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Instruments overview

Instruments introduction for Logic Pro for Mac

Logic Pro provides an extensive suite of software instruments that can be used in
your productions.

Sample-based instruments include Alchemy, Sampler, Sample Alchemy, and Quick Sampler.
These enable you to create and play back recordings of acoustic instruments. Alchemy
provides extensive sample manipulation and resynthesis options that can result in sounds
that bear little resemblance to the source. Also included are the sample-based Studio
Bass, Studio Piano, Studio Strings, and Studio Horns plug-ins. The latter two offer a variety
of individual and grouped instruments with multiple articulations.

Specialized percussion synthesizers and instruments include Drum Synth, Ultrabeat, Drum
Kit Designer, and Drum Machine Designer. Ultrabeat combines several percussion-oriented
synthesis engines and a step sequencer, making it a powerful tool for the creation of new
sounds and beats. Drum Machine Designer is a track instrument that directly integrates
and interacts with the Logic Pro Mixer and Step Sequencer.

Four vintage instruments emulate the classic B3 organ, Rhodes, Wurlitzer, and Hohner
electric pianos, the Hohner Clavinet, and the Mellotron. See Vintage B3, Vintage Electric
Piano, Vintage Clav, and Vintage Mellotron.

When it comes to synthesizers, you have a huge range to choose from. These include
simple plug-ins such as ES P, ES M, ES E, and EFM1. More advanced options include Retro
Synth, ES1, and ES2, up to the extremely sophisticated Alchemy and Sculpture instruments.

Alchemy provides several synthesis and sample manipulation engines that you can use
alone or with each other to produce a staggering variety of sounds. It features extensive
modulation options, built-in arpeggiation, and sequencing.

Sculpture is a modeling synth that you can use to recreate physical instruments or to
create instruments that don't exist. It has a number of unique modulation facilities and
can generate a huge array of sound types.

Rounding out the collection are the External Instrument and Klopfgeist Utility instruments,
and the EVOC 20 PolySynth vocoder. This instrument tracks incoming MIDI notes and
processes audio signals to create classic robotic voices and choirs that follow played
note and chord pitches.
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Add, remove, move, and copy plug-ins in
Logic Pro for Mac

You can add plug-ins, replace a plug-in with a different one, and remove plug-ins from a
channel strip. You can also move, copy, and bypass plug-ins. If you're unhappy with any
of your plug-in adjustments, you can undo them.

Add an instrument plug-in

In a Logic Pro channel strip, do one of the following:

Click the Instrument slot, then choose a plug-in from the pop-up menu.

Option-click an Instrument slot.

You can now choose legacy plug-ins from the pop-up menu.
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Add a MIDI effect plug-in

In a Logic Pro channel strip, do one of the following:

« Click the MIDI Effect slot, then choose a plug-in from the pop-up menu.

v No Plug-in

Arpeggiator
Chord Trigger
Modifier
Modulator
Note Repeater
Randomizer
Scripter
Transposer

Velocity Processor

- Place the pointer above or below an occupied MIDI Effect slot, click the green line that
appears, then choose a plug-in from the pop-up menu.

Stereo Out

1+2




Add an audio effect plug-in to an instrument channel

In a Logic Pro channel strip, do one of the following:
- Click an Audio Effect slot, then choose a plug-in from the pop-up menu.

Sampler Alchemy © In1 O In1 @ In1 @ In1 @ Bus1

v No Plug-in

Recent

Amp Designer

Channel EQ

Bitcrusher St out St Out
Compressor

Amps and Pedals
Delay

Distortion
Dynamics

EQ

Filter

Imaging
Metering

Adaptive Limiter
ChromaGlow
Compressor
DeEsser 2
Enveloper
Expander
Limiter

Modulation
Multi Effects
Pitch

Reverb
Specialized
Utility

Multipressor
Noise Gate

M M N e~ v

Audio Units

v

The last visible empty Audio Effect slot in a channel strip is shown at half its height; use
it in the same way.

- Option-click an Audio Effect slot.

You can now choose legacy plug-ins from the pop-up menu.

Replace a plug-in

+ InaLogic Pro channel strip, place the pointer over the plug-in slot, click the arrows that
appear to the right, then choose a plug-in to replace the existing one.

Stereo Out

Logic Pro Instruments for Mac 13
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Remove a plug-in

Move an effect or MIDI plug-in

Copy an effect or MIDI plug-in

In a Logic Pro channel strip, place the pointer over the plug-in slot, click the arrows that

appear to the right, then choose No Plug-in from the pop-up menu.

1+2
Read

&
=)

In a Logic Pro channel strip, drag the plug-in up or down in the channel strip, or to

Drum Kit Designer

Alchemy

- Drum Kit Designer
Drum Synth
EFM1 (FM Synth)
ES E (Ensemble Synth)
ES M (Monophonic Synth)
ES P (Polyphonic Synth)
ES1 (Synthesizer 1)
ES2 (Synthesizer 2)
EVOC 20 PS (Vocoder Synth)
Quick Sampler (Single Sample)
Retro Synth
Sampler (Multi-Sample)
Sculpture (Modeling Synth)
Studio Horns
Studio Strings
Ultrabeat (Drum Machine)
Vintage B3 Organ
Vintage Clav
Vintage Electric Piano
Vintage Mellotron

Utility

another channel strip.

For guidance, use the colored line that appears when moving the plug-in.

In a Logic Pro channel strip, press and hold Option and drag the plug-in to an

unused slot.

(AT -

vV VV V VVV VV VYV VYV VYV VYV VYV YV VY

v
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Bypass a plug-in

If you want to deactivate a plug-in, but don’t want to remove it from the channel strip, you
can bypass it. Bypassed plug-ins don't drain system resources.

- In Logic Pro, to bypass a single plug-in, do one of the following:

- Place the pointer over the plug-in slot, then click the Bypass button that appears to
the left.

O Input1

"
<

Stereo Out

Option-click the plug-in slot.

Click the center area of the plug-in slot to open the plug-in window, then click the
Bypass button at the left side of the plug-in window header.

User Default

Copy Paste

- To bypass multiple plug-ins, click a plug-in slot, then drag the pointer up or down.

All swiped plug-in slots switch to the same state.
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Use multi-output instruments in Logic Pro for Mac

There are two reasons to use multi-output instruments in your mix:

+ To process each sound individually in a drum kit, for example, with different effects

- To route the different software instrument outputs to different outputs on your
audio interface

Logic Pro supports the multiple outputs of all instruments that provide a multi-output
configuration (including Drum Kit Designer, Sampler, Studio Horns, Studio Strings,
Ultrabeat, and all Audio Unit instruments). One or more multi-output options may be
displayed in addition to the mono and stereo versions shown in the plug-in pop-up
menu of the Instrument slot.

Sampler (Multi-Sample)

No Plug-in

Recent

Sampler (Multi-Sample)

ES M (Monophonic Synth)
Quick Sampler (Single Sample)
Retro Synth

Studio Piano

Alchemy
Drum Kit Designer
Drum Synth
EFM1 (FM Synth)
ES E (Ensemble Synth)
ES M (Monophonic Synth)
ES P (Polyphonic Synth)
ES1 (Synthesizer 1)
ES2 (Synthesizer 2)
EVOC 20 PS (Vocoder Synth)
Quick Sampler (Single Sample) St Out St Out St Out
Retro Synth
- Sampler (Multi-Sample) Mono
Sculpture (Modeling Synth) v Stereo
Studio Bass
Studio Horns 5.1
Studio Piano
Studio Strings
Ultrabeat (Drum Machine)
Vintage B3 Organ
Vintage Clav
Vintage Electric Piano
Vintage Mellotron

Utility
Sampler

Drum Machine Designer

AU Generators
AU Instruments S M S

AU MIDI-controlled Effects Fina s

Note: Not all instruments offer multi-output options.
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Insert and set up a multi-output instrument

1.

In a Logic Pro channel strip, click the Instrument slot, then choose the multi-output
instance from the pop-up menu.

The first two outputs of a multi-output instrument are always played back as a stereo
pair by the instrument channel strip that the plug-in is inserted into. Additional outputs
(3 and 4, 5 and 6, and so on) are accessed via aux channel strips.

In the plug-in window, set up the output routing for individual sounds or samples. This
is generally done using a pop-up menu with entries such as Main, 3-4, 5-6, and so on.

In the Mixer, click the Add button (+) of the instrument channel strip that you inserted
the multi-output instrument into.

Note: The Add button (+) appears only on multi-output instrument channel strips.

17
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An aux channel strip is created to the right of the multi-output instrument channel strip.
Use this new channel strip to isolate and route a sound for independent mixing and
processing.

Sampler Samp3-4 Samp5-6 Samp7-8

St Out St Out

L1 e L

. Repeatedly click the Add button (+) to create more aux channel strips, for all stereo or

mono outputs available to the instrument plug-in.

You should create only as many aux channel strips as are required for the number of
outputs used by the multi-output instrument.

After you create the first aux channel strip for your multi-output instrument, a Delete
button (=) appears beside the Add button (+).

Click the Delete button (-) to remove aux channel strips.
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Alchemy overview in Logic Pro for Mac

Alchemy is an easy-to-use, yet powerful sample manipulation synthesizer. It offers
numerous real-time performance controls and an extensive preset library.

Alchemy features additive, spectral, and granular synthesis and resynthesis, sampling, and
virtual analog engines. You can analyze imported samples and can manipulate them using
one or more of these synthesis methods. Alchemy provides extensive sample mapping,
looping, and grouping facilities that make it easy to create instruments containing hundreds
of samples and layers. If you want to create purely synthetic sounds, the additive, spectral,
and virtual analog synthesis engines are full-featured, matching or exceeding the power
and facilities of many standalone instruments.

An Alchemy preset can contain up to four sources, each using one or more synthesis
engines. You can morph or crossfade between these sources. Dozens of modeled analog
and digital filters are available, in addition to multiple racks of integrated effect units and
an extensive modulation section. Alchemy also features a powerful arpeggiator that can
control each source independently and provides flexible pattern modulation options.

If you're new to synthesizers and different synthesis methods, see Synthesizer basics
overview. Also see the Alchemy tutorial introduction for detailed tasks on the use of
several advanced Alchemy synthesis features.

If you're new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Before you can design new sounds with Alchemy you need to understand how its different
parts fit together, and how each of them contributes to what you hear.

At first glance Alchemy may seem complex, but its layout is relatively simple:

Gl Additive '
c A ~ FX Send

Source Filter/
"M» Fxsend | Effects

Filters FX Send

------------------------ |
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The diagram shows signal flow from left to right through the different sound generating
and processing modules.

There are three basic stages:

- Each sound can contain up to four sources: A, B, C, and D. Each source consists of
additive, spectral, granular, sampler, and virtual analog elements. Multiple elements
can be active in each source. Each source has three independent filters that can
operate in parallel or in series. These sources are used to create and shape the basic
tone of the sound. All modulation in this section applies per voice. See Alchemy source
overview, Source filter controls, and Source modulations.

- There are two main filters that can operate in parallel or in series. The main filters
are used to shape or otherwise alter the combined sound from the four sources. All
modulation in this section applies per voice. See Main filter controls.

- After the individual voices are mixed together and filtered, they pass through the
effects stage. Any modulation of the Effects section is applied to the entire audio
signal sent from the main filter section. You can also directly route sources (post
source filters, if used) to the Effects section, bypassing the main filters altogether.
See Alchemy effects overview.

Working with projects from Logic Pro for iPad

Logic Pro for Mac provides playback compatibility with Logic Pro for iPad projects that use
Sample Alchemy. You can load presets for this plug-in in Logic Pro for Mac Alchemy, but
can only edit parameters in Sample Alchemy in Logic Pro for iPad.

To continue working with Sample Alchemy settings in Logic Pro for Mac, replace the
plug-in with Alchemy. See the Share a project with Logic Pro for iPad topic in the
Logic Pro for Mac User Guide, and the Export and Share projects chapter in the
Logic Pro for iPad User Guide.

Replace Camel Audio Alchemy with Logic Pro Alchemy on a track

Logic Pro Alchemy settings are compatible with Camel Audio Alchemy. This enables you to
replace the Camel Audio plug-in with Logic Pro Alchemy.

1. In Logic Pro, select the track with the Camel Audio Alchemy plug-in.

2. In the channel strip for the selected track, place the pointer over the instrument slot
containing Camel Audio Alchemy, then choose Alchemy from the pop-up menu.

The new instance automatically retains your Camel Audio Alchemy settings.

Note: Because of updates to Logic Pro Alchemy controls and features, patches might
not sound exactly the same as they did in Camel Audio Alchemy. Also, automation
doesn’t carry over to Logic Pro Alchemy.

20
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Alchemy interface overview in Logic Pro for Mac

View buttons: Alchemy has three main views. You access each view by clicking these
buttons. Each view is designed for different tasks and situations.

All views feature the Name bar and the Perform section. See Alchemy Name bar and
Performance controls overview.

SIMPLE ADVANCED

- Browse button: Browse view is ideal for performance or exploration and for use of
presets when composing. The Preset browser displays all available presets and offers
a powerful search engine. The Perform section, located beneath the Preset browser,
features a number of real-time controls that you can map to almost any Alchemy
parameter.

s [ — e ) FName bar

Category Subcategory
Al Al
Arpeggiated Acoustic
Bass Analog
Brass Bass
Drums Bell S \coustic Thumb
Guitars. Bowed tronic 18705 Analog Arp
Keys Ghaotic a 1970s Analog Arp (1)
Leads Choir in 19705 Modular Synth Bass
Mallets Cinematic Industrial Phat 1980 Sweet Pad

Organs Ciassic Pop Nice 60 Vintage Organ

Pads Dance Rock Nasiy A ST ~Preset
Rhythmic Digital Soundtrack Organic 70s Analog Synth Lead b rowser
Sound Effects Drone Techno Metallic 70s Classic Synth Bass
Soundscapes Drums Trance ‘Smooth 70s Rock Synth Patterns
Strings Electric Electro Giitchy 70s Space Pad

Syrine Eieatonic Funk 700 Space Synth Patioms
Vocals Ensemble Jazz 70s Space Twinkles
Woodwinds. Evolving Orchestral 70s Synth Arp

Comments User Tags Search

PERFORM Text search
X1: Saw/ Square X2: ArpFiate :
Bright Syrth Epic Synth Metalic Swell Moton Pad \’ a @ @ () @ field
Delay Cutolf Filter Env. Unison Attack Decay
. M © © & @ ® @
Reveb  Fosonance Movement  Characier Susin  Foleaso

Yo e

| Perform/Arp/Effects sections

«  Preset browser: See Preset browser overview.
. Text search field: See Browser results list.

- Arp(eggiator) section: Click the Arp button to view and make changes in the
arpeggiator control panel. See Alchemy arpeggiator overview.

- Effects section: Click the Effects button to view and make changes in the effects
control panel. See Alchemy effects overview.
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Simple button: When simple view is turned on, Alchemy provides a compact interface
ideal for live performance.

PERFORM

X1:Morph X. X2: Trip Mix

LT S 9 ® © CMC )

Delay Cutofl  ApOcave  ArpMode Attack  Decay

Hollow Triplets @ \’ @ o ’ @

Tubo anca  AmpSelect Ap Shuffle Sustain  Rolease

Y1: Morph Y Y2 Tiip Colour

Advanced button: Advanced view is particularly useful for creating new sounds or
manipulating existing presets. This view unlocks all Alchemy synthesis, modulation,
and editing capabilities.

e _iowe | OECTTTITEEND e o @

SOURCES FILTER MASTER
Al Semi Acoustic Semi Acoustic T ¢ > B) semi Acoustic Semi Acoustic T ¢ > ) LP120BClean ¢ >
1 T 1 1
’ .

Pan  FUF2 ~ Yo Twe  Pan FiF2 - Cutoff

v
& semi Acoustic Semi Acoustic T ¢ > B Semi Acoustio Semi Acoustic T < On LP12dBClean < VOIGES

Aways
1 1
’ / \
MORPH v Yol Tune . FX Main

Newest

MODULATION AHDSR SEQUENCER  ENVFOLLOWER  MODMAP
Filter 1 Cutoff
on Control2
On Velocity

on

)

Decay  Sustain Release

PERFORM

X1: Vibrato X2: Delay Time

CC

Efiocts. Warmih

i
i®

Delay & Reverb ‘ \’ \' @

Resonance  Humanize Bite Sustai

El R EEE B ¥1: Vibrato Rate Y2: Rleverb Time:
Ceave Fare MocWnee! ‘Snan Vol

&
[

- Source, main filters, master voice, and morph sections: See Alchemy source
overview, Main filter controls, Alchemy master voice section, and Morph controls.

- Source editors: When individual sources are selected, you can also access the
source editors. See Alchemy source edit window overview.

«  Modulation section: See Alchemy modulation overview.

- Arp(eggiator) section: Click the Arp button to view and make changes in the
arpeggiator control panel. See Alchemy arpeggiator overview.

- Effects section: Click the Effects button to view and make changes in the effects
control panel. See Alchemy effects overview.
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Alchemy Name bar in Logic Pro for Mac

The Name bar provides tools for preset management and other functions. It is shown in all
views. See Alchemy interface overview.

o | DT O e - @

Name bar parameters

Preset field and pop-up menu: Displays a list of presets available to load. By default,
all presets are shown. To quickly scroll through and load a preset, use the Previous
and Next buttons (the arrows) adjacent to the Preset field. The order of presets is
determined by settings in the Preset browser. See Preset browser overview.

The field shows the current preset name and category, or Default if no preset is loaded.

The category of the selected preset is displayed to the left of the preset name when a
preset is loaded.

Category button: Show a pop-up menu of preset categories.
File button: Open a pop-up menu containing preset management commands.

- Save Consolidated: Save a copy of the active preset along with copies of audio
files used.

Note: Because supplied samples use audio files available to all Alchemy users,
these files are not copied.

Initialize Preset: Initialize Alchemy, providing a basic sawtooth wave that can be
used as a starting point for your own presets.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

« Refresh Library: Scans all default file locations, and updates the preset
library database.

Save button: Save your changes to the active preset. If the preset belongs in the
App Presets bank, a Save As dialog is displayed, preventing you from accidentally
overwriting the preset.

Save As button: Open a browser window where you can choose a filename (*.acp) and
a location to save the currently active preset. Newly saved presets are automatically
added to the Preset browser with a category, several predetermined attributes, and
the artist name specified in Settings > My Info > Artist Name. If this preference is not
set, "“Unknown Artist” is shown in preset results.

Quality pop-up menu: Choose the processing resolution on output. This setting remains

active when loading other presets or when recalling the project.

Limiter button: Turn the Limiter on or off. This prevents clipping of the signal from all
voices at the end of the signal path.

Volume knob: Boost or cut the overall preset volume. This happens at the end of the
signal path and controls the effected and dry signals of all voices.
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Alchemy file locations in Logic Pro for Mac

You can find Alchemy files in the following default locations:

Presets: [Library/Application Support/Logic/Plug-In Settings/Alchemy

User presets: ~/[Music/Audio Music Apps/Plug-In Settings/Alchemy

Sample data: [Library/Application Support/Logic/Alchemy Samples

Sampler Instruments: [Library/Application Support/Logic/Sampler Instruments

User sample data: ~/[Music/Audio Music Apps/Alchemy Samples

Ratings, comments, tags, and attributes: These are stored in the preset database file.

When you save a preset as part of a channel strip setting (CST file), patch, or
project (when File > Project Settings > Assets > "Copy Alchemy audio files into
project” is not active):

The location of previously saved AAZ data (the Alchemy analyzed sample format)
is retained.

If AAZ data has not already been saved, it is saved in the ~/Music/Audio Music Apps/
Alchemy Samples folder.

When you save an ACP (Alchemy preset) file, Logic Pro also automatically saves references
to AAZ files in the application samples folder. If AAZ files are in any other location, they
are saved in the same folder as the ACP file. The ACP filename is used at the front of

AAZ filenames.

User samples may be located anywhere on disk, with AAZ data being saved in the patch
or preset location. Logic Pro for Mac uses the default locations listed above when

File > Project Settings > Assets > “"Copy Alchemy audio files into project” is not active.
See Manage project assets and Manage content in the Logic Pro for Mac User Guide.
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Alchemy Preset browser overview in Logic Pro for Mac

The Preset browser is used for loading, searching, sorting, rating, and tagging presets.

(oo | o | owco | OECTT—— T -
* R Ap

Category Subcategory

User tags

Edit

PERFORM

X2 Trip Mix

Hollow Triplets

[ o B o [ o [}
Ortre -

There are two different views for the Preset browser results list.
- Browser view: Click the Browse button to open browser view.
- Name bar list: Click the preset field in the Name bar to display a list of presets.

Both lists are synchronized. If the Preset browser is used to select a particular category
or to sort results, the Name bar list reflects your choices, and vice versa.

When a new instance of Alchemy is inserted, the browser results list shows all available
presets. The Name bar preset field displays the preset category and preset name.

When a preset is loaded, the area below the browser results list displays Comments and
User Tag fields. The area to the right shows additional parameters. See Browser results list.
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Alchemy browser results list in Logic Pro for Mac

Shown in browse view, the browser results list displays all presets matching the current
search criteria. A number of columns are shown from left to right.

User Tags

Browser results list parameters

Category column: Shows preset categories.
Subcategory column: Shows subcategories of preset categories.

Attributes columns: Show the articulation, Genre, Newer Than, Older Than, Sound
Designer, Sound Library, Timbre, or User Tags attributes. Click column headers to
choose an attribute from a pop-up menu.

Attributes are used to refine the preset results list and to apply attributes to presets
when in Edit mode.

Tip: Combine Attributes columns such as Newer Than and Sound Designer to show
presets that you created within a date range, without also showing supplied presets
installed in the same date range.

Rating column: Shows user ratings. Click the column header to sort the results list. A
second click reverses the current sort order.

The highest rated presets appear first in the list. User-rated presets always take
precedence over unrated presets. Three dim stars indicate that a preset has not
yet been rated.

Preset column: Shows preset names. Click the column header to sort the results list. A
second click reverses the current sort order.

The number of presets returned by the current search criteria is displayed to the right
of the Preset column header.

Comments field: Shows preset comments.
User Tags field: Shows existing user tags.

User Tags button: Open a pop-up menu with commands for creating and deleting user
tags. A list of existing user tags is shown below the menu commands.

Edit button: Open an enlarged view of the Preset browser window that provides text
entry fields for user tags and comments.

Close button: Closes the enlarged view of the Preset browser window.

Search field: Use to type a search term for presets.
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Set criteria to refine the preset results list

1.

In Alchemy in Logic Pro, click an entry such as Guitars in the Category column to limit
the preset results list to include only presets belonging to the Guitars category.

Click an entry such as Acoustic in the Subcategory column to further limit the preset
results list to include only presets belonging to the Acoustic subcategory of the parent
category (Guitars, in this example).

Click the header of one or more attribute columns to open a pop-up menu where you
can choose the attributes you want to use.

Click a category in each attribute column.

You can choose multiple entries in any column by doing one or more of the following:

Click an entry, then hold down Shift while clicking another entry in the same column.
All items between the clicked entries are selected and used as search criteria for the

preset results list.
Hold down Command, then click any entries you want to use as search criteria.

Click the All entry at the top of a column to reset the selection criteria.

Use the search field

The search field is used for manual searching of presets by name, attributes, user
comments, artist name, or tags. The most recent search term is saved and recalled
with the project.

1.

In Alchemy in Logic Pro, type your search term, then click the magnifying glass icon or
press Enter.

The Preset browser results list updates to reflect your search criteria, and the first
preset is loaded.

. You can refine a text search with the minus symbol. For example, to search for all

presets matching analog but not bass, use the search term analog -bass.

This may also be used to remove all bass presets from the results list by entering
only -bass in the search field. Presets in the Bass category and presets with bass
or basses in the preset name, user tags, or comments field are removed from the
preset results list.

. To clear the current search term, click the search field and make sure all text is

selected, then press the Delete key.
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Use preset edit mode

Preset edit mode displays all attribute columns in an enlarged Preset browser window. Edits
made to multiple selected presets apply attributes, user tags, or comments to all presets in
the group. All changes made in edit mode are immediately applied and saved in the preset
database. The Sound Designer is determined by the settings in Settings > My Info > Artist
Name. If this is not set, “Unknown Artist” is shown.

Note: It is not possible to change the Sound Library for a preset; this column is displayed
for reference only.

Category Subcategory

Arpsggiated

Filter Mod

1. In Alchemy in Logic Pro, click the Edit button to switch to preset edit mode.

2. Click a preset name. You can also use the Previous and Next buttons in the Name bar to
select a preset. To select multiple presets, do one of the following:

« Click an entry, then hold down Shift while clicking another entry in the same column.
All items between the clicked entries are selected and are available for edits.

- Hold down Command, then click any entries you want to add for editing.
3. Type in the User Tags or Comments fields, as required.

Terms entered in these fields can be searched using the text search function.
4. Change the Category, Subcategory, or Attributes for the preset.

Changing the preset category updates only the preset category database. The preset
itself is not moved to a new category folder on disk.

5. Click the Edit button to exit preset edit mode.

Create, remove, and delete user tags

1. In Alchemy in Logic Pro, select the preset that requires user tag changes.
2. Click the User Tags button, then choose New Tag from the pop-up menu.

The Enter New Tag field is shown.
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Type in the Enter New Tag field, then click OK. Click Cancel if you do not want to switch
to a new tag or want to close the Enter New Tag field.

The user tag is added to the New Tag pop-up menu, and the Enter New Tag field closes.
The new tag is shown below the menu commands in the pop-up menu.

Click the User Tags button, then choose the newly created tag name from the
pop-up menu.

The new tag is assigned to the preset. This is indicated by a tick beside the tag name.

To remove an assigned tag, click the User Tags button, then choose the tag name from
the pop-up menu. Assigned tags are indicated by a tick beside the tag name.

The tag is removed from the preset, but the tag is not deleted. No tick is shown beside
the tag name. This tag can be reassigned to another preset.

To delete a user tag, click the User Tags button, then choose the tag from the Delete
Tag submenu.

The tag is immediately removed.

Rate a preset

1.
2.

In Alchemy in Logic Pro, click a preset name to select it.

Click a star in the Ratings column to set the rating between 1 and 5. Unrated presets
display 3 stars.

Note: You can limit the preset results list to match any star rating by entering
the number of stars in the text search field. A search for **** displays only
4-star rated presets.

Alchemy sound sources

Alchemy source overview in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view.

Alchemy sound generating modules are called sources. Four independent sources are
available in each preset (A, B, C, and D). Each source has an identical set of components.
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Each source provides multiple sound generating elements based on different methods of
synthesis. See Source elements overview.
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Elements can be turned on or off independently within each source, allowing you to
combine synthesis methods. Some elements require a sample import or the creation
or import of other content before they can be used.

There are a handful of restrictions on element combinations within a single source. You
can circumvent such restrictions when creating your sound by using a different synthesis
method (or combination of methods) for each of the four sources.

If you're new to synthesizers and different synthesis methods, see Synthesizer
basics overview.

Alchemy source master controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view.

At the left of the source section are six buttons: Global, A, B, C, D, and Morph. Indicators
to the left of each button denote the following: blue = active source, green = morphing
enabled for the source.

Source mode buttons: Click Global to view all sources. Click A, B, C, or D to view a
single source. Click Morph to use morph mode. Option-click A, B, C, or D to view and
solo the source.

When the Global button is on, the source master controls are displayed. The main filter and
master voice controls are also displayed when Global is active. See Main filter controls and
Alchemy master voice section.

When the A, B, C, or D button is on, the subpage controls for the selected source are
displayed. See Source subpage controls.

When the Morph button is on, source morphing parameters are displayed. See
Morph controls.
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The source select field in each source does double duty as a VU meter that shows the
current output level from the source into the main filter section. When the output level
exceeds 0 dB, it clips the input of the main filter section, and the VU meter turns red.
This is useful for quickly determining the cause of unwanted distortion.

Note: Sources can also be routed directly to the Effects section, bypassing the main filters.
The VU meter is shown regardless of the source output destination.

Saw - Arp

Tune Pan

Additive

Source master controls
- A/B/C/D buttons: Turn the source on or off. Option-click to solo a source.

- Source select pop-up menu and field: Displays the name of the current source audio
data. Click to open a pop-up menu with source content handling commands. Click the
Previous and Next buttons (the arrows) to step through available waveform data. This
field also acts as a VU meter during playback.

- Import Audio: Import audio data into the element. You can also drag and drop audio
from Logic windows (Main window, Loop Browser, File Browser), use the Import
browser, or hold Command to drag and drop audio files from Finder.

Load VA: Load waveform data into the VA element. This automatically enables
the VA element and disables all other synthesis engines for this source. See
VA element controls.

Load Source: Load source data from disk. Data is in SRC file format. Loaded data
includes all source control settings and a reference to any loaded or imported audio
data. Source control modulations are not loaded as part of the SRC file.

- Save Source: Write source data to disk in SRC file format. Saved data includes
all source control settings and a reference to any loaded or imported audio data.
Source control modulations are not saved as part of the SRC file.

Copy Source: Copy source data to the Clipboard. This is useful for duplicating the
content and settings of one source in another. Copied data includes settings of all
source controls and a reference to loaded or imported audio data. Source control

modulations are also copied.

- Paste Source: Paste source data from the Clipboard.

« Clear Source: Reset the source to the default state.
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«  Randomize Source: Apply random variations to source controls, depending on active
elements in the source.

- Swap With Source: Choose a source to swap with the current source. This enables
you to quickly experiment with the parameter settings of the two swapped sources.

- Vol knob: Set the source output level (-inf dB to 0 dB).

«  Tune knob: Tune the source in semitone increments. A further Fine Tune control is
available on each source subpage. See Source subpage controls.

- Pan knob: Set the source output position in the stereo field. This parameter works as
a pan control if the source Stereo button is off or as a left/right balance control if the
source Stereo button is on. The behavior of the Pan control changes when wide unison
mode is turned on. See Alchemy wide unison mode.

- Send knob: Set the source output balance (post source filters, if used) sent to the
destinations specified with the Send pop-up menu.

- Send pop-up menu and field: Determine where the source output is sent (post source
filters, if used). This is the send from each source panel to the main filters and/or the
effects rack.

F1/F2: Source output is routed to main filters 1 and 2. The balance between these
targets is set with the Send knob.

F1/FX A/B/C/D: Source output is routed to main filter 1 and effects rack A, B, C, or D.
The balance between these targets is set with the Send knob.

- F2/FX A/B/C/D: Source output is routed to main filter 2 and effects rack A, B, C, or D.
The balance between these targets is set with the Send knob.

Note: Signals sent to effects rack A, B, C, or D destinations bypass the main filters
when the Send knob is set to the full-right position. See Alchemy effects overview.

Alchemy Import browser in Logic Pro for Mac

You can import WAV, AIFF, and Sampler sound files as additive, spectral, a combination of
additive and spectral, granular, or sampler elements. See Source elements overview.

You can quickly replace the sound for Alchemy on a software instrument track by dragging
an audio file, audio or software instrument region, or Apple Loop to the track header. When
you drag content to one of the Alchemy zones to replace the existing sound, you can
choose whether the new sound uses additive, granular, or spectral synthesis.

The additive element allows for the most detailed manipulation of sound and is especially
good for sound files that represent single notes, rather than chords or more complex
sounds and textures.

Importing to the spectral element allows effective manipulation of polyphonic sounds, such
as chords, drum loops, and other complex sounds and textures.

An additive+spectral import may deliver the best results when an additive import fails to
capture the noisy components of a sound, such as the hammer strike of a piano or the
breath noise of a flute.

The granular element is good for drum loops, percussive sounds, and any sound that you
want to use granular effects with.
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Use the sampler element when you want to play a sound file in its original form, transposed
across the keyboard.

Analysis Mode Mapping

Additive  Spectral | AddeSpec| Granular  Sampler Pitch v

Formant

Import browser parameters

- Places column: Shows all top-level folder locations. The Alchemy Samples and EXS
Factory Samples folders are shown at the top of the list. Click to view each folder.

- Samples column: Shows the samples within the selected folder, preset, or sampler
instrument. Only sample data is displayed. See the tasks in this section for information
on sample selection.

- Dropzone: Shows the names of samples added to this area. Samples can be from
multiple locations or instruments. See the tasks in this section for information
about use.

Control-click files in the Dropzone list to open a shortcut menu.
Delete: Remove the file from the Dropzone.

Move to New RR Group: Create a new round-robin group and add the selected file or
files to the group. See Inspector group controls.

« Analysis Mode buttons: Set the type of analysis that is performed when sample data
is imported.

- Additive button: Use to import samples that you want to resynthesize using additive
synthesis. Good results depend on accurate identification of the root note. If the
filename has a pitch value appended to it, this is used to set the root note. In other
cases, analysis of the waveform pitch determines the root note. The Mapping mode
may also be important.

Spectral button: Use to import samples that you want to resynthesize using spectral
synthesis. The root note determines the MIDI note that plays the resynthesized
sound at its original pitch. If the filename has a pitch value appended to it, this is
used to set the root note. In other cases, analysis of the waveform pitch is used to
determine the root note.
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- Add+Spec button: Use to import samples that you want to resynthesize using a
combination of additive and spectral synthesis. By default, the spectral component
is imported and played with the spectral element set to Noise-Resynth mode.
Playing the spectral data in Resynth mode produces a markedly different effect,
which you may sometimes prefer. The spectral element internal highpass control is
automatically set to a high value, thus excluding frequencies that would compete
with those produced by the additive element. If the spectral element is too subtle,
you can make it more prominent by setting the highpass control to a lower value.

< Formant button: Use in conjunction with the Additive, Spectral, or Add+Spec buttons
to perform additional analysis of formants in the sample material. The values of this
formant analysis are mapped to the Analyzed formant filter parameters in the source
subpage. See Formant filter controls.

Granular button: Use when you intend to perform granular-specific manipulations
such as time stretching. The root note determines the MIDI note that plays the
sound file at its original transposition. If the filename has a pitch value appended
to it, Alchemy automatically sets the root note to match.

- Sampler button: Use to create straight sample-playback presets. The root note
determines the MIDI note that plays the sound file at its original transposition. If
the filename has a pitch value appended to it, Alchemy automatically sets the root
note to match.

- Mapping pop-up menu: Choose a mapping mode suitable for pitched or unpitched
imported samples.

« Pitch: Suitable for sounds that you want to play across the keyboard chromatically.
Use this mode to automatically place imported samples in keyboard zones for
optimum playback when re-pitched.

- Drum: Maps each sample to a single key. Use this mode to map sounds such as a
set of drum hits or chords that won't transpose correctly if re-pitched. Imported
samples are mapped to individual keys (starting at C1).

- Preview button: Turn on to automatically audition samples when you click filenames in
the Samples column.

- Cancel button: Use to cancel the import operation. No files are imported, and the Import
browser window is closed.

- Import button: Use to start the import operation. Depending on the chosen mode, when
you click Import, an import progress dialog is briefly displayed and the Import browser
window closes. Click Cancel next to the progress bar to cancel a long import.

Drag an audio file into a source

1. In Alchemy in Logic Pro, open advanced view then drag an audio file onto any source
select field from one of the following:

Loop Browser
File Browser
Logic Main window

Finder: Hold Command while performing the operation.
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2. Drop the file onto one of the analysis mode labels shown on the grid of the
target source.

The chosen analysis mode is highlighted.

SOURCES

Additive Spectral

s “Incredible" Spoken Word

Granular Sampler

Triangle

If Additive, Spectral, or Granular mode is chosen, analysis may take a moment or two.
No analysis occurs when Sampler mode is used.

Note: If you want to perform an Add+Spec analysis, or want to perform a further
formant analysis of the audio material, use the Import browser methods discussed
in following tasks.

Replace the sound for Alchemy on a software instrument track using drag
and drop

1. In Logic Pro, drag an audio file, region, or Apple Loop to a software instrument track
with an Alchemy instrument plug-in as the instrument.

2. When the "Replace existing sound with" dialog appears, drag the item to one of the
available options to choose the synthesis type Alchemy uses to process the content:
Additive, Granular, or Spectral.

Import a single audio file into a source with the Import browser

1. In Alchemy in Logic Pro, open advanced view then click a source select field and choose
Import Audio from the pop-up menu to open the Import browser window.

2. Click one of the Analysis Mode buttons to choose an import analysis mode.

If the Additive, Spectral, or Add+Spec button is active, you can also turn on the Formant
button. This performs a further analysis of the audio material and sends the results to
the Analyzed section of the formant filter. See Formant filter controls.

If the audio data is imported to the additive, spectral, add+spectral, or granular
elements, analysis may take a moment or two. No analysis occurs when the Sampler
analysis mode button is active.

3. Click the Preview button to enable or disable automatic preview of selected files.

Sound files can be mono or stereo, 8-, 16-, 24-, or 32-bit, at any sample rate. Note that
rates above 44.1 kHz don't provide significant improvements in quality.

4. Click a filename, then click the Import button to import the sound.

An import progress dialog is shown. The Import browser closes when the import is
complete, and the previous window is displayed.
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Import multiple audio files into a source with the Import browser

Multiple WAV and AIF files may be imported to a single source. Other file types are not
supported for multifile import.

If the note name is included in the filename, samples are mapped to corresponding
keyboard zones for all analysis types. When importing using additive or spectral analysis,
samples without a note name are analyzed to determine pitch information that is then used
for keyboard mapping. Samples are mapped to the highest key of the zone and pitched
down for the remaining notes in the zone.

When no pitch information or note names are available, samples are mapped evenly across
keyboard zones based on file selection order. The root key pitch is set to the middle of
each zone.

1. In Alchemy in Logic Pro, open advanced view then click a source select field and choose
Import Audio from the pop-up menu to open the Import browser window.

2. Click one of the Analysis Mode buttons to choose an import analysis mode.

If the Additive, Spectral, or Add+Spec button is active, you can also turn on the Formant
button. This performs a further analysis of the audio material and sends the results to
the Analyzed section of the formant filter. See Formant filter controls.

If the audio data is imported to the additive, spectral, add+spectral, or granular
elements, analysis may take a moment or two. No analysis occurs when the Sampler
analysis mode button is active.

3. Click the Preview button to enable or disable automatic preview of selected files.

Sound files can be mono or stereo, 8-, 16-, 24-, or 32-bit, at any sample rate. Note that
rates above 44.1 kHz don't provide significant improvements in quality.

4. Use standard modifier keys to select multiple files: Command-click to select or deselect
files, Shift-click to select a range of files.

If you are creating a sound that uses samples from multiple instruments or folders, drag
the selected file or files to the Dropzone shown at the right side of the Import browser.

Once at least one file is added to the Dropzone, you can double-click a filename to add
it to the list of Dropzone files. Drag filenames in the Dropzone list to change their order.

Tip: You can also drag files directly into the Dropzone from the Main window, Finder
(hold Command), the Audio File browser, or the Loop browser. You can use standard
modifier keys to select or deselect files.

5. Choose a mode from the Mapping pop-up menu.
- Pitch: Suitable for sounds that you want to play across the keyboard, chromatically.
« Drum: Map each sample to a single key.

6. Click the Import button to import all selected files.

Note: Clicking Import when at least one file is in the Dropzone imports files from the
Dropzone, rather than files selected in the file list.
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Alchemy source subpage controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

Each of the four sources has an identical set of controls for more in-depth editing. Several
source subpage controls are duplicates of those found in the source master controls. See
Source master controls.

For information on source filter controls, see Source filter controls.
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The waveform display and element controls section update to show relevant data and
parameters when different synthesis engines are active. The additive element is active
for source A in the image.

Source subpage controls
- On/off button: Turn the source on or off.

- Source select pop-up menu and field: Displays the name of the current source audio
data. Click to open a pop-up menu with source content handling commands. See
Source master controls.

- Solo button: Isolate the source by turning off all other sources. Click again to restore
the on/off status of other sources.

Note: If you save a preset with one source in solo mode, the resulting preset retains the
on state of the source, but solo mode is disabled. All other sources are off.

- Stereo button: Turn stereo mode on or off. If stereo mode is off and a stereo file is
loaded or imported, only the left channel is played. When stereo mode is on, loaded
or imported sounds are played in stereo. This makes it possible to pan individual
oscillators in the additive element or individual grains in the granular element,
for example.

- Edit button: Open the source edit window. See Alchemy source edit window overview.
- Volume knob: Set the source output level (-inf dB to 0 dB).

- Wait knob: Set a delay between the keystrike and triggering of the source.

- Coarse Tune knob: Tune the source pitch in semitone increments.

- Fine Tune knob: Tune the source pitch in increments of one cent (one hundredth of
a semitone).
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- Position knob: Determine the playback start position in the audio data. A value of 0%
indicates the absolute start point of the audio data. A value of 100% indicates the
absolute end point. See Source modulations.

When the Loop Mode pop-up menu and field (see entry below) is set to Start/End or
Start/Length, the Position (and Speed) knob is replaced with the following two controls:

(Loop) Start knob: Determine the playback start position in the audio data. A value
of 0% indicates the absolute start point of the audio data. A value of 100% indicates
the absolute end point.

« (Loop) End/Length knob: Loop End sets the playback end point. Loop Length
determines the playback length, expressed as a percentage of the overall length
of the sample.

- Speed knob: Set the audio data playback rate in additive, spectral, or granular mode.
Speed has no effect when the element is set to sampler mode. A setting of 100%
represents the original playback rate. Higher settings (up to 500%) represent faster
playback, while lower settings (down to 0%) represent slower playback.

Playback begins at the point set with the Position knob and travels through the audio
data on a path determined by the Loop mode. Speed determines the rate of this travel.
Playback remains at the normal pitch regardless of the rate of travel. Set Speed to 0%
to halt playback at the point set with the Position knob.

- Sample Tempo field: Displays the analyzed sample tempo of imported audio material.
You can set it to Off or a value between 5 and 990 to match the length of beats in the
audio file with beats in the project. The file tempo is automatically analyzed for tempo
(BPM) info on import.

Note: When Sample Tempo is set to any value other than Off, the speed of sample
playback is a multiple of the project tempo (BPM) and the analyzed audio file BPM.
This results in a beat in the audio file matching the playback time of a beat in the
project, when the Speed parameter is set to a value of 100%.

+  Keyscale pop-up menu and field: Choose from three key scaling options that affect
source pitch response to incoming MIDI data.

Key+PBend: The pitch of the source responds to MIDI note and pitchbend data.

Key: The pitch of the source responds to MIDI note data but does not respond to
pitchbend data.

Off: The pitch of the source does not respond to either MIDI note or pitchbend data.

Note: Global pitchbend behavior is determined with the PitchBend Up and Down
controls in the master voice section. See Alchemy master voice section.
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- Loop Mode pop-up menu and field: Choose from five loop mode options that affect
playback of the source audio data.

« None: Ignores the loop start and end points, and plays the entire sound once
without looping.

Continuous: Plays from the beginning, enters the loop region, and loops continuously
in a forward direction while a note is held and during the envelope release phase.

Sustain: Plays from the beginning, enters the loop region, loops continuously while a
note is held, and exits the loop region to play the normal sound release phase.

Forward/Back: Like Continuous, but plays the loop region alternately forward
and backward.

- Start/End: In this mode, playback starts from the defined start point, playing at 100%
speed to the defined loop end position, then skips to the start point and repeats.
These positions are set with the Loop Start and Loop End knobs (see entries above).

Note off messages have no impact on loop repetitions. If the loop end point is placed
before the loop start point, playback is reversed (backwards to the loop end point)
when the loop start point is reached.

Start/Length: In this mode, playback starts from the defined start point, playing
at 100% speed to the defined loop end position, then skips to the start point and
repeats. The length of the loop, controlled with the Loop Length knob, is set as a
percentage of the overall length of the sound, such that loop end point is equal to
the loop start point plus loop length.

If the settings of Loop Start and Loop Length controls (see entries above) cause
playback to go beyond the end of the underlying sample, silence is automatically
inserted at the end of the sound.

All: Ignores the loop start and end points, and loops the entire sound continuously.

Note: The loop start and the loop end points, and sample start and end points,
can be edited in the Main edit window. See Alchemy source edit window overview
and Zone waveform editor. The VA noise component is not affected by the Loop
mode setting.

- Waveform overview display: Shows the waveform for the source when the granular
or sampler element button is active. The display also shows real-time additive or
spectral data, or a representation of the waveform, if the Position or Speed controls
are selected. When Position is adjusted, a position indicator is shown, allowing you to
fine-tune the start position.

- Synthesis element buttons: Choose the synthesis type, and view and change related
parameters in the area below. A variable combination of the Additive, Spectral, Pitch,
Formant, Granular, Sampler, and VA buttons is available for use, depending on the audio
data specified in the source select field and the import method used, if applicable. See
Source elements overview and Import browser.
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Alchemy source filters in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The source filter module provides three multimode filters, which can be configured either
in series or in parallel. The source filters let you filter each source independently. The main
filters, by comparison, process a mix of all four sources. See Main filter controls.

Tip: Though you can use filters at multiple locations in the signal path, you can attain
identical or similar results by careful use of fewer filters, which helps to reduce CPU load.

- When the source filters are configured in series, the signal passes through the three
filters, one after the other.

Filter/

Filter Filter Filter FXSend

- When the source filters are configured in parallel, the signal is split and fed through the
three filters simultaneously.

Filter/
FX Send

Source filter parameters

The most common filter controls are listed. Note that the chosen filter type can change
both the name and function of available controls, notably the Cutoff, Resonance, and
Drive parameters. See Filter types and Source filter use tips.

- 1/2/3 buttons: Select each filter. The three filters are independent and can have unique

settings. The LED at the top of each button shows on (lit) or off (unlit) status.

FILTER

1 2 38

Ser Par

- On/Off buttons: Enable or disable each filter (1, 2, or 3).

- Filter type pop-up menu and field: Choose the filter type. Use the descriptive names
Clean, Edgy, Gritty, Rich, Sharp, and Smooth to make a choice that is right for your
sound. You can step through the available filter types with the Previous and Next
buttons (the arrows).
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Ser/Par buttons: Set the filter routing configuration. Series runs from filter 1 into filter 2.
Parallel runs the two filters side-by-side.

Cutoff knob and field: Set the cutoff frequency for the chosen filter type.

Resonance knob and field: Boost or cut frequencies above, below, or surrounding the
value set with the Cutoff knob. Resonance behavior varies among filter types.

Drive knob and field: Overdrive the filter. This can lead to intense distortions and
aliasing, depending on filter type.

Send knob: Set the level of the source output (post source filters, if used) sent to the
destinations specified with the Send pop-up menu.

Send pop-up menu: Determine where the source output is sent (post source filters,
if used).

« F1/F2: Source output is routed to main filters 1 and 2. The balance between these
targets is set with the Send knob.

- F1/FX A/B/C/D: Source output is routed to main filter 1 and effects rack A, B, C, or D.
The balance between these targets is set with the Send knob.

- F2/FX A/B/C/D: Source output is routed to main filter 2 and effects rack A, B, C, or D.
The balance between these targets is set with the Send knob.

Note: Signals sent to effects rack A, B, C, or D destinations bypass the main filters
when the Send knob is set to the full-right position. See Alchemy effects overview.

Alchemy source filter use tips in Logic Pro for Mac

Alchemy provides multiple filter types at different positions in the signal path. You can use
filters at the source level, and the main filters, and you can also insert filters in the Effects
section. The positioning can have a significant bearing on the sound produced and can also
impact on the processing resources required. Depending on currently available resources,
you may need to pay close attention to envelope settings, the number of voices, and other
parameters to achieve the sonic result you are chasing.

Source-level filtering provides the most precision and potentially the greatest sonic
impact on your sound. The downside is that source-level filtering requires more
processing resources. Processing is per voice.

Use of the main filters is more CPU-efficient and can have significant sonic impact.
Processing is per voice.

Effects section filters process the entire signal, rather than each voice independently.
Filtering at this stage of the signal path is often used to refine the overall sound or to
provide a performance control variation.

Use an FM filter as a sound source

The FM filter produces a sine wave that is modulated by your source signal. Because the

FM process adds harmonics to the sound, the more complex the sound you feed into the

filter (and the louder it is) the more quickly the sound is distorted. FM in Alchemy is great
for aggressive sounds, but is also useful for basses and other sounds.
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Unlike dedicated FM synths, Alchemy does not have preconfigured algorithms or a
modulation matrix set up for FM synthesis. It does, however, offer the option to run a
huge number of "operators” (FM filters) in various series and parallel configurations. FM
in Alchemy also has a sonic character that's different from classic FM synths. This means

following the approach outlined in the steps below is not always the best option in Alchemy

if you want to recreate classic digital FM sounds. Such sounds are often more easily

achieved by other means, such as with additive synthesis or resynthesis. FM in Alchemy is
more like working with FM on analog synths where you modulate oscillator frequency rather

than phase.

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Switch to advanced view, then click the A button to show source A parameters.
3. Use a sine or triangle wave as your source sound.

4. Click the source A filter On button to enable the filter, then choose FM from the Filter
type pop-up menu.

5. Control-click the Frequency knob, and choose Envelope Follower > Source A.

The filter is assigned to track keyboard pitch. By default, the centered knob at 523Hz
provides a medium pitched sound that works well. If you want to change the octave,

multiply or divide by two, and round to the nearest whole number that sounds best. For

example, set the Frequency knob at 262Hz for one octave lower.

6. Adjust the modulation Depth on the filter to increase the impact the source signal has

on the sine wave generated by the FM filter, and listen to the results. For more grit, try

adjusting the Feedback control, which allows the filter output to apply modulation to
itself.

7. FM in Alchemy requires experimentation to develop more complex sounds. Here are a
few things to try:

Use other types of VA oscillators or samples as your modulation source.

Run multiple FM filters in series or parallel to see what best meets your needs. When
doing so, resist high initial modulation and feedback depths so you can get a feel for

the degree of control you have in shaping the overall sound.

Use independent envelopes for the frequency and volume of your source (or on FM

filters earlier in the signal path) to hear the results this provides.

Important: Due to technical requirements, FM is often best done at the source filter
level. As you progress through the signal path, gain increases (and therefore FM)
become increasingly heavily modulated and distorted. You will find that it is easier to
work with FM at the source level than as a master filter or effect.
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Use a comb filter as a sound source

When making comb filters your primary sound source, you may find that longer master
envelope release settings are required for a natural feel when playing. This results in more
overlapping notes, higher polyphony, and therefore more CPU overhead. Because of this,
you may need to carefully adjust envelope release times and reduce the maximum number
of voices in the Master section.

1.
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In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Switch to advanced view, then click the A button to show source A parameters.

Click the source A filter On button to enable the filter, then choose Comb PM from the
Filter type pop-up menu.

Control-click the Frequency knob, and choose Envelope Follower > Source A.

The filter is assigned to track keyboard pitch. By default, the centered knob at 523Hz
will provide a medium pitched sound that works well. If you want to change the octave,
multiply or divide by two, and round to the nearest whole number that sounds best. For
example, set the Frequency knob at 262Hz for one octave lower.

Control-click the Volume knob for source A (choose the lowest feasible level), and
assign a New AHDSR from the menu.

Set up an envelope for your impulse signal to excite the comb filter. You can choose any
impulse type, from VA noise to resynthesized samples. The aggressive nature of FM
also makes this a good choice of impulse for comb filters.

The impulse requires its own envelope, separate from the master or any envelope you
have controlling the comb. The best settings for the envelope depend on the needs of
the sound, but a good rule of thumb is to start with zero attack, zero hold, a very short
decay, zero sustain, and zero release. This provides a quick spike that starts comb
movement and allows the remainder of sound generation be handled by the comb itself.

Tip: The chosen impulse can have a large impact on the tone so it is worthwhile
experimenting with different sound sources. One approach is to import a sample with a
strong initial attack using the Additive import method, then use the Additive Harmonic
effect knobs to adjust the tone. These controls plus comb filtering can provide
numerous fast and easy adjustments, letting you dramatically alter the perceived
hardness, material, and tone of your modeled sound. You can also import a drum loop
and set it to sustain with Continuous Loop mode. Because drum loops typically contain
short bursts of sound that vary in tone, they work well with comb filters.

Use the Damp control to reduce ringing or other artifacts in the sound, if required.
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Alchemy source elements overview in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

Each source can make use of multiple synthesis elements that operate on different
functional principles. You can use a synthesis method independently, or you can combine
multiple synthesis types by turning on all required elements. For example, you can
combine granular synthesis with virtual analog synthesis, or additive synthesis with
spectral synthesis. Each synthesis method has inherent strengths and weaknesses,
making them more suitable for certain sound types than other synthesis engines. If
you're new to synthesis or are unfamiliar with different synthesis approaches, see
Synthesizer basics overview.

SPECTRAL PITCH FORMANT VA

The Additive, Spectral, Pitch, Formant, Granular, Sampler, and VA buttons on the source
subpage show synthesis engine parameters. Not all of these buttons are available for
use at any one time. The combination of active buttons updates to reflect the audio
data specified in the source select field and the import method used, if applicable.

See Import browser.

See these sections for detailed information on parameters and functions.
- Additive element controls

- Additive element effects

+ Spectral element controls

+ Spectral element effects

- Pitch correction controls

- Formant filter controls

+ Granular element controls

«  Sampler element controls

- VA element controls

Alchemy additive element controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the Additive button is active in a source
subpage. The additive element controls also include a number of additive effects. See
Additive element effects.

SPECTRAL PITCH FORMANT

Sine Complex
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Additive element parameters

On/off button: Enable or disable the additive element in the source. This can be useful
when an audio file has been imported using Add+Spec mode and both the additive
and spectral engines are used to recreate different aspects of the sound. Use the on/
off button to disable either section if you need to listen to the additive or spectral
component in isolation.

Sine/Complex buttons: Use Sine to resynthesize each partial with a sine wave. Use
Complex to choose a resynthesis waveform from the Shape pop-up menu.

Sine mode results in the most accurate resynthesis of the original sample and makes it
easy to work with the additive effects and formant controls. In Complex mode, choosing
any non-sine waveform can have a dramatic and often unusual effect on the overall
timbre of the sound.

Note: The additive effects and formant controls are named on the assumption that each
partial is a sine wave. If one of the complex waveforms is used, the Pulse/Saw knob and
formant shape selectors behave in a more complex manner. To simplify working with
these controls, it is recommended that the Sine option is chosen in most cases.

Shape pop-up menu: Choose a waveform used to resynthesize each partial in
your sound.

Volume knob: Set the output level of the additive element within the source. When
multiple elements are used in a source, use this control to set the relative level of
the additive component.

Num Partials knob: Set the number of additive partials that are generated (up to 600).

The number of oscillators required depends on the sound. For example, a flute has a
limited number of harmonics and requires fewer partials than a cello or a violin. The
playable register can also affect the number of oscillators required: high notes will
accommodate only a small number of higher harmonics before reaching the limits of
audibility, while low bass notes may have hundreds of harmonics without reaching the
limit. Alchemy automatically sets a suitable Num Partials value when re-synthesizing
additive data from imported audio files. You can reduce this value in some cases, but
removing higher partials can cause unwanted changes to certain sounds.

Note: The additive engine processes partials in groups of four. Set the Num Partials
parameter to a multiple of four to achieve the best compromise between CPU load
and sound quality. Always set Num Partials to the lowest number of partials that are
required by the sound because this helps to reduce CPU load.

PVar knob: Tune all partials simultaneously. This occurs before processing by the
additive effects modules which stretch/shift partial tunings. Set to 0% to tune all
partials in a perfect harmonic series. Set to 100% to make each partial follow the pitch
fluctuations detected in the original audio file. The sonic impact of this parameter is
highly dependent on the audio material: sounds with strong inharmonic content such
as bells are dramatically changed by reducing pitch variations. If all partials are tuned
to the harmonic series, however, the knob has no influence on the sound.

The pitch variation knob is most useful when dealing with resynthesized audio.

For example, if you analyze a vocal sample recorded with vibrato, this knob lets
you reduce the vibrato depth, or remove it entirely with a setting of zero. Removing
all pitch variations from a vocal can result in a synthetic, artificial character.
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- Sym knob: Alter the symmetry, or shape, of sine waves by lengthening the first half of
the waveform while shortening the second, or the reverse. The audible effect is similar
when the knob is turned in either direction. Symmetry alters waveforms until they are
no longer pure sine waves in shape, resulting in each partial developing independent
harmonics and making the sound brighter.

Resynthesize a sound and modify it with the main additive controls

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Click a source select field, then choose Import Audio from the pop-up menu.
3. In the Import browser, click the Additive button to change the analysis mode.
4. Choose an audio file, then click Import.

Single notes with a strong harmonic character tend to work well. A good source of such
files is the Vocals subfolder of the EXS Factory Samples folder.

5. Play the file up and down the keyboard and reduce the value of the Num Partials knob to
remove upper harmonics. Note that when playing higher notes you will need to turn this
knob down further before you hear it start to take effect.

6. Reduce the PVar knob value to remove all pitch variations and force all partials to a
perfect harmonic series. A PVar value of zero completely removes any vibrato or pitch
changes in the source sound.

7. Adjust the Sym knob value to change the symmetry of source sine waves, and note the
extra brightness that is introduced by new harmonics that are generated.

Alchemy additive element effects in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

Three effects units are available in the lower half of the additive parameters shown
in the source subpage. See Additive element controls. These are not audio effects
in the traditional sense; rather they provide ways to control entire groups of partials
simultaneously. Each unit provides a different selection of effects. Unit 1 is devoted
to amplitude effects, unit 2 to pitch effects, and unit 3 to panning effects.
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The initial configuration of the effects units changes when you use the default preset and
when you import a sample. A preset with initialized settings loads the Pulse/Saw module
into unit 1. A sound with an imported sample loads the Harmonic module into unit 1.

Note: Some effects are included only for compatibility with older Alchemy versions. These
effects are shown when a preset based on the older Alchemy architecture is loaded, but
you cannot see, nor insert, these "legacy” effects in new presets or in presets designed
for the new Alchemy architecture.

On Harmonic v On Beating » On Spread

A F 1
’ 4 .

Fundamental Octaves Amount Partial Amount Ramp

I A Y ’ ]

QOdd/Even Fifths Tuned Rate Cycles

Additive effect 1 (amplitude) parameters
- Additive effect on/off button: Enable or disable the additive effect unit.

WARNING: Turning off additive effects modules, particularly additive effect 1, can result
in a significant level increase. It is best to turn down your amplifier or mixer levels to
avoid signal spikes that may damage your speakers or hearing.

- Additive effect 1 pop-up menu and field: Choose an effect type that is used to adjust
the levels of different partial groups. Your choice determines the controls that are
shown. Choosing None results in an equal volume level for all partials, which can
sound extremely bright and harsh.

«  Harmonic: Allows you to set groups of partial levels.

«  Fundamental knob: Set the level of the fundamental tone and all partials above it.
Set to zero to completely remove the fundamental tone. Set to 100% to hear the
fundamental tone in isolation. Higher values tend to make the sound thicker.

Octaves knob: Set the level of the fundamental tone and all partials at whole
octave intervals above it. Set to zero to completely remove harmonics 1, 2,

4, 8, 16, and so on, while boosting the levels of non-octave harmonics. Set to
higher values to boost the levels of octave harmonics while reducing the levels
of other harmonics.

- Odd/Even knob: Set the balance between odd or even harmonics. Low values
increase the level of odd-numbered partials (1, 3, 5, 7, and so on), making
the sound more hollow. High values increase the level of even harmonics
(retaining the fundamental tone: harmonic/partial 1) to make the sound
brighter and sweeter.

Fifths knob: Set the level of the fundamental tone and all partials at fifth intervals
(7 semitones) above it. Higher values boost harmonics 1, 3, 9, 27, and so on, with
a corresponding reduction in the levels of other harmonics. Low values have the
reverse effect and can make the sound more cutting and edgy.
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- Pulse/Saw: Scales partial levels to make higher partials softer than low partials.
Loaded by default when no sample has been imported into the additive element
of the source.

Pulse/Saw knob: Set the mix ratio between a pulse wave and a sawtooth wave,
created by summing sine wave partials tuned to a harmonic series. Turn toward
Pulse to mute even harmonics. Note that if one of the complex waveforms is
used, the Pulse/Saw knob behaves differently.

« Sync knob: Enable oscillator sync and set the pitch that the main oscillator is
synchronized with.

- Odd/Even knob: Set the balance between odd or even harmonics. Low values
increase the level of odd-numbered partials 1, 3, 5, 7, and so on, making
the sound more hollow. High values increase the level of even harmonics
(retaining the fundamental tone: harmonic/partial 1) to make the sound
brighter and sweeter.

Tone knob: Tilt the overall spectrum from flat to steeply angled, affecting the
tonal color.

- Saw+Noise: Saw wave with noise applied to the amplitude of harmonics.
- Noise knob: Set the amount of noise applied to amplitudes of harmonics.
« Rate knob: Set the rate at which the noise value is changed.

- Smooth knob: Set a response that varies between an instant change at each
new value through to a gradual ramp over the entire time period.

- Tone knob: Tilt the overall spectrum from flat to steeply angled, affecting the
tonal color.

Additive effect 2 (pitch) parameters
- Additive effect on/off button: Enable or disable the additive effect unit.

- Additive effect 2 pop-up menu and field: Choose an effect type that is used to

adjust the tuning of different partial groups. Your choice determines the controls
that are shown.

- Beating: Allows a group of partials to be detuned to create beating effects as they
move in and out of phase with adjacent partials or to add a clangorous, atonal
character to a sound. The group of partials affected is defined by the Partial knob.

Amount knob: Set the amount of detuning for selected partials. The range of this
knob is determined by the position of the Tuned knob.

Partial knob: Define the pattern of (groups of) partials affected. Set to 2 to

limit the detuning affect to only partials 2, 4, 6, 8, and so on; set to 3 to apply
detuning to only partials 3, 6, 9, 12, and so on. Higher values affect fewer partials,
which in turn changes the impact of the Amount knob, making it more subtle.
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Tuned knob: Set the range for the Amount knob. This knob behaves like a switch.

On: At the zero position, the selected partial is tuned down to the pitch of the
second partial below. When the Amount knob is at 100%, the selected partial
is unaffected.

Off: At the zero position, the selected partial is tuned down to the pitch of the
second partial below. When the Amount knob is at 100%, the selected partial is
tuned up to the pitch of the next partial above.

Stretch: Allows the tuning of partials to be stretched upward, sharpening upper
partials while retaining the original fundamental tone pitch. This stretching of
the harmonic series is typical of instruments that use vibrating strings or tines.

Amount knob: Stretch the tuning of all partials equally. Higher values increase
the intervals between partials and shift higher partials upward. Lower values
decrease the intervals between partials and shift higher partials downward. This
is a quick way to tune upper partials without the need to manually edit partial
pitch values in the additive editor. See Additive edit window overview.

String knob: Stretch the tuning of higher partials more intensely than lower
partials. Small increases can result in a subtle sweetening of the sound without
altering its basic character. Larger increases can add an inharmonic, metallic, or
bell-like quality to upper partials. Modulate this parameter with an envelope to
add a plucked string type articulation to the start of a note.

Shift: An unusual frequency shifter type effect that moves all partials up or down

by the same amount in hertz, thereby breaking the harmonic relationships between
them. In a sound with a fundamental frequency of 220 Hz and a second harmonic an
octave higher at 440 Hz, an upward frequency shift of 100 Hz results in partials at
320 Hz and 540 Hz, with the second partial no longer an octave higher than the first.
This effect type can radically alter the harmonic structure, leading to inharmonicities
and atonalities, in addition to a perceived change of the fundamental pitch.

Pitch knob: Set the amount of shift for the first harmonic. All subsequent partials
are shifted by the same amount in hertz rather than in semitones because this
would result in a simple pitch change. Defining the frequency shift in this way
retains a consistent timbre as you play up and down the keyboard.

Freq knob: Define a static shift in hertz. Because the shift does not track the
keyboard, the timbre of the resulting sound changes from note to note. When
combined with another harmonic sound (in the VA section, for example), small
shifts can create beating, chorus-type effects between the source elements.
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- Magnet: Allows you to shift the tunings of all partials toward a specified target
pitch. This can lead to unusual effects and can result in dramatic transformations
of the sound.

Amount knob: Specify the amount of pitch shift as a percentage. At 100%, all
partials are set to the pitch determined by the Pitch knob. At 50%, all partials are
moved halfway to the target pitch. Subtle use of this parameter can turn harmonic
pitched sounds into atonal bell-like timbres, for example.

Pitch knob: Set the target pitch. All partials are shifted toward the target when
the Amount knob is rotated. At low positions, partial pitches shift down. Toward
100%, partial pitches shift up. At 50%, high partial pitches shift down and

low partial pitches shift up. Adjust the knob to balance the shift and to control
the brightness of any atonal, inharmonic elements that may be introduced to
the sound.

Noise: Applies noise to shift the tunings of partials. This can lead to chaotic effects.

Amount knob: Set the amount of noise applied to partials.

Rate knob: Set the rate at which the noise value is changed, with a smooth ramp
of pitches between these points.

Smooth knob: Set a response that varies between an instant change at each new
value through to a gradual ramp over the entire time period.

Min. Partial knob: Set the amount that noise affects low or high partials by
specifying the minimum partial that is altered by the effect.

Additive effect 3 parameters

Additive effect on/off button: Enable or disable the additive effect unit.

Additive effect 3 pop-up menu and field: Choose an effect type that is used to process
the output of the additive element.

- Auto Pan: Modulates the pan positions of all partials from left to rightin a
regular pattern.

«  Amount knob: Set the depth of the stereo panning effect.

« Rate knob: Set the speed of the stereo panning effect.

« Ramp knob: Set the panning amount for lower partials. This can create a subtle

widening of the sound, with less obvious left to right movement in the lowest
partials.

Cycles knob: Set phase differences between partials. At zero, all partials are in-

phase. Higher values lead to a finer, more subtle and complex effect.
Comb: Applies a comb filter to the output of the additive element.
Amount knob: Set the depth of the comb filter effect.
Damp knob: Set the duration of each dip (or notch) in the comb.
Freq knob: Set the frequency of the filter. The range is from 16 Hz to 20 kHz.
F-Back knob: Set the amount of feedback.
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EQ: Applies an EQ to the output of the additive element. Crossover frequencies
are centered at 120 Hz, 800 Hz, and 5000 Hz, with a one octave transition
between bands.

Low knob: Set the amount of low frequency cut or boost.

Low Mid knob: Set the amount of lower mid frequency cut or boost.
High Mid knob: Set the amount of upper mid frequency cut or boost.
High knob: Set the amount of high frequency cut or boost.

Filter: Applies a continuously variable lowpass/highpass filter to the output of the
additive element.

Amount knob: Set the depth of the filter effect.

LP - HP knob: Set the shape of the filter blending between a low pass, band pass,
and high pass filter.

Cutoff knob: Set the cutoff frequency. The range is from 16 Hz to 20 kHz.
Res knob: Adjust the level of frequencies surrounding the cutoff frequency.

Spread: Modulates the pan positions of all partials to create a wide pseudo-stereo

effect. Partials are panned left to right in a regular pattern, with every second partial
position inverted.

« Amount knob: Set the depth of the stereo panning effect.
« Rate knob: Set the speed of the stereo panning effect.

« Ramp knob: Set the panning amount for lower partials. This can create a
subtle widening of the sound, with less obvious left to right movement in
the lowest partials.

Cycles knob: Set phase differences between partials. At zero, all partials are
in-phase. Higher values lead to a finer, more subtle and complex effect.

Strum: A filter that modulates the amplitudes of partials to create interesting effects,
some of which can be reminiscent of guitar strumming.

Amount knob: Set the depth of the effect.

Partial knob: Select the partial (number) that you want to set to full amplitude.
Modulating the partial number can create rhythmic melodic effects.

« Release knob: Set the release (or decay) time for the selected partial. Shorter
release times and slower modulation of the partial number can create strumming
of partials.

- Width knob: Set the number of partials in a range surrounding the
selected partial.

Ripples: Applies a sine wave to the amplitude of partials, resembling waves or
ripples in water.

Amount knob: Set the depth of the effect.
Group knob: Select a group of partials to be processed.

Period knob: Set the number of partials over which one full cycle of the sine wave
is applied. For example, a value of 10 applies a sine wave shape over partials 1-10,
11-20, 21-30, and so on.

«  Phase knob: Set the phase of the sine wave. Modulate this with a ramp up LFO for
smooth sound changes.
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Alchemy spectral element controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the Spectral button is active in a source
subpage. Two Spectral element effects units are available in the lower half of the spectral
parameters shown in the source subpage.

Note: You must first perform a sample import with a spectral analysis or draw in the
Spectral edit window before you can use any of the spectral engine parameters. See
Import browser and Spectral edit window.

Spectral resynthesis analyzes the changing frequency spectrum of a signal and attempts to
recreate these spectral characteristics. In Alchemy, the audible spectrum of a signal is split
into a large number of spectral bins. Energy distribution across these bins is analyzed and
the sound is recreated by filling each spectral bin with the required amount of signal, using
either sine waves or filtered noise. The results are then summed.
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Spectral element parameters

- On/off button: Enable or disable the spectral element in the source. This can be useful
when an audio file has been imported using Add+Spec mode and both the additive
and spectral engines are used to recreate different aspects of the sound. Use the
on/off button to disable either section if you need to listen to the additive or spectral
component in isolation.

- Pitch/Noise buttons: Use Pitch to fill spectral bins with sine waves. Use Noise to
fill spectral bins with filtered noise. The chosen audio import mode automatically
changes the state of these buttons, but you are free to change this to meet the
sound'’s requirements.

Spectral import: Enables only the spectral element and sets the mode to pitch.
The spectral bins are filled with sine waves, which is generally the best choice
to recreate the entire original signal. Noise mode can be useful for transforming
normal speech into whispering, for example.

« Add+Spec import: Enables both the additive and the spectral engines. The spectral
engine is used only to recreate noisier aspects of the sound because this is not a
strength of additive resynthesis. In this case, the mode is set to Noise.
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- Volume knob: Set the output level of the spectral element within the source. When
multiple elements are used in a source, use this control to set the relative level of
the spectral component.

- Low Cut knob: Set a cutoff frequency. All signals above this frequency are allowed to
pass. Signals below the frequency are cut.

- High Cut knob: Set a cutoff frequency. All signals below this frequency are allowed to
pass. Signals above the frequency are cut.

The Low Cut and High Cut parameters work in conjunction with each other to act as a

bandpass filter, where signals that fall within the two cutoff ranges are allowed to pass.

Alchemy spectral element effects in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch

to advanced view, then click the A/B/C/D button to select the source you want to edit.

Alchemy spectral element effects provide a number of creative options in the spectral
synthesis engine. Two effects units are available in the lower half of the spectral
parameters shown in the source subpage. See Spectral element controls for information
on other spectral element parameters.

Note: You must first perform a sample import with a spectral analysis or draw in the
Spectral edit window before you can use any of the spectral engine parameters. See
Import browser and Spectral edit window.
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Spectral effect parameters
- Spectral effect on/off buttons: Enable or disable the spectral effect unit.

- Spectral effect pop-up menus and fields: Choose a spectral effect type. See spectral
effect descriptions below.

+ Mix knob: Set the balance between the original signal and the processed sound. This
parameter is common to all spectral effect types.

- Parameter knob 1: Set the value for the parameter assigned to the chosen spectral
effect. The parameter name and function vary with each effect type.

- Parameter knob 2: Set the value for the parameter assigned to the chosen spectral
effect. The parameter name and function vary with each effect type.

- Parameter knob 3: Set the value for the parameter assigned to the chosen spectral
effect. The parameter name and function vary with each effect type.
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Bloom

Bloom produces a burst of frequencies based on the source sound. Note that this effect
requires a small amount of calculation time to collect and release a group of frequencies.
As a result, there may be a gap between playing a note and hearing the effect.

Tip: Try single note samples with a strong initial attack, such as a piano, and set Mix to

a value that introduces the effect as part of the tail of the sound.

.

Mix knob: Set the balance between the original signal and the processed sound.
Threshold knob: Set the amount of lower amplitude frequencies heard in the effect.
Attack knob: Set the time it takes for effect-generated frequencies to fade in.

Shift knob: Move the emphasis of the effect from lower harmonics (negative values)
to higher harmonics (positive values). When centered (0), the original frequency
balance is used.

Blur

Blur produces a frequency blurring effect.

Tip: Try a melodic loop with pitch variations to best hear the impact of this effect.

Mix knob: Set the balance between the original signal and the processed sound.
Length knob: Set the time period that frequencies are sustained (blurred over time).

Variance knob: Set the degree of variation for frequency selection (frequencies that
are blurred).

Gate knob: Determine the impact of the source sound envelope on the effect and the
number of audible frequencies. For example, when used on a loop, higher settings
produce a simplified sound with more frequent gaps in the effect output.

Cloud

Cloud produces what might best be described as a cloud of frequency grains, resulting in a
textured chorus effect.

Logic Pro Instruments for Mac

Tip: Try this effect on vocal samples.

Mix knob: Set the balance between the original signal and the processed sound.
Threshold knob: Set a sustained emphasis on the highest amplitude harmonics.

Attack knob: Set the time it takes for frequencies emphasized by the Threshold setting
to fade in.

Simplify knob: Reduce lower amplitude frequencies to enhance prominent frequencies,
lessening detail in favor of an increasingly pure tone.
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Gate

Gate is best described as a combination of a square wave LFO and envelope follower
modulation for frequencies in the spectrum. Depending on your settings and source
material, this can either produce a choppy sound or a smoother one.

Tip: Drum loops are an ideal starting point when learning uses for this effect.

- Mix knob: Set the balance between the original signal and the processed sound.

- Threshold knob: Set the amount of lower amplitude frequencies that are allowed to
pass through the gate. This reduces detail and enhances prominent frequencies in
the source.

- Attack knob: Set the time it takes for effect-controlled frequencies to fade in.

- Decay knob: Set the time it takes for effect-controlled frequencies to fade out.

Glide

Glide creates adjustable, repeating upward filter sweeps that are based on the source
content. Note that this effect requires a small amount of calculation time before the
results of your adjustments are heard.

Tip: Sources with wide frequency ranges produce a more pronounced filter sweep
sound, whereas sources with limited frequencies can result in unique melodic drones
as narrow filters sweep across their ranges.

«  Mix knob: Set the balance between the original signal and the processed sound.
- Freq knob: Set the starting frequency for the sweep.

- Width knob: Set the width of the filter (the frequency range, or band, affected by the
filter).

- Shift knob: Set the height of the sweep.

Freq Shift

Freg(uency) Shift moves the spectral bins higher or lower in the spectrum, reducing
the level of (or entirely dropping) some frequencies while emphasizing others. This is
a powerful sound design tool that can dramatically alter the sound and can introduce
inharmonic overtones.

Tip: Try single note samples with a strong initial attack, such as a piano, and blend the
mix level so that the effect comes in as part of the tail of the sound.

+ Mix knob: Set the balance between the original signal and the processed sound.

- Shift knob: Move bins up (positive) or down (negative) the frequency spectrum. Start
with small adjustments because this parameter has a wide range.

- Feedback knob: Set the intensity of selected frequencies.

- LP Cutoff knob: Set the cutoff frequency. Higher frequencies are attenuated.

Logic Pro Instruments for Mac 55



Freq Stretch

Freg(uency) Stretch is an unusual and powerful effect in that spectral peaks are shifted
based on a combination of the Alpha and Beta knobs, resulting in a series of inharmonic
stretches and randomizations.

Tip: This effect is highly dependent on the available frequency range in the imported
sample. For example, the Alpha and Beta knobs are useful across the entire range with
drum loops, whereas the most useful Alpha and Beta ranges are small positive or negative
deviations from the center position when used with spoken vocals.

+ Mix knob: Set the balance between the original signal and the processed sound.

- Alpha knob: Shift harmonics to produce an effect reminiscent of a formant filter. A
setting of 1 (centered) is closest to the source sound.

- Beta knob: Set the frequency range of the effect. A setting of 1 (centered) is closest to
the source sound.

- Variance knob: Introduce randomization to frequency shifts. Depending on source
material and Alpha/Beta settings, these can range from “underwater” sounds to
powerful noise clouds.

Metallize

Metallize produces classic comb filter style effects.
Tip: Experiment with drum loops to clearly hear the impact of the controls.

+ Mix knob: Set the balance between the original signal and the processed sound.
- Interval knob: Set the effect frequency.

- Simplify knob: Reduce the number of effect-generated frequencies, resulting in a
simplified sound.

- Feedback knob: Set the intensity of the effect. Higher settings emphasize harmonics,
creating metallic resonances.

Shimmer

Shimmer sweeps the frequencies to varying degrees and speeds, imparting either slow
frequency shifts or fast shimmering sounds.

Tip: Try pure organ samples to clearly see the results of the effect in the realtime
spectrogram display, particularly at moderate rate settings.

+ Mix knob: Set the balance between the original signal and the processed sound.
+ Rate knob: Set the sweep speed.
- Shimmer knob: Set the intensity of the frequency sweep.

- Feedback knob: Adjust to introduce resonant, metallic harmonics that are reminiscent of
sounds that can be attained with comb filters.

Logic Pro Instruments for Mac 56



Shuffle

Shuffle randomly rearranges blocks of bins, resulting in an increasingly abstract and
scattered sound.

Tip: Import a bell sample, and start with very low settings to see and hear the impact of
controls on the sound.

- Mix knob: Set the balance between the original signal and the processed sound.
- Factor knob: Set the number of blocks (of bins) that you want to shuffle.
+ Range knob: Set the distance (number of bins) that you want to move each block.

- Bins knob: Set the number of bins contained in each block. Note that bins are numbered
(and selected) sequentially.

Smear

Smear averages between blocks of frequencies to create a smoother, more consistent
sound. It delivers different results to the Blur effect.

Tip: Try melodic loops that have pitch variations to showcase this effect.

- Mix knob: Set the balance between the original signal and the processed sound.

- Smooth knob: Set the number of frequency blocks to smooth between. Higher settings
have less sonic variation, so make small changes.

- Bright knob: Emphasize higher frequencies.

- Phase On: Enable to preserve the original phases of the source sound. This natural
variation in the sound provides a more organic cloud-like effect. Disable to lock the
phases of the source, resulting in a tight, metallic sound.

Alchemy pitch correction controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the Pitch button is active in an additive or
spectral source subpage.

ADDITIVE  SPECTRAL FORMANT
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Pitch correction parameters
- On/off button: Enable or disable pitch correction.

- Amount knob: Set the intensity of pitch correction. Higher values result in
stronger correction.

- Speed knob: Set the delay time before pitch correction occurs, following a change in
the pitch of the sound. This is shown as a percentage.

- Pitch pop-up menu and field: Choose a criteria that snaps all pitches to the
chosen value.

One Note: All pitches are snapped to a single pitch.

Octaves: All pitches are snapped to the nearest octave.

Fifths: All pitches are snapped to the nearest fifth.

Octaves&Fifths: All pitches are snapped to the nearest octave or fifth.

Chromatic: All pitches are corrected to a chromatic scale.

Alchemy formant filter controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the Formant button is active in an additive
or spectral source subpage.

When audio is imported into the additive or spectral engines with the Formant option
enabled, the signal is analyzed and resonances in the original signal are extracted and
converted into a formant filter shape. See Import browser.

The formant filter scales the amplitude of additive partials or spectral bins over time to
recreate the characteristic resonances of the instrument, rather than processing the audio
signal like a conventional filter.
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Formant filter analyzed parameters

The analyzed controls work only if you enable the Formant button in the Import browser
when importing your audio files. This more detailed analysis attempts to determine the
resonant frequencies of the source audio data.

On/off button: Enable or disable the analyzed formant section.

Shift knob: Shift the formant filter up or down in semitones. Higher values can make
sounds seem brighter or thinner. Lower values can create a darker, thicker character.

KTrack knob: Determine how the formant filter tracks notes on the keyboard. At 100%,
filter resonances shift up or down in pitch with the note. Set to lower values to reduce
key tracking which may make some sounds playable over a wider keyboard range.

Size knob: Stretch the formant filter to change the perceived size of the resonant
chamber. Use this parameter to alter the size of a guitar body or to make a child's
vocal sample sound like that of a giant, for example. The Size knob works in
conjunction with the Center parameter.

Center knob: Set the center frequency for formant stretching (controlled with the Size
knob). Resonances below the center frequency are shifted upward as the Size knob
value is increased. A corresponding downward shift occurs to resonances above the
center frequency.

Note: The Center knob has no effect when the Size knob is set to 100%.

Smooth knob: Set the rate of change for the formant filter. High values smooth and slow
down formant changes. Low values exaggerate and speed up changes. Low values can
also introduce an unusual “chattering” distortion that may be suitable for drum sounds.

Formant filter synthesized parameters

The synthesized controls work with any additive or spectral material and do not require
the formants to be analyzed on import. Use these parameters to impose new resonant
characteristics on the original signal. The default settings provide a range of vowel sounds:
use the Select knob to morph through the default “a,” "e,” "i," "0,” and "u” vowel sounds
loaded into the four slots to the right.

.

On/off button: Enable or disable the synthesized formants section.

Shift knob: Shift all synthesized formant filters up or down in semitones. Higher
values can make sounds seem brighter or thinner. Lower values can create a darker,
thicker character.

Size knob: Stretch the formant filter to alter the perceived size of the resonant chamber.
Size works in conjunction with the Center knob.

Center knob: Set the center frequency for the formant stretch set with the Size knob.
Resonances below the center frequency are shifted upward as the Size value is
increased. A corresponding downward shift occurs to resonances above the

center frequency.

Select knob: Morph smoothly through the four filter units. The displayed value indicates
position. Whole numbers indicate a particular filter unit, and fractional values indicate a
position between filters.
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Filter type pop-up menus and fields: Choose the filter type used in each of the four

formant filters. You can step through the available filter types with the Previous and

Next buttons (the arrows).

Off: Passes the original data, as if the synthesized section were turned off. Assign
this type to use one of the four filter units as a bypass. Adjust the Select knob to
quickly disable synthesized formant processing.

Comb filters: Comb filters are so-named because they create a distinctive comb-like
pattern of boosts and cuts in the frequency spectrum, arranged in a harmonic series.

« Comb Neg: The position of the first harmonic is determined by the Shift knob.

The Size knob can be used to stretch the pattern of cuts and boosts up or down
the frequency spectrum, or both, depending on the setting of the Center knob.

The negative filter name is used because it recreates the effect of a phase-
inverted delayed signal that boosts only odd harmonics, resulting in a
hollow sound.

Comb Pos: This filter emulates the effect of mixing in a positive phase delayed

copy of the original signal, resulting in a boost of both even and odd harmonics.

This filter has a brighter sound than the negative comb filter.

«  Metal Combs: The Brass, Iron, Steel, and Tin comb filter variants provide a

distinctive tonal coloration that emphasizes different harmonics in the frequency

spectrum. To help you visualize these differences, the “teeth” (harmonics) on

the comb are of varying thicknesses and are spaced at different intervals in each

filter. Experiment with each comb to determine the best choice for your sound.

Classic and Parallel filters: The classic variants are two-pole designs. The parallel
filters are multipole designs.

«  Band Pass: A bandpass filter with a gentle slope. Signals above or below the set

center frequency are attenuated.

« High Pass: Emulates a two-pole highpass filter that gently reduces the levels
of lower frequencies. The Shift knob sets the cutoff frequency. The Size knob
changes the filter slope.

Low Pass: Emulates a two-pole lowpass filter that gently reduces the levels of
higher frequencies. The Shift knob sets the cutoff frequency. The Size knob
changes the filter slope.

Notch: A filter that attenuates a narrow band of frequencies near the set
frequency. The frequency band can be moved up or down the frequency

spectrum with the Shift knob. The Size knob sets the width of the band (notch).

«  Peak: A filter that boosts a narrow band of frequencies around the set frequency.

The frequency band can be moved up or down the frequency spectrum with the

Shift knob. The Size knob sets the width of the band.
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- Vowel Bright, Classic, and Smooth filters: Bright vowel sounds contain more high
frequency content and are the most aggressive-sounding. Classic vowel sounds
are warmer, and are similar to synthesizer vowel sound filtering. Smooth variants
are more natural-sounding vowel shapes with a gentler filter slope.

Tip: Most of the “vowel” filters are not strictly designed to create that exact
vowel. Each Bright, Classic, and Smooth vowel filter is more of a unique variation on
that general sound, with not only brightness differences, but also overall character
differences. Additionally, any vowel filter can be independently modulated, alone or
in conjunction with Select knob morphing between filters (even from mismatched
sets). Use these facilities to dramatically expand your filtering options.

Vowel A: Mimics a set of vocal chords to impose an “a” vowel sound on the audio.
Each variation of this complex filter shape has prominent peaks at different
frequencies. It is, generally speaking, an open-sounding filter.

Vowel E: Mimics a set of vocal chords to impose an “e" vowel sound on the audio.
Each variation of this complex filter shape has prominent peaks at different
frequencies. It is, generally speaking, an open-sounding filter.

- Vowel I: Mimics a set of vocal chords to impose an "i” vowel sound on the audio.
Each variation of this filter shape has prominent upper midrange peaks and a
further low-mid peak, making this filter sound thinner and less open than the "a"
and "e" vowel filters.

Vowel O: Mimics a set of vocal chords to impose an “0” vowel sound on the audio.
This filter shape has gentler midrange and upper midrange peaks with a dominant
low-mid resonance. The result is a rounder sound with less brightness and
presence than the vowel types above.

- Vowel U: Mimics a set of vocal chords to impose a “u” vowel sound on the
audio. This filter shape has gentler midrange and upper midrange peaks with
a prominent low-mid resonance. The "u” filter variants also emphasize higher-
range content around 7 and 8 KHz, for example, making them sound thinner
than the "o" filter.

Modify formants in a resynthesized additive guitar sound

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Select source A, then click the source select field and choose Import Audio from the

pop-up menu.
In the Import browser window, click the Additive and Formant Import Mode buttons.

Navigate to the Guitars subfolder in the EXS Factory Samples folder, and choose a
single guitar sample.

When loading is complete, click the Formant button to the right side of the source A
window. Note that the upper Analyzed section is turned on.

Adjust the Shift knob to move resonances up or down in frequency and to change
the timbre. Small amounts of Shift variation work well for subtle changes: try a few
semitones in either direction.
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7.

Play some very low notes, then some very high notes. Gradually turn down the KTrack
knob to reduce key tracking for the formant filter, and note the difference when you
replay the high and low notes.

Adjust the Size knob value to change the apparent size of the guitar body. Also adjust
the Center knob value, and note the effect it has on the tone of the resulting larger or
smaller guitar body.

Modify formants in a resynthesized spectral drum loop

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Select source A, then click the source select field and choose Import Audio from the

pop-up menu.
In the Import browser window, click the Spectral and Formant Import Mode buttons.

Navigate to the Loops subfolder in the EXS Factory Samples folder, and choose a
drum loop.

When loading is complete, click the Formant button to the right of the source A window.
Note that the upper Analyzed section is turned on.

Adjust the Size knob value to make the drums seem bigger or smaller.

Adjust the Smooth knob value to alter the rate of change for the formant filter. Higher
values smear the timbre of one drum into the next. Lower values exaggerate changes
and create an unusual distortion near the bottom of the knob range.

Create a talking additive sound with synthesized vowel formants

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Select source A, then turn off the oscillator in the VA section to the right.

Click the Additive button, and turn on the additive section. You will hear an additive
sawtooth sound if you play some notes.

As an option, increase the Num Partials value. This helps to prevent the sound
becoming dull if played in lower registers.

Click the Formant button, and turn on the lower Synthesized section. Play a few notes
to hear the "a” vowel sound that is imposed on the sawtooth wave.

. Increase the Select knob value, and play a few notes. Note how the vowel sound morphs

to an "e,” then an "i,” then finally a “u” at 100%.

Reduce the Select knob value, then modulate it with a new AHDSR envelope (AHDSR?2),
and leave the depth at +100%.

. Set Sustain to zero for the AHDSR2 envelope. Note the "yeah” articulation this creates

as you play each note.

Increase the Attack time for the AHDSR2 envelope. Note the "aya” type articulation this
creates as you play each note.
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10. Adjust the Shift knob, the Size knob, and the Center knob, to explore the different
timbres available.

11. Switch the order of vowels in the four pop-up menus, and also load different filter types
such as Comb.

Alchemy granular element controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the Granular button is active in a source
subpage. The Granular section is available only when you import an audio sample using
either granular or sampler mode. See Import browser.

Note: The sampler and granular engines are mutually exclusive: you can use one or the
other within a single source, but not both together. You can, however, enable further
sources if both engines are required simultaneously.

Granular synthesis represents continuous sound as a stream of grains, or tiny pieces of
sound. Alchemy generates grains by extracting 2- to 230-millisecond pieces from an audio
file. The amplitude of each grain is shaped, along with any pitch and pan modifications,
before the grain is sent to the output stream.

Grains can be reordered, time stretched, and pitch shifted. This provides an inexhaustible
supply of potential raw material to use as the basis of your sounds.
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Granular element parameters

In addition to the following controls, granular playback is affected by loop modes and by
the settings and modulations of the Position and Speed knobs in each source subpage.

See Source subpage controls. Modulations of the granular element update with each new
grain. For an example of the impact this has, modulating the source Coarse Tune parameter
with an LFO causes the stream of grains to rise and fall in pitch, but does not create pitch
sweeps within each grain. If a large Size value is used in conjunction with a low Density
value, modulations of source parameters such as pitch may sound stepped, rather

than smooth.

- Waveform window: Shows real-time changes to the waveform.
- On/off button: Turn on to use the granular element in the source.

- Volume knob: Set the volume of the granular element, independent of other
source elements.

- Size knob: Adjust the duration of each grain from 2 msec to 230 msec.
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Density knob: Determine the number of potentially overlapping grains from 1 (no
overlap) to 10.

The Size and Density parameters interact with each other. When the Density value is 1,
a single grain is sent to the output stream. As soon as one grain finishes, the next one
is sent. A Size value of 100 msec sends a new grain every 100 msec.

Increasing Density to 2 adds a second grain that is sent in between those of the first,
resulting in a new grain every 50 msec, assuming a Size value of 100 msec. The first
and second grains overlap each other. Higher Density values inject additional new
grains into the output stream. These new grains occur more frequently and overlap
more heavily.

Setting Size to around 100 msec and Density to around 5 grains is often suitable for
smooth pad sounds with no sharp transients. Setting Size between 40 and 80 msec
and Density to around 2 grains is useful for drums and other sounds featuring sharp
transients. Small Size values tend to produce a buzz that masks the original pitch of
the sample. Large Size values tend to break up the sound. You can counteract both
tendencies by increasing the Density.

Note: Also important to the Size and Density parameters is the shape chosen in the
Grain Shape pop-up menu. This can have a significant or subtle impact on sonic
artifacts that may be introduced in the stream of grains.

RTime knob: Add a small random offset to grain extraction positions in the sample.
The default value is 3% because a small amount of randomization helps to smooth the
output of the granular element.

RPan knob: Add a random offset to the stereo position of each grain. The source Stereo
button must be on for RPan to have an effect.

Num Taps knob: Set the number of taps (up to 8). Taps retrigger the attack phase of
the source.

Note: Taps that fall within a looped area are retriggered on each loop cycle.

Tap Spacing knob: Set the spacing between the specified number of taps. Values are
shown as a percentage of the overall sound duration. Set to 100% to evenly space taps
across the entire sound duration. Set to 50% to trigger more closely spaced taps that
start at the halfway point of the sound. Set to zero to trigger taps in quick succession
at the sound end point.

Stereo Offset knob: Offset the stereo position to create a wider sound. The source
Stereo button must be on for Stereo Offset to have an effect.

Grain Shape pop-up menu and field: Choose the envelope shape that is applied to each
grain. At a basic level, this applies a small fade-in and fade-out to each grain, but some
shapes may have a more significant impact, depending on the current Size and Density
values (and the source material). You can also step through the available grain shapes
with the Previous and Next buttons (the arrows).

This function is primarily intended to reduce or remove glitches, clicks, and crackles in
the playback of a stream of grains, but it can introduce buzzy gaps between grains and
can affect the tonality of grains. The effect of the chosen grain shape can also be quite
subtle in many cases, particularly when you avoid extreme Size and/or Density values.
There are no fixed rules when it comes to the choice of grain shape, given the infinite
variety of source audio material. Therefore, you may want to experiment to achieve

the required results.

64



Logic Pro Instruments for Mac

Alchemy sampler element controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the Sampler button is active in a source
subpage. The sampler section is available only when you import an audio sample using
either granular or sampler mode. See Import browser.

The sampler section allows audio files, known as samples, to be played directly. Samples
played at a higher pitch than the original play back at a faster speed. Samples played

at a lower pitch than the original play back at a slower speed. The sample waveform is
displayed in the center. A progress bar indicates the current playback position for the
most recently triggered note.

Note: The sampler and granular engines are mutually exclusive: you can use one or the
other within a single source, but not both together. You can, however, enable further
sources if both engines are required simultaneously.

ADDITIVE GRANULAR

Reverse

Sampler element parameters
- Waveform window: Shows real-time changes to the waveform.
- On/off button: Enable or disable the sampler element in the source.

- Volume knob: Set the output level of the sampler element within the source. When
multiple elements are used in a source, use this control to set the relative level of the
sampled component.

+ Reverse button: Turn on to play samples backwards. If the loop mode in the main source
section is set to Forward/Back, enabling this parameter also reverses the loop playback
order. See Source subpage controls.
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Alchemy VA element controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the VA (Virtual Analog) button is active in a
source subpage.
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Virtual Analog parameters
- Waveform window: Shows real-time changes to the waveform.

- Oscillator on/off button: Enable or disable the main oscillator. When you click the Name
bar File button, and choose Initialize Preset from the pop-up menu to initialize Alchemy
to default settings, the VA element is automatically enabled.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

- Wave pop-up menu and field: Choose an oscillator waveform. Basic saw, sine, square,
and triangle and many specialized waveforms are provided. You can also step through
the available waveforms with the Previous and Next buttons (the arrows).

- (Oscillator) Vol knob: Set the output level of the oscillator. When multiple elements are
used in a source, use this control to set the relative level of the oscillator component.

- Sym knob: Alter the symmetry, or shape, of the oscillator waveform. When a square
wave is active, Symmetry acts as a pulsewidth control. The effective range is between
5% and 95% because extreme values may cause sonic artifacts.

- Phase knob: Set the oscillator start point (phase). Values from 0% to 99.9% set a fixed
start point for the oscillator. A value of 100% causes random variations of the waveform
start point each time the oscillator is triggered.

- Sync knob: Enable oscillator sync and set the pitch that the main oscillator is
synchronized with.

-« Num(ber) knob: Set the number of unison voices.

- Detune knob: Set the amount of detuning and stereo width variance between unison
voices or detuning between oscillators when wide unison mode is turned on. See
Alchemy wide unison mode.

- Noise on/off button: Enable or disable the noise oscillator.

- Noise pop-up menu and field: Choose a noise waveform. These have different spectral
characteristics that can be further refined with filters. You can step through the
available waveforms with the Previous and Next buttons (the arrows).
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- (Noise) Vol knob: Set the output level of the noise oscillator. When multiple elements
are used in a source, use this control to set the relative level of the noise component.

« Tune knob: Set the tuning of the noise signal.

+  Low Cut knob: Set a low cutoff frequency for the noise oscillator. All frequencies above
this value are allowed to pass. All frequencies below are attenuated.

« High Cut knob: Set a high cutoff frequency for the noise oscillator. All frequencies
below this value are allowed to pass. All frequencies above are attenuated.

The Low Cut and High Cut parameters work in conjunction with each other to act as a
bandpass filter, where the noise signal that falls within the two cutoff ranges is allowed
to pass.

Alchemy wide unison mode in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the A/B/C/D button to select the source you want to edit.

The parameters in this section are shown when the VA (Virtual Analog) button is active in a
source subpage.

Alchemy wide unison mode provides oscillator pan and detune options that enhance the
perceived width of VA sources.

To turn on wide unison mode, choose the Wide Unison entry at the bottom of the Wave
pop-up menu.

Important: When you choose File > Initialize Preset, wide unison mode is automatically
turned on.

All existing presets and patches load in the older non-wide mode. Newly initialized settings
and updated factory content will have the wide mode turned on.

ADDITIVE GRANULAR SAMPLER
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Wide Unison mode parameters

In wide unison mode, the source Pan and Detune knob behavior functions as outlined in
this section.

«  Pan knob: Set the oscillator output position in the stereo field. The behavior of the
parameter changes as additional oscillators are added to the source. All odd-numbered
oscillators (except the center panned oscillator) are hard panned as you increase the
number of oscillators.

- 1 oscillator: center panned
- 2 oscillators: hard panned left/right

- 3 oscillators: one oscillator is centered and the other two oscillators are panned hard
left/right

- 4 oscillators: when playing a C with full detune (2 semitones up/down), the Bb
and Db are both hard right panned, and the remaining two oscillators are hard left
panned

- Detune knob: Set the amount of detuning between wide mode oscillator voices.
Oscillator pitches (in semitones) are spread in a linear fashion between the top and
bottom values.

Note: Detune knob scaling is not linear. Values closer to the centered position can be
adjusted in smaller increments. Values further from the centered position are coarser.

- 100% Detune value corresponds to 2 semitones up/down on each side

- b50% Detune value plays a semi tone up/down on each side

Alchemy source modulations in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view.

Most Alchemy source parameters, such as Pan, Tune, and Position, can be modulated
by modulation sources such as AHDSRs or LFOs. Parameters that have a modulation
assignment are indicated by an orange arc around the control. See Alchemy
modulation overview.

Note: Parameters that are morphed and have a modulation assignment show both an
orange and green arc around the control.

This section focuses on Position, which is a modulation target. The principles discussed
apply equally to other source parameter targets.

Position determines the playback position of audio data. When modulated, the playback
path through the audio data is controlled by the selected modulation source. In sampler
mode, the note-on modulation value determines the initial offset for the play position within
the audio data. Beginning at that position, the rest of the sound plays in a normal manner,
although looped as if the Loop mode is set to All. In additive, spectral, or granular mode,
Position can be continuously modulated forward or backward at any rate (including zero).
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Create tempo-synced loops by modulating position

Synchronized playback of looped audio with the Logic Pro tempo is easy to achieve by
modulating the Position parameter. This technique is possible with any synthesis method
that permits continuous modulation of Position. This example uses the granular engine,
but the same technique can be applied to the additive and spectral engines.

You can set Position and Speed to 0% and can modulate Position with a unipolar LFO,
MSEG, or a performance control linked to the modulation wheel. When Position is
modulated and Speed has a value greater than zero, the playback path is determined
by a combination of modulation value (whenever this value changes) and the normal
path (at a rate determined by Speed whenever the modulation value is static).

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

In source A, import a rhythmic or melodic sample that loops evenly.

Turn the source A Speed knob down to its minimum value of 0%, and play a few notes.
You will hear that playback is frozen at the very beginning of the sample.

Do one of the following:

« Click the Position knob to select it as a modulation target, then click the first
modulation rack slot, and choose LFO > LFO 1 from the pop-up menu.

«  Control-click the Position knob, then choose Add Modulation > LFO > LFO 1 from
the shortcut menu.

Note the orange arc that appears around the Position knob. This indicates that the
parameter has a modulation assignment.

Click the LFO button in the modulation section if the LFO controls are not visible, then
choose Basic > Ramp Up from the LFO Shape selection pop-up menu. Also in the LFO,
turn off the Bipolar button.

This routing increases Position smoothly so that the entire sample plays back from
beginning to end, then jumps immediately back to the beginning and continues to loop.

Adjust the LFO Rate if loop playback is too fast.

Finally, adjust the Logic Pro tempo as you play additional notes to confirm that the loop
is properly synchronized.

Note: It is unnecessary to freeze playback by setting Speed to 0% (as performed in
step 3) before modulating Position with the Ramp Up LFO shape. This is because this
LFO shape is constantly changing, without any static/flat portions and thus is always
controlling play position, making the Speed value irrelevant. If you use a different

LFO shape with static/flat portions, however, setting Speed to a non-zero value would
cause play position to be controlled by a combination of the LFO shape and the normal
playback behavior of the sample.
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Alchemy morph controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the Morph button to view and use the morph controls.

The morph controls determine how the four Alchemy sources interact. There are two basic
types of interaction:

- XFade: In a crossfade, all active sources play simultaneously, and the X and Y knobs
control the mix between them. This is equivalent to turning the Amp knobs in each
source to attain the desired mix. If you crossfade from a source with a high Coarse Tune
setting to a source with a low Coarse Tune setting, the high source fades out as the low
source fades in. In the middle of the crossfade you hear both sources.

- Morph: In a morph, a single sound is generated with parameter values determined by
interpolating between the settings of all four sources. If you morph from a source with a
high Coarse Tune setting to a source with a low Coarse Tune setting, you hear a single
sound during the morph. The sound tuning falls smoothly from the high value to the
low one.

Morphing provides more scope than simple crossfades between sources. It also allows
cross-synthesis, where you can combine different aspects of different sound elements. For
example, you could apply the formants or other characteristics of an additive source to the
spectral element of another source. See the tutorials found in Elemental morphs overview.

Only certain parameters, notably all parameters controlled with a knob, can be morphed.
Morphed parameters are indicated by a green arc around the control. Parameters that are
morphed and have a modulation assignment show both an orange and green arc around
the control. Parameter settings are shared across all morphed sources, which means that
changing a parameter in one source results in the corresponding parameter being changed
for all morphed sources.

Note: Parameters that do not directly participate in the morph, including most buttons and
pop-up menus, are indicated with a lock icon displayed at the top left of the control (the
lock icons are shown only in source subpages). Where there is a parameter pairing of an
On button and a pop-up menu, only the button shows the lock icon. Neither parameter
participates in the morph.

XFade XY XFade Lin Morph XY Marph Lin

Al Elements

A-B

Granular Pitch Formant Envelope

Fixed Pitch

Logic Pro Instruments for Mac 70



Logic Pro Instruments for Mac

Morph controls

+ Morph type buttons: Choose one of four crossfade or morph modes.

- XFade XY: This mode crossfades levels between all four sources.

Use the X knob to control the mix levels of sources A and C versus sources
B and D.

Use the Y knob to control the mix levels of sources A and B versus sources
C and D.

«  XFade Linear: This mode is useful for setting up crossfades based on Velocity or
KeyFollow.

Crossfade from source A to B to C to D as you increase the X knob value from 0%
to 100%.

The Y knob is not shown in this mode.

Morph XY: This mode is like XFade XY, but all parameters of the sound are morphed.
Regions of each source encompassed by corresponding warp markers are time-
aligned in the morph. See Zone waveform editor.

All/Elements buttons: Use All to view and edit the X/Y values for all active
parameters. Use Elements to view and edit the X/Y values of five parameters.

X/Y knobs: Edit the X/Y values for all active parameters. Y values are not shown in
“linear” modes.

Additive knob X/Y: Set the morph value for active additive sources. Also controls
VA morph position if the VA element is active.

Spec/Gran knob X/Y: Set the morph value for active spectral or granular sources.
Also controls sampler morph position if the sampler element is active.

Pitch knob X/Y: Set the pitch morph value between active sources.

Formant knob X/Y: Set the formant level morph value between active sources.
Also controls morphing of the source filter knobs.

Envelope knob X/Y: Set the envelope morph value between active sources.
These controls morph the timing of the sound. In cases where source A has
a short attack and source B has a long attack, for example, the length of the
attack varies as you change the X knob.

Auto Gain button: Enable to match source levels, resulting in smoother morphs.

Fixed Pitch button: Turn on to lock the root note to a pitch that doesn’t change,
regardless of morph position movements. Turn off for the best morphing quality.

Auto Align button: Enable to automatically align all morphed sources. As an
example, Auto Align corrects the timing of words of four spoken voice samples
saying the same phrase in each of the four morphed sources. Auto Align is
automatically turned off when you set warp markers manually.
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« Morph Linear: This mode is like XFade Linear, but all parameters of the sound are
morphed. Regions of each source encompassed by corresponding warp markers are
time-aligned in the morph. See Elemental morphs overview.

All/Elements buttons: Use All to view and edit the X value for all active
parameters. Use Elements to view and edit the X values of five parameters.

Source group buttons: Choose source group A-B, C-D, or A-B-C-D. Morphs affect
only the chosen group of sources.

Additive knob: Set the morph value for active additive sources.

Spec/Gran knob: Set the morph value for active spectral or granular sources. This
also controls the sampler morphing position if the sampler element is active.

- Pitch knob: Set the pitch morph value between active sources.

- Formant knob: Set the formant level morph value between active sources.

- Envelope knob: Set the envelope morph value between active sources.

« Auto Gain button: Enable to match source levels, resulting in smoother morphs.

« Fixed Pitch button: Locks the root note to a pitch that does not change,
regardless of morph position movements. Turn off for higher morphing quality.

« Auto Align button: Enable to automatically align all morphed sources. Auto Align
is automatically turned off when you set warp markers manually. For example,
Auto Align corrects the timing of words of four spoken voice samples saying the
same phrase in each of the four morphed sources.

- Morph square: Display and edit the current X/Y morph position. Drag the point to
change the X or Y value, or both.

Morph XY mode: When the Elements button is on, five points represent the following
parameters: Additive (blue), Spec/Gran (orange), Pitch (green), Formant (purple),
and Envelope (yellow). Drag each point to change the corresponding X and Y values.

« Morph Linear mode: When the Elements button is on, five points represent the
following parameters: Additive (blue), Spec/Gran (orange), Pitch (green), Formant
(purple), and Envelope (yellow). Drag each point to change the corresponding X
parameter value for the active source group: A-B, C-D, or A-B-C-D.

Alchemy source editors

Alchemy source edit window in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters
for the selected source.

- Edit button: Open the source edit window. Edit buttons are shown on all source
subpages.

- Close window button: Close the source edit window. Shown at the top right of all
edit windows.
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By default, the Main edit window is shown. Further Additive and Spectral edit windows
can be opened by clicking the buttons at the top of the window. These windows provide
additional parameters that let you precisely edit and sculpt your sounds. See Additive edit
window overview and Spectral edit window.

Inspector, global, group,

Iand zone controls
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- Keymap editor
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[Zone waveform editor

The Main edit window is divided into three areas that interact with each other. You can edit
parameters graphically in the keymap or waveform editor or can use corresponding fields
and other parameters in the inspector.

- Inspector: This area shows global parameters, group functions, and zone parameters.
See Inspector global controls, Inspector group controls, and Inspector zone controls.

- Keymap editor: A graphical representation of, and editor for, sample zones. This area
interacts with the zone parameters in the inspector. See Keymap editor.

- Zone waveform editor: A graphical representation of, and editor for, the waveform used
in each sample zone. See Zone waveform editor.

Alchemy inspector global controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters for the
selected source.

The source edit window is opened by clicking the Edit button on any source subpage. Click
the close window icon (X) to close the source edit window.

The source inspector is divided into three main parameter groupings: global and source
parameters, group parameters, and zone parameters. See Inspector group controls and
Inspector zone controls.
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Inspector global parameters
- A/B/C/D buttons: Select the corresponding source.

- Main/Additive/Spectral buttons: Open the Main, Additive, or Spectral edit window.
Click the X icon at the top right of the active window to close it.

- On/Off button: Enable or disable the source selected with the A/B/C/D buttons.

- Source select pop-up menu and field: Displays the name of the current source audio
data. Click to open a pop-up menu with source content handling commands. You
can also click the Previous and Next buttons (the arrows) to step through available
waveform data. See Source master controls and Import browser.

- Solo button: Solo the source selected with the A/B/C/D buttons. All other sources
are muted.

Alchemy inspector group controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters for
the selected source.

The source edit window is opened by clicking the Edit button on any source subpage. Click
the close window icon (X) at the top right to close the window.

The source inspector is divided into three main parameter groupings: global and source
parameters, group parameters, and zone parameters. See Inspector global controls and
Inspector zone controls.
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Round Robin v 2

Logic Pro Instruments for Mac 74



Logic Pro Instruments for Mac

Inspector group parameters

Group (+) pop-up menu: Open a pop-up menu with two group creation commands.

Empty: Create a new empty group. The new group name is added below existing
group names in the Group list shown under the Group pop-up menu. A sequentially
assigned number is appended to the new group name.

Import: Open an import window where you can choose one or multiple samples to
import as a group. See Import browser.

Group list: Double-click a group name to open a text name field and change the Trigger,
Fade, and Poly values. Control-click a group name to choose the Delete command.

Trigger pop-up menu and field: Set a trigger mode for all zones in the group. Attack
triggers group zones when note-on messages are received. Release triggers group
zones for note-off messages. This mode is useful for instruments with a distinctive
end-of-note sound such as a key click or hammer thump. Such sounds can be
included as a separate group with release triggering enabled. You can also use

this feature creatively to add abstract reverb tails or to create a pad sound that
changes dramatically during the release stage.

Fade pop-up menu and field: Apply a fade out time value ranging from 0 to 100 for
note-off events when the attack trigger mode is active. Apply a fade in time value
ranging from 0 to 100 for note-off events when the release trigger mode is active.
This parameter is primarily intended for use in conjunction with release triggering,
to create a crossfade between the main body of the note and the release sample.

Poly pop-up menu and field: Set a maximum polyphony value for the group. A
common use of this feature is to create a group containing an open and a closed
hi-hat sample. If you set group polyphony to one, either the closed or open hi-hat
sample can play, but not both at the same time.

Starts pop-up menu and field: Define when each group will trigger. You can create and
combine multiple rules using boolean logic. The normal state for any newly created
group is a single rule set to Always, unless that group was defined as a Round Robin
group in the Import browser Dropzone. Click the field to choose a rule. This adds a
new rule pop-up menu below the first and displays a Logic pop-up menu to the right.
Choose Delete from the pop-up menu to remove a rule.

Always: Zones in the group always trigger when a note-on event arrives within the
specified zone key and velocity ranges.

Round Robin: Choose to automatically switch between layers for each note-on, so
that striking a given note multiple times triggers variations of the sample rather than
the same sample being played repeatedly.

«  Order pop-up menus and fields: Set the playback order of round robin groups. At
least two round robin groups must exist for this parameter to have an effect. Each
group is assigned a different value. If two groups are assigned to the same value,
both zones are triggered simultaneously. Each note-on sequentially triggers
a round robin group from lowest to highest. Once the highest group number
is triggered, the sequence starts again from the lowest group number. Drag
vertically in the field or use the arrows to set a value.
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Random Round Robin: Choose to automatically switch between layers for each
note-on, so that striking a given note multiple times triggers random variations of
the sample rather than the same sample being played repeatedly. No Order pop-up
menu is shown.

Keyswitch: Choose to switch a group on or off in accordance with either the
Transform pad position or the KeySw parameter conditions. You can also assign
keyswitching to a MIDI note or range of notes which prevents the group from
triggering until one of these notes is played. Two pop-up menus are displayed,
where you can choose keyswitch conditions.

« Snap1-Snap8 pop-up menu and field: These values represent Transform pad
positions. For example, set the first field to Snap2 and the second field to Snap4,
which results in the group being triggered only when the Transform pad is at
position 2, 3, or 4. Assign multiple groups to different ranges to switch between
up to eight different groups. See Transform pad.

«  Keyswi1-Keysw10 pop-up menu and field: These values represent the position
of the Keyswitch knob shown in the global controls for the source. This knob is
visible only when the Keysw1-10 options are chosen in these menus. For example,
set the first field to Keysw1 and the second to Keysw5, which results in the group
being triggered when the Keyswitch knob is set to a value that falls within this
range. Up to 10 Keyswitch knob positions are available, enabling you to switch
between groups with the knob. Because the Keyswitch knob is available as a
modulation target, this lets you create complex automated group switches.

. C2-G8 pop-up menu and field: Set a specific note or range of notes as
keyswitches. Play a note in this range to switch to a group, which remains
active until another group is chosen.

Controller: Switch groups on or off in accordance with specified performance
controls in the Perform section, or in accordance with assigned MIDI controller
values. Three pop-up menus are displayed where you can choose the controller
type and set controller values.

«  Type pop-up menu and field: Choose Control 1 to Control 8 to control switching
from any of the eight performance control knobs. Choose the XYPad options to
control switching from the X or Y axes of either of the performance control X/Y
pads. Choose the EnvAttack, EnvDecay, EnvSustain, or EnvRelease option to
assign switching to the performance control envelope knobs. See Performance
controls overview. You can also choose from any of the 128 MIDI controllers
CC#0 to CC#127.

«  Value pop-up menus and fields: Define the range of values that trigger the group.
For example, set the type to Control 1, with field values of 30 and 50, which
results in the group being triggered only when performance control 1is set within
the 30% to 50% range. You can set other groups with the same type but with a
different control range to switch between groups with a single controller. Because
the Control 1 knob used in the example is available as a modulation target, this
lets you create complex automated group switches. Drag vertically in the fields
or use the arrows to set a value.
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- Delete: Remove the selected group rule.

« Logic pop-up menus and fields: Define a condition for multiple group rules, using
And, Or, and Not boolean statements. For example, set the first group rule to
Controller and Control 1 with a range of 50% to 100%. Set a second group rule to
Controller and Control 2 with a range of 50% to 100%. The different logic conditions
result in different outcomes.

And: Both Control 1 and Control 2 must be set above 50% for the group to trigger.
With either control set below 50% the group does not trigger.

« Or: Either Control 1 or Control 2 must be set above 50% for the group to trigger.
The group does not trigger only when both controls are below 50%.

- Not: The group triggers when Control 1 is set above 50%, and Control 2 is
set below 50%. If both controls are set above or below 50%, the group does
not trigger.

Crossfade to a different group of samples on note-off

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Switch to advanced view, and set the Release time for AHDSR1 to a suitable length for
your release samples.

Switch to one of the sources with the A/B/C/D buttons, then click the Edit button to
open the Main edit window.

Click the select field, and choose Import Audio.

Select a sample (or multiple samples) representing the main sustain portion of your
sound, and import using any of the available import modes.

Alchemy analyzes each sample to determine the root pitch (if not defined in the
filename), set the root key, key range, and velocity range for each sample zone such
that they span the entire keyboard and the entire dynamic range, and add all zones to
a group named Group 1.

Click the "+" symbol at the top of the Group section, and choose Import.

Select a sample (or multiple samples) representing the release portion of your sound,
and import (the import mode is automatically set to match the existing group).

Alchemy again analyzes each sample and adds all zones to a group named Group 2.
Double-click Group 2, then click the Trig field and change it to Release.

Zones in Group 2 will now trigger when you release each key, playing over zones in
Group 1 which continue to sound until AHDSR1 reaches the end of the release stage.

Double-click Group 1in the list, then click the Fade field and change it to a value other
than O.

Zones in Group 1 will now fade out when the note is released, allowing Group 2 to be
heard during the release stage of the sound. Higher Fade values result in slower fades.
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10. As an option, double-click Group 2 in the list, then click the Fade field and change it to
a value other than 0.

Zones in Group 2 will now fade in when the note is released, creating a crossfade
between Groups 1 and 2 at note-off. Higher values result in slower fades. Fading in the
release group may be unnecessary if your release samples already have a natural fade
in at the start, however, or undesirable if a percussive transient is required at note-off.
Try to set Fade values for Group 1 and 2 to an identical small value to create a sudden
but click-free crossfade at the end of each note.

Create random round robin variations

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Switch to advanced view, and set the Release time for AHDSR1 to a suitable length for
your release samples.

3. Switch to one of the sources with the A/B/C/D buttons, then click the Edit button to
open the Main edit window.

4. Click the select field, and choose Import Audio.

5. Select a sample (or multiple samples) representing the main sustain portion of your
sound, and import using any of the available import modes.

Alchemy analyzes each sample to determine the root pitch (if not defined in the
filename), set the root key, key range, and velocity range for each sample zone such
that they span the entire keyboard and the entire dynamic range, and add all zones to a
group named Group 1.

6. Click the Rule field, and change it from Always to Random Round Robin.
7. Click the "+" symbol at the top of the Group section, and choose Import.

8. Select a sample (or multiple samples) representing the second of your round robin
variations, and import (the import mode is automatically set to match the existing
group).

Alchemy will again analyze each sample and add all zones to a group named Group 2.
9. Click the Rule field below Group 2, and change it from Always to Random Round Robin.

Any notes you play will now randomly trigger either group 1 or group 2, but not both
together. Note that if you play a chord, each individual note is randomly assigned to one
of those groups.

10. Repeat steps 7 to 9 as needed to configure a group for each further variation you
require.
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Assign the source Keysw knob to switch between groups

1.

10.

1.
12.

13.

14.
16.

16.

Logic Pro Instruments for Mac

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Switch to advanced view, and set the Release time for AHDSR1 to a suitable length for

your release samples.

Switch to one of the sources with the A/B/C/D buttons, then click the Edit button to
open the Main edit window.

Click the select field, and choose Import Audio.

Select a sample (or multiple samples) representing the main sustain portion of your
sound, and import using any of the available import modes.

Alchemy analyzes each sample to determine the root pitch (if not defined in the
filename), set the root key, key range, and velocity range for each sample zone such
that they span the entire keyboard and the entire dynamic range, and add all zones
to a group named Group 1.

Click the Rule field, and change it from Always to Keyswitch.

Click the first range field, and change it to Keysw1. The second range field also changes
to the same value.

As an option, you can click the second range field and increase the value to specify a
range of values that will trigger this group, instead of just a single value.

Click the “+" symbol at the top of the Group section, and choose Import.

Select a sample (or multiple samples) representing the second of your variations, and
import (the import mode is automatically set to match the existing group).

Alchemy will again analyze each sample and add all zones to a group named Group 2.
Click the Rule field below Group 2, and change it from Always to Keyswitch.

Click the first range field, and change it to the first unused Keysw value. If the second
range field for Group 1 is set to Keysw3, choose Keysw4.

As an option, you can click the second range field and increase the value to specify a
range of values that will trigger Group 2, instead of just a single value.

Repeat steps 9 to 12 for each new group of variations you require.
Click the X symbol at the top right to close the source edit window.
A new Keysw knob is visible in the source pane, to the left of the Keyscale field.

Rotate the Keysw knob to switch between the groups you created. Control-click this
knob to add modulation routings from the shortcut menu.
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Create round robin variations for just one Transform pad position

1.

10.
11.

12.

13.
14.

15.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Switch to advanced view, and set the Release time for AHDSR1 to a suitable length for

your release samples.

Switch to one of the sources with the A/B/C/D buttons, then click the Edit button to
open the Main edit window.

Click the select field, and choose Import Audio.

Select a sample (or multiple samples) representing the main sustain portion of your
sound, and import using any of the available import modes.

Alchemy analyzes each sample to determine the root pitch (if not defined in the
filename), set the root key, key range, and velocity range for each sample zone such
that they span the entire keyboard and the entire dynamic range, and add all zones to
a group named Group 1.

Click the Rule field, and change it from Always to Round Robin.

It is automatically assigned the number 1 in the sequence, and a second rule (set to
Always) is added below.

Click the Logic field for rule 1, and change it to Or.
Switch rule 2 from Always to Keyswitch.

Leave the first range field for rule 2 set to Snap1, and change the second range field
to Snap7.

Click the “+" symbol at the top of the Group section, and choose Import.

Select a sample (or multiple samples) representing the second of your round
robin variations, and import (the import mode is automatically set to match the
existing group).

Alchemy again analyzes each sample and adds all zones to a group named Group 2.
Click the Rule field below Group 2, and change it from Always to Round Robin.

It is automatically assigned the number 2 in the sequence, and a second rule (set to
Always) is added below.

Switch rule 2 from Always to Keyswitch.

Set the first Range field for rule 2 to Snap8. The second field is automatically set to the
same value.

Played notes only trigger zones in Group 1 unless the Transform pad is at position 8,
in which case Groups 1 and 2 play alternately, in a round robin fashion.

Repeat steps 10 to 14 as needed to configure a group for each further variation
you require.
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Alchemy inspector zone controls in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters
for the selected source.

The source edit window is opened by clicking the Edit button on any source subpage.
Click the close window icon (X) at the top right to close the window.

The source inspector is divided into three main parameter groupings: global and source
parameters, group parameters, and zone parameters. See Inspector global controls and
Inspector group controls.
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Inspector zone parameters

- Add Zone (+) button: Open the Import browser where you can select one or multiple
samples to import into zones. Newly imported samples are added to the current
configuration. Each new sample results in a new zone. See Import browser.

- Select MIDI button: Turn on to automatically select zones by playing your
MIDI keyboard.

- Zone name field: Displays the name of the current audio file in the selected zone.
Click to open a pop-up menu where you can select other source zones.

Note: The keymap editor lets you select multiple zones simultaneously. In this case
the zone name field shows Multiple to indicate a multi-zone selection. Any parameter
changes are applied to all selected zones. See Keymap editor.

- Key field: Set the root key for the selected zone with the up and down arrows. The
chosen note triggers playback of the sound at its original pitch. A pitched sample
should ideally be mapped to a matching root key. If the root note is defined as part of
the filename, the Key parameter is set accordingly when the file is imported. If the root
note is not in the filename, samples are analyzed on import to calculate their original
pitch and a suitable root key setting. Drag vertically in the field or use the arrows to
set a value.

- Learn button: Turn on to set the root key for a sample: the next MIDI note received
defines the new root key. The button is automatically turned off once the root key
has been learned.
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Loop mode field: Open a pop-up menu with five looping options.

« None: Ignores the loop start and end points, and plays the entire sound once
without looping.

- Continuous: Plays from the beginning, enters the loop region, and loops continuously
in a forward direction while a note is held and during the envelope release phase.

Sustain: Plays from the beginning, enters the loop region, loops continuously while a
note is held, and exits the loop region to play the normal sound release phase.

Forward/Back: Like Continuous, but plays the loop region alternately forward
and backward.

All: Ignores the loop start and end points, and loops the entire sound continuously.

Note: The loop start and loop end points can be edited in the source main edit
page. See Zone waveform editor. In VA mode, a raw oscillator noise source is
used rather than loopable data, so VA synthesis elements are not affected by
the Loop mode setting.

Volume knob: Set the selected zone output level. This parameter is also useful for
level-matching multiple selected zones.

Tune knob: Tune the zone in semitone increments.

Pan knob: Determine the left/right pan position for each zone or the left/right balance
for a stereo zone.

Lo Key field: Drag vertically or use the arrows to set the lowest MIDI note that triggers
the zone. Alternatively, drag the left edge of the highlighted zone in the keymap editor.
See Keymap editor.

Hi Key field: Drag vertically or use the arrows to set the highest MIDI note that triggers
the zone. Alternatively, drag the right edge of the highlighted zone in the keymap editor.

Lo Vel field: Drag vertically or use the arrows to set the lowest MIDI note velocity that
triggers the zone. Alternatively, drag the lower edge of the highlighted zone in the
keymap editor.

Hi Vel field: Drag vertically or use the arrows to set the highest MIDI note velocity that
triggers the zone. Alternatively, drag the upper edge of the highlighted zone in the
keymap editor.

Zone Fade pop-up menu and field: Determine the method used to fade overlapping
zones at the boundaries of key and velocity ranges. No more than two zones can be
triggered simultaneously within one group, which means that crossfades can be set
for zones with adjacent key ranges or for zones with adjacent velocity ranges, but
not for both at the same time.

Linear: Create a linear ramp from full amplitude to zero. This typically results in a
crossfade that sounds quieter at the halfway point. Linear mode can be useful when
crossfading two highly similar sounds that may reinforce one another at the halfway
point of an equal-power crossfade.

- Power: Create an equal-power curved fade that is suitable for most sounds. When
crossfading two sounds with a similar loudness, Power mode results in a smooth
fade with the same apparent loudness at the halfway point.

Left field: Drag vertically or use the arrows to set the range of the fade for the left edge
of the zone, relative to the Lo Key parameter. If Lo Key is set to C2 and Left is set to 12,
the zone fades in gradually for notes with pitches between C2 and C3.
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Right field: Drag vertically or use the arrows to set the range of the fade for the right
edge of the zone, relative to the Hi Key parameter. If Hi Key is set to C4 and Right is
set to 5, the zone fades out gradually for notes with pitches between G#4 and C5.

Bottom field: Drag vertically or use the arrows to set the range of the fade for the lower
edge of the zone, relative to the Lo Vel parameter. If Lo Vel is set to 20 and Bottom

is set to 15, the zone fades in gradually for notes with velocities between 20 and 35.
Velocity values below 20 do not trigger the zone.

Top field: Drag vertically or use the arrows to set the range of the fade for the upper
edge of the zone, relative to the Hi Vel parameter. If Hi Vel is set to 90 and Top is set
to 30, the zone fades out gradually for notes with velocities between 60 and 90.
Velocity values above 90 do not trigger the zone.

Note: Zone fades and overlapping zones are not compatible with morphing sources.
When morphing is enabled, only one zone is triggered at a time from each morphing
source (the first zone in the list), and zone fades are disabled.

Alchemy keymap editor in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters for the
selected source.

The source edit window is opened by clicking the Edit button on any source subpage. Click
the close window icon (X) at the top right to close the window.

The keymap editor displays all sample zones in the currently selected group, with each
zone represented as a rectangle. The size and location of the rectangle indicates the key
and velocity range for the associated zone. The selected zone in the inspector is indicated
by a white outline in the keymap editor. See Inspector zone controls.
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The left and right boundaries of the rectangle indicate the Lo Key and Hi Key
parameters relative to the keyboard display below. Drag either boundary to set
the Lo Key and Hi Key values.

The bottom and top edges of the rectangle indicate the Lo Vel and Hi Vel parameters.
Drag either the top or bottom edge to set the Lo Vel and Hi Vel values.

Drag the middle of the scroll bar to view zones that are not visible in the display area.
Horizontally drag the zoom controls at either end of the scroll bar to resize the contents
of the visible display area.
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Keymap editor menu commands

Control-click any zone to open a shortcut menu.

- Cut: Remove the selected zone or zones from the current group, and copy to
the Clipboard.

- Copy: Copy the selected zone or zones to the Clipboard.

- Paste to existing group: Paste content from the Clipboard to an existing group chosen
from the submenu.

- Paste to new group: Create a new group, and paste content from the Clipboard into it.

+  Exchange sample: Open the Import browser where you can choose a replacement
sample for the zone. The import mode used by the previous sample is retained, and
the import mode buttons are dimmed. See Import browser.

« Assign to existing group: Move the selected zone or zones from the current group to an
existing group chosen from the submenu.

- Assign to new group: Create a new group, and move the selected zone or zones from
the current group into the new group.

Select and edit the values of one or more zones

1. In Alchemy in Logic Pro, select the zone by doing one of the following:
- Click a rectangle in the keymap editor.
« Choose the zone name from the pop-up menu in the zone section of the inspector.

- Command-click a region containing overlapping zones, then drag horizontally to
cycle through each zone.

2. Hold down Shift, then click multiple zones in the keymap editor to select them.

All selected zones are highlighted with a white border, and Multiple is shown in the
inspector zone name field.

3. Drag the left, right, top, or bottom edge of the zone. When multiple zones are selected,
drag the edge of one selected zone to apply the same relative change to all other
selected zones.

Delete one or more zones

1. In Alchemy in Logic Pro, select the zone by doing one of the following:

- Click a rectangle in the keymap editor.

« Choose the zone name from the pop-up menu in the zone section of the inspector.
2. Hold down Shift, then click multiple zones in the keymap editor to select them.

All selected zones are highlighted with a white border, and Multiple is shown in the
inspector zone name field.

3. Press the Delete key.

The zone or zones are deleted. All associated sample, additive, or spectral data is
removed from the source.
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Audition a zone

Enable the > icon below the keymap editor to hear a preview whenever a zone is clicked.
The sample is previewed, inclusive of loop settings but ignoring zone parameters such as
Tune, Volume, and Panning.

1.

2.

In Alchemy in Logic Pro, select the zone by doing one of the following:

Click a rectangle in the keymap editor.

Choose the zone name from the pop-up menu in the zone section of the inspector.
Click a key on the keyboard display below the zones.

Click near the top of a key to audition low velocities.

Click near the bottom of a key to audition high velocities.

Audio is sent directly to the Alchemy outputs, bypassing any filters or effects that
are enabled in other sections.

Create a multisample with key splits and crossfades for adjacent zones

1.

ok w0 D>

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Click the Advanced button, then click the source A button.
Click the Edit button to open the Main source editor.
Click the source select field, and choose Import Audio from the pop-up menu.

In the Import browser, select two or more samples representing the same instrument

played at different pitches, then click the Import button. Any import mode may be used.

Alchemy analyzes each sample to determine the root pitch (if not defined in the
filename) and sets the root key and key range for each sample zone accordingly.

Select a zone in the keymap editor, and drag its left or right edge so that it overlaps the

adjacent zone. The amount of overlap determines the range of the crossfade.

Select the leftmost of the two overlapping zones, and adjust the Right parameter in the

inspector zone section. If the overlap between the zones extends over four keys, set
this parameter to 4.

Select the rightmost of the two overlapping zones, and set the Left parameter in the
inspector zone section to the same value used in the previous step.

These two zones will now crossfade from one to the other when you play notes in the
overlapping region.

Import further samples, and repeat the previous three steps for each pair of zones you
want to crossfade.
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Add and adjust loop markers for a zone

1. In Alchemy in Logic Pro, select the zone you want to loop by doing one of the following:
« Click a rectangle in the keymap editor.
« Choose the zone name from the pop-up menu in the zone section of the inspector.

2. Click the Loop Mode field in the zone section of the inspector, then choose Continuous,
Sustain, or Forward/Back.

Loop start and end markers appear on the waveform display, with the loop region
highlighted between them.

3. Click and hold the loop start marker handle until the waveform zooms in horizontally,
then drag left or right to find a suitable loop start point.

4. Click and hold the loop end marker handle until the waveform zooms in horizontally,
then drag left or right to find a suitable loop end point.

5. If required, enable loop crossfading with the Loop XFade button, then drag the
crossfade marker left to create a smooth loop.

Alchemy zone waveform editor in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters
for the selected source.

The source edit window is opened by clicking the Edit button on any source subpage.
Click the close window icon (X) at the top right to close the window.

The waveform display of the audio associated with the currently selected zone is shown
at bottom of the Main edit window. Zones can be selected in the keymap editor or zone
parameters in the inspector. See Keymap editor and Inspector zone controls.

Note: If the additive or spectral engines are in use, the waveform display shows the
resynthesized sound amplitude envelope rather than the original sample.

Preview button Loop markers

End marker

Start marker

When morphing is enabled, vertical gray lines with numbered handles are displayed over
the waveform. These are warp markers. For information on use of warp markers, see
Manually time-aligning morphed sounds in Alchemy.

The bright vertical blue lines displayed over the waveform, labeled S and E, indicate
playback start and end points. Drag the S or E handle right or left to trim unwanted
audio playback from the start or the end of the sound.
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Depending on the source material and active morph mode, light blue lines may appear on
the background between the start and end markers. These can help with manual alignment
of warp markers.

If the selected zone is set to one of the looping modes, loop start and loop end markers are
displayed as faint orange lines, each with a small triangular handle shown in the ruler. The
loop region is highlighted between these markers. The marker with the left-facing handle
sets the loop end point. The marker with the right-facing handle sets the loop end point.
Drag the triangular marker handles to adjust the loop start and end points. Click and

hold the handle of a loop marker to zoom the waveform horizontally, allowing for more
accurate placement.

Note: You cannot position the loop start point later than the loop end point. You can,
however, drag both the loop start and loop end markers to the same position, creating
a sustain point rather than a loop region. This option is available only in the additive
or spectral engines, or with a sample loaded into the granular engine, but not in
sampler mode.

Waveform display parameters

- > button: Turn automatic audio previewing on or off when selecting zones in the
keymap editor.

- Loop XFade button: Turn on to enable crossfades between loop start and end markers
when Continuous or Sustain loop mode is chosen in the inspector.

- A crossfade (XF) marker is shown at the loop end point. Drag this marker left to
define a crossfade region, during which a portion of the sound from before the loop
start marker is faded in, while the loop region is faded out.

In sampler mode, discontinuities between the loop start and end points can result in
an audible click each time the loop restarts. Loops in additive, spectral, or granular
modes do not click, but timbral or volume differences between the loop start

and end points can often result in an obvious sounding loop. Unlike conventional
samplers, the additive, spectral, and granular engines are capable of looping a single
instant within the sound, with loop start and end markers at identical positions. This
can work well with some sounds, but with others the loop stage may seem too static
and obviously different from the start of the note.

Tip: Looping clicks in sampler mode can usually be removed with minimal
crossfades, while other timbral or volume discontinuities may need larger crossfades.
Drag the XF marker while playing a note to find a suitable crossfade length.

Note: The Loop XFade button is shown in sampler mode only. This parameter is not
visible if other import modes are used.

- Time line: Shows the overall length of the waveform in seconds. Fractional values (of
the overall waveform length) are displayed in some situations, such as manual alignment
of warp markers.

- Scroll bar and zoom controls: Drag the middle of the scroll bar to view waveform data
that is not visible in the display area. Horizontally drag the zoom controls at either end
of the scroll bar to resize the contents of the visible display area.
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Alchemy additive edit window in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters
for the selected source.

The source edit window is opened by clicking the Edit button on any source subpage.
Click the close window icon (X) at the top right to close the window.

Use the Additive button at the top of the Main edit window to open the Additive
edit window.

The Additive edit window allows detailed editing of additive resynthesis data and also lets
you design sounds from scratch by creating the additive data yourself.

Additive synthesis represents each sound as a sum of individual partials. The additive data
describes each partial in terms of four parameters: amplitude, tune (pitch), pan, and phase,
each of which changes over time.

You can think of the additive data as a series of snapshots, each of which captures the
amplitude, pitch, pan, and phase of every partial at a particular point in time. In between
snapshots, each parameter updates smoothly toward the following snapshot value.
When played in succession and with the right timing, the series of snapshots describes
a potentially complex and continuously evolving sound.

Note: Phase is not an independent parameter. The phase of a partial at any moment in the
evolution of a sound is determined by the phase at the start point of the sound and by
the (possibly changing) pitch of the partial. Because pitch information is captured in each
snapshot, it isn't necessary for phase information to be captured in the same way. The
phase of each partial is specified only at the absolute start point of the sound.

X
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The Additive edit window shows additive data in two graphical displays.

- Partial bar display: Shows a series of vertical columns, or bars. Levels represent the
amp, pitch, pan, or phase values of individual partials or partial groups, depending on
the chosen display mode. See Partial bar display.

- Partial envelope: Shows a number of points that operate in two ways, depending on the
chosen display mode. See Partial envelope controls.
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Alchemy partial bar display in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters
for the selected source.

The source edit window is opened by clicking the Edit button on any source subpage.
Click the close window icon (X) at the top right to close the window.

Use the Additive button at the top of the Main edit window to open the Additive
edit window.

The Partial bar display shows up to 600 partials with independent amplitude, pitch, pan,
and phase values at each Partial envelope point. You can edit individual partials or groups
of related partials for each envelope point.

Note: Higher partials that are part of the additive data set may not be heard unless the
Num Partials (number of partials) control on the respective source A/B/C/D subpage is set
to a suitably high value. For example, raising the amplitude of partial number 72 has no
effect when Num Partials is set to a value of 60. Conversely, setting a Num Partials value
of 500 has no effect in additive mode unless partial data exists for 500 partials.

Partial bar display parameters

« Overall button: Use in conjunction with the Vol, Tune, Pan, and Phase buttons to display
partial values averaged across all envelope points. When the Phase button is active, the
Partial envelope only is updated.

Turn on Overall to adjust the amplitude, pitch, and pan values of all partials across the
entire sound, without the need to select and edit individual envelope points for each
partial. Also see the Overall button information for the Partial envelope controls.

- Partial display mode buttons: Click Vol, Tune, Pan, or Phase to restrict the display to the
chosen partial parameter type.

Vol button: Show partial amplitude values.

Tune button: Show partial pitch values. Also see Snap Pitch button
information below.

«  Pan button: Show partial pan values.

«  Phase button: Show partial phase values.
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Mode pop-up menu and field: Choose a group of related partials for editing. You can
also click the Previous and Next buttons (the arrows) to step through modes. Group
adjustments retain the relative differences between partial values. Hold down Command
while dragging to scale adjustments logarithmically. Note that the Shape pop-up menu
affects editing behavior in each mode.

One: Adjustments affect the value of only the selected partial.
All: Adjustments affect the values of all partials.
Even: Adjustments affect the values of only even-numbered partials.

Fifths: Adjustments affect the values of only partials that are fifths apart from the
selected partial and the selected partial itself.

« Octaves: Adjustments affect the values of only partials that are octaves apart from
the selected partial and the selected partial itself.

- Odd: Adjustments affect the values of only odd-numbered partials.

« Thirds: Adjustments affect the values of only partials that are thirds apart from the
selected partial and the selected partial itself.

Shape pop-up menu and field: Choose a weighted group of related partials for editing.

- Normal: Adjustments affect only the selected partial and grouped partials that
precede it.

Flat: Adjustments evenly affect all grouped partials.
Bright: Adjustments are weighted toward higher grouped partials.
Dark: Adjustments are weighted toward lower grouped partials.

Snap Pitch button: Visible only when the Tune button is active. Automatically limits
partial pitch values to meaningful units when a bar is edited.

Breakpoint button: Open a pop-up menu with a number of Partial envelope point-related
commands. See Partial envelope controls.

Copy Breakpoints: Copy all partial data in the currently selected envelope point or
points to the Clipboard.

- Paste Breakpoints: Paste all partial data from the Clipboard to the currently selected
envelope point or points.

- Paste Breakpoints Amp/Pitch/Pan Data: Paste the currently visible parameter partial
data from the Clipboard to the currently selected envelope point or points.

- Paste All Breakpoints Amp/Pitch/Pan Data: Paste the currently visible parameter
partial data from the Clipboard to every envelope point.

Image button: Open an import dialog where you can choose a PNG format image file for
conversion to additive synthesis data. See the task in this section.

Clear button: Removes all partials and resets the Partial bar display and Partial envelope
to default values.

Partial bar display: Shows editable bars that represent partial values.

Partial number bar: Indicates the selected partial. Click a partial number to select it
without affecting any values.

Scroll bar and zoom controls: Drag the middle of the scroll bar to view partials that are
not visible in the display area. Horizontally drag the zoom controls at either end of the
scroll bar to resize the contents of the visible display area.

90



Logic Pro Instruments for Mac

Adjust the values of one or more partials
In Alchemy in Logic Pro, from the Partial bar display, do any of the following:
« Click directly at a position in a bar to set a value.

- Drag a bar vertically. Hold down Shift while dragging to set values with
enhanced precision.

- Drag horizontally to create multiple new partials or to alter several existing
partial values.

- Control-click a partial or drag a partial below the baseline to set it to a value of zero.

- Control-click in the Partial bar display, then drag left or right to set multiple partials to
a value of zero.

Create an additive sound from scratch

This example introduces the basic principles of additive programming in Alchemy.

When you create a new, initialized preset by choosing Initialize Preset from the File button
pop-up menu in the Name bar, source A is in VA mode.

Important: Use of Initialize Preset automatically turns on wide unison mode. See Alchemy
wide unison mode.

For additive synthesis, a different default configuration is better suited. It is not necessary
to change any settings from their initial values as soon as you enter the Additive edit
window and start creating data; the configuration of source A switches, automatically,

to a sensible set of defaults for additive programming.

1. In Alchemy in Logic Pro, open advanced view and click the A button to view the source
A subpage, then click the source A Edit button to open the Main edit window. Click the
Additive button at the top of the Main edit window to view the Additive edit window.

2. Set the Detail knob to 100% for an accurate view of all data.
3. Make sure the Partial bar display Vol button is on and the Overall button is off.

4. Drag from left to right in the Partial bar display to draw in bars that define the harmonic
content at the beginning of the sound.

Play a few notes on your MIDI controller to confirm that the sound begins with a
bright timbre.

5. The default loop mode is Continuous which loops the sound indefinitely when you hold
a note. If you do not want the sound to loop, change the Loop mode to None.

6. Select point 2 in the Partial envelope, then click the Breakpoint button and choose
Copy Breakpoint from the pop-up menu.

7. Select point 3 in the Partial envelope, and drag it toward point 2. Release point 3 when
you are close to point 2.

8. Click the Breakpoint button, and choose Paste Breakpoint from the pop-up menu.
Make sure point 3 is selected.

The data from point 2 is copied to point 3, smoothing out the levels between points.
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9. Click the X icon at the top right to close the Additive edit window.
The Additive element parameters are displayed.

10. Experiment with the Additive parameters to change the tone of your basic additive
sound. Feel free to use other synthesis, filter, modulation, and effect parameters to
make your additive sound more interesting.

Import an image file, and convert it to additive data

Alchemy is capable of importing an image in PNG (Portable Network Graphics) format and
translating it into additive synthesis data. You can convert an existing image into sound,
or you can design new sounds by drawing the image you want to import in an external
graphics application.

1. In Alchemy in Logic Pro, open advanced view and click the A button to view the source
A subpage, then click the source A Edit button to open the Main edit window. Click the
Additive button at the top of the Main edit window to view the Additive edit window.

2. Click the Image button at the top right of the Additive edit window, then choose a
PNG-format file in the file browser.

The selected file is translated into additive data using the criteria outlined below.

Each column of pixels represents a snapshot in the additive data. The leftmost
column describes snapshot 1, the next column to the right describes snapshot 2,
and so on. Snapshots are timed at a steady rate of 20 per second.

- Within each column, there is a one-to-one correspondence between pixels and
partials: the bottom row represents partial 1, the second row up represents partial
2, and so on. Thus the height of your image determines the number of partials. For
example, an image 100 pixels tall translates to a 100-partial sound.

The brightness of each pixel determines the amplitude of a particular partial in
a particular snapshot. A black pixel corresponds to silence, while a white pixel
corresponds to maximum amplitude. You can import both color and grayscale

images. Color information other than brightness is ignored.

Note: Importing an image with a lot of bright pixels results in additive data with
numerous high-amplitude partials, which may cause clipping to occur.

3. If the results of an image import are unexpectedly noisy, you can reduce the overall
amplitude by doing one or more of the following:

Reduce the Vol setting of the additive element.

Click the Overall button, then choose All from the Mode pop-up menu, and drag
downward in the Partial bar display.

Use your graphics software to darken the image before importing it.
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Alchemy partial envelope in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters
for the selected source.

The source edit window is opened by clicking the Edit button on any source subpage.
Click the close window icon (X) at the top right to close the window.

Use the Additive button at the top of the Main edit window to open the additive
editor window.

The Partial envelope shows a number of points that indicate the temporal position of
envelope snapshots (groups of partials) or individual partials, depending on the chosen
Mode pop-up menu option (above the Partial bar). These points also indicate the overall
level or value of the visible parameter type in the selected snapshot or partial. Partials are
shown in the Partial bar display. See Partial bar display.

Partial envelope parameters
- Overall button: Shown above the Partial bar display, sets two Partial envelope modes.

Overall button on: Each point represents a snapshot of summed amplitude, pitch,
and pan values of all partials at a certain point in time. Typically, you choose
snapshots in the envelope display and adjust individual or grouped partial values
in the Partial bar display. You can, however, also adjust all partial values in a given
snapshot by dragging vertically in the Partial envelope. The horizontal, or x-axis,
indicates the temporal position of each snapshot. The vertical, or y-axis, indicates
the summed value of each snapshot.

Overall button off: Each point in the Partial envelope has a one-to-one correlation
with the selected partial in the Partial bar display. Adjusting a value in either the
Partial bar display or the Partial envelope is immediately reflected in the other. The
horizontal, or x-axis, indicates the temporal position of the selected partial. The
vertical, or y-axis, indicates the value of the selected partial.

Note: The time positions of envelope points may vary from one partial to the next as
you choose different partials when the Overall button is off. This is one of the keys
to the high quality of resynthesis in Alchemy: each partial can have an independent
set of points. When the Overall button is on, Alchemy presents a series of envelope
points linked to all partials, and adjustments to individual partial times and values are
handled automatically.
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- Detail knob: Set the resolution of the Partial envelope display. This affects the number
of points shown.

- A value of 25% reduces the total number of visible points. This may necessitate
scrolling or zooming to view all points.

A value of 100% shows all points. The 500 or more visible points are unnecessary
for anything other than the most precise edits, but you may find this level of detail
useful when programming an additive sound from scratch, rather than editing
resynthesis data.

- Mode pop-up menu and field: Choose a mode to determine the way the envelope
responds when a point is dragged.

«  Normal: The dragged point only is moved. All other points remain stationary.

- Slide: Dragging one point causes all subsequent points to move, retaining the
relative distances between points.

- Stretch: Dragging left compresses earlier points and stretches later points. Dragging
right stretches earlier points and compresses later points. In either case, the total
length of the envelope is preserved.

Note: Point levels remain fixed in stretch mode, so you can only drag horizontally.
- Partial envelope: Display and edit envelope point positions and values.
The ruler indicates the current envelope position in milliseconds.

The Partial envelope shows only straight line segments between points, with no
convex or concave lines.

The first and last points always have an amplitude of zero. In sounds with a fast
attack phase, a second point with a nonzero amplitude is shown at a time position
very close to the first point. You may need to increase the Detail setting to see the
second point.

- Loop and warp markers can be superimposed on the Partial envelope. See
Zone waveform editor.

Warp marker movements automatically snap to existing Partial envelope points.

Positioning the loop start and loop end markers at identical positions creates a
sustain point which allows a particular segment of the sound (a snapshot) to be
heard continuously. This method is useful for locating, auditioning, and editing a
succession of snapshots.

« Scroll bar and zoom controls: Drag the middle of the scroll bar to view envelope points
that are not visible in the display area. Horizontally drag the zoom controls at either end
of the scroll bar to resize the contents of the visible display area.
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Create or delete points in the partial envelope

In Alchemy in Logic Pro, do one of the following:

.

.

Click anywhere in the Partial envelope to create a new point for the active partial
(selected in the Partial number bar).

Click on or near a line between existing points to create a new point.

When the Partial envelope contains existing points, either method creates a snapshot of
partial values that fall in between the partial values associated with the preceding and
following points.

If the Partial envelope is “blank” (only contains a single point), each newly-created point
has a single associated partial value (for the partial selected in the Partial number bar).
The partial (value) of the preceding point is also shown in the Partial bar display.

Note: The Overall button affects the display of values shown in the Partial bar and
related points in the Partial envelope.

Double-click an envelope point to delete it.

Adjust partial pitch values with partial envelope points

When the additive editor displays pitch (the Tune button is on), point levels represent
partial pitches. You can edit these levels to eliminate a pitch wobble or to create vibrato,
for example.

1.

In Alchemy in Logic Pro, click an envelope point to select it. You can also drag across
multiple envelope points to select them.

This selects a snapshot of multiple partials when the Overall button is on, or individual
partials when the Overall button is off.

When multiple points are selected, the Partial bar shows the average value of each
partial across the selected envelope points. Edits of partial values are applied to all
partials associated with the selected points.

Click the Tune button above the Partial bar display to view pitch values at the current
envelope point.

If required, click the Mode pop-up menu above the Partial bar to choose how your edits
are applied: to a single partial, all partials, or a group of related partials.

. Drag the envelope point vertically to set the pitch value.

The time and pitch of the selected point are displayed at the pointer position
when clicked.
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Fix unwanted pitch fluctuations with copied envelope points

In cases where a resynthesized sound has unwanted pitch fluctuations, you can resolve
these artifacts by reducing the PVar (pitch variation) control on the source A/B/C/D
subpage. The downside with this approach is that each partial is aligned with its
harmonic tuning which may change the character of the sound significantly. Try

this alternative method.

1. In Alchemy in Logic Pro, make sure the Overall and Tune buttons are active, then select
a single Partial envelope point.

2. Click the Breakpoint button, and choose Copy from Breakpoint from the pop-up menu.

3. Click the Breakpoint button, and choose Paste All Breakpoints Pitch Data from the
pop-up menu.

The partial pitch values of the copied envelope point are applied to all other envelope
points, thus retaining the inharmonic features of the copied point while simultaneously
eliminating fluctuations from one point to the next.

Alchemy spectral edit window in Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the A/B/C/D button to view detailed parameters for
the selected source.

The source edit window is opened by clicking the Edit button on any source subpage.
Click the close window icon (X) at the top right to close the window.

Use the Spectral button at the top of the Main edit window to open the Spectral
edit window.

Spectral edit window: Use to graphically edit spectral resynthesis data. You can also create
new sounds by using simple paint tools directly in the display.

o o L e
StereaMods  Resolution
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Spectral data is displayed as follows in the Spectral edit window, or “canvas”.

Time, expressed in seconds, is represented along the x-axis from left to right. It is also
shown at the pointer position.

Frequency, in hertz, is represented along the y-axis from bottom to top. It is also shown
at the pointer position.

Amplitude is represented by brightness, using shades of blue. Dark blues represent
lower amplitude values, and light blues represent higher amplitude values. Silence is
black, and the loudest amplitude is white.

A green play position indicator scrolls across the image for the most recently
triggered voice.

Warp markers are also shown, if the Warp button is enabled in the Main edit window.

Note: Accurate resynthesis requires a much finer frequency resolution than the spectral
display can accommodate. Frequency information depicted in the display is a coarse
representation of the underlying data. Graphical data creation and editing are performed
at the resolution of the display. This means that you cannot paint conventional melodies
and chords consisting of precise notes, for example.

Spectral editor parameters

Draw/Mask buttons: Set a mode that affects the behavior of the paint tools.

- Draw: The paint tools can be used to modify the image itself either by drawing new
or deleting existing content or by increasing or decreasing the luminosity of specific
parts of the spectrum.

- Mask: The entire image is masked, as if covered with a layer of black wax. The paint
tools can be used to selectively reveal parts of the underlying image, as if scraping
away the wax to reveal the layer underneath.

Note: The most recent edit made in the Spectral editor can be undone by pressing
Command-Z. Multiple edits can be reversed by pressing Option-Command-Z, then
choosing the step you want to revert to from the Undo History window.

Lasso, Brush, and Erase buttons: Choose a select (Lasso) or brush mode. Erase uses
the selected brush type to remove portions of the spectrogram.

- Lasso button: Turn on to activate a select mode. Drag across the spectral canvas to
select an area.

- In mask mode, your selection only is played. The unselected portion of the canvas
is silent.

In draw mode, your selection can be used as a brush shape.

Brush button: Turn on to activate brush mode. You can draw directly on the image
when in draw mode, or scrape away the mask layer to reveal the underlying image
when in mask mode. Any Lasso selection can be used as a brush shape that remains
available until you select a different brush shape. See Brush pop-up menu and field.

«  Hold down Shift to limit painting to the vertical axis.
+ Hold down Command to limit painting to the horizontal axis.

- Erase button: Turn on to selectively remove portions of the image with the selected
brush type. See Brush pop-up menu.
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Brush pop-up menu and field: Choose a predefined brush shape. Visible only when the
Brush or Erase button is active.

« Circle, DotBlurred, LineHorizontal, and LineVertical produce the brush
shapes described.

Transient produces a vertical edge that slopes to the right, typical of a percussive
drum hit.

Custom uses the Lasso selection as a brush shape.
Size knob: Scale the size of the brush chosen in the Brush pop-up menu.
Note: When a custom brush is active, the Size knob is not available.

Color knob: Set the amplitude scaling of the brush. At 100%, brush strokes are white.
At 50%, brush strokes are mid-blue. At zero, brush strokes are black. This knob is
visible only when both the Draw and Brush buttons are active.

Note: When a custom brush is active, the maximum intensity is defined by the custom
brush data.

Mode pop-up menu and field: Choose a mode that determines how the brush interacts
with the existing canvas image in draw mode. This menu is visible only when both the
Draw and Brush buttons are active.

Normal: Each pixel on the canvas is set identically to the corresponding brush pixel.

Add: Brush pixel values are added to the existing canvas pixel values. In this
mode, painting multiple coats of blue results in increasingly higher amplitudes
with each coat.

Multiply: Brush pixel values are multiplied with the existing canvas pixel values.
Use this to selectively brighten parts of the image.

Mono/Stereo buttons: Switch the display mode between mono and stereo.

Note: This does not change the sound. In mono mode, stereo sounds are represented
as a single image that represents both channels. Edits affect the left and right channels
equally. In stereo mode, stereo sounds are shown in left and right lanes. Edits affect
only the channel they are made in.

Resolution buttons: Switch the display between a linear and logarithmic representation
of your spectral data on the vertical y-axis. Logarithmic (right button) is the default.

Linear (left): A simple linear scale with 11 KHz shown at the halfway point
on the vertical y-axis. This mode is useful for detailed editing of very high
frequency content.

- Logarithmic (right): A logarithmic scale for frequency that corresponds more closely
with human perception of pitch. Content at the halfway position on the y-axis is
approximately 1 KHz. Log mode is useful for most editing duties.
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- Image button: Choose an import image option from the pop-up menu.

- Import Image: Opens a dialog where you can select a file in PNG format that is
placed directly on the spectral canvas. The imported image is positioned at the far

left of the canvas. The height of the image is scaled to fit the entire vertical range of

the canvas, and the width of the image is scaled by the same factor as the height,
retaining the original image proportions. All color information is discarded, and
image brightness information is mapped to amplitude. If the imported image width
does not extend fully to the right edge of the canvas, existing data beyond the imag
edge remains in place. Images with a height of 256 lines result in a one-to-one map
of pixels to spectral bins. The spectral editor display is actually 381 lines tall, so
edits involve some blurring between bins.

Import Image to Brush: Opens a dialog where you can select a file in PNG format to
be used as a brush for painting on the spectral canvas. The original dimensions of
the image are preserved. You can place the image at any position with a click, or
you can drag to paint with it.

- Clear button: Deletes all spectral data from the source, leaving only silence (a solid
black image).

« Scroll bar and zoom controls: Drag the middle of the scroll bar to view spectral data
that is not visible in the display area. Horizontally drag the zoom controls at either end
of the scroll bar to resize the contents of the visible display area.

Alchemy main filters

Alchemy main filter controls in Logic Pro for Mac

Main filter components are shown only in advanced view. Click the Advanced button to
switch to advanced view, then click the Global button.

There are two main filter modules, labeled Filter 1 and Filter 2. The filters can operate in
parallel or in series.
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The output from all four sources is sent to the main filters at levels determined by
independent controls in each source. Both main filter modules provide multi-mode
filters with identical controls.

Note: It is possible for each source to completely bypass the main filters, or to send a
portion of the source signal to the main filters and another portion directly to the Effects
section. Though you can use filters at multiple locations in the signal path, you can often
attain the same or similar results by careful use of fewer filters, which helps to reduce
CPU load.

Main filter parameters

On/Off buttons: Enable or disable each filter.

Filter type pop-up menus and fields: Choose the filter type. Use the descriptive names:
Clean, Edgy, Gritty, Rich, Sharp, and Smooth to make a choice that is right for your
sound. You can step through the available filter types with the Previous and Next
buttons (the arrows). See Filter types.

Note: The chosen filter type can alter the names and functions of the default Cutoff,
Resonance, and Drive knobs.

Cutoff knobs and fields: Set the cutoff frequency for the chosen filter type.

Resonance knobs and fields: Boost or cut frequencies above, below, or surrounding the
value set with the Cutoff knob. Resonance behavior changes when different filter types
are chosen.

Drive knobs and fields: Overdrive the filter. This can lead to intense distortions and
aliasing, depending on filter type.

VU meters: Indicate the current audio level received from all four sources. If the

filter input level exceeds 0dB, the VU meters indicate clipping by momentarily turning
red. Clipping produces an undesirable digital audio artifact in the output stage. If
clipping occurs, reduce the Vol knob of the loudest source or adjust the balance
between sources.

Par/Ser knob and field: Set the filter routing configuration. Note that this is pre-effects.

- At 0% position, the total output of Filter 1is sent to the main outputs of the filter
module. This is parallel mode.

At 100% position, the total output of Filter 1is sent to the Filter 2 input. This is
series mode.

At 50% position, equal amounts of the Filter 1 output signal are sent to the Filter 2
input and the main outputs of the filter module.

Note: When the Par/Ser knob is set to 100%, a portion of the Filter 1 signal bypasses
Filter 2 whenever the Filter 1 FX Master knob is set above 0%.

100



Logic Pro Instruments for Mac

FX master knobs: Determine the balance between the filter module output sent to the
Effects section and the filter module output sent directly to the Alchemy main output.

- At 0% position, the total filter output is sent to the Alchemy main outputs, and none
of it to the Effects section.

At 100% position, the total filter output is sent to the Effects section, and none of it
to the Alchemy main outputs.

At 50% position, equal amounts of filter output signal are sent to the Effects section
and the Alchemy main outputs.

Send destination pop-up menus: Independently send the output of main filter 1 or 2 to
the Main effects rack, or to the A/B/C/D effects rack. Choose FX Main, FX A, FX B, FX C,
or FX D.

Note: When the FX master knob for filter 1 or 2 is at the full-left position, the total filter
1 or 2 output is sent to the Alchemy main outputs, and none of it to the Effects section.

Create vowel sounds with parallel source filters

Vowel sounds in human speech are the result of formants produced by changing the shape
of the vocal cavity. By mimicking these formants, Alchemy can produce speech- or song-
like effects, even in VA mode without samples of actual speech.

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Click the source A button, then make the following parameter changes:

« Set Vol to 0 dB.
. Set Coarse Tune to —12 semis.
Click the source A Fine Tune knob.

In the top slot of the modulation rack, choose LFO > LFO 1 from the pop-up menu, then
set the Mod Depth knob to a value near 50%.

In the LFO 1 control panel, set Attack to approximately 0.50 sec, turn off Sync, and set
Rate to approximately 5 Hz.

Enable filter 1 by clicking the On button next to the filter type pop-up menu. Do the
same for filters 2 and 3. Click the Par(allel) button to enable parallel configuration of
the source A filters.

Click the Global button to view all sources, then click the source A content field and
choose Copy Source from the pop-up menu.

Click the source B content field, and choose Paste Source from the pop-up menu.
Repeat for the source C and D content fields.

Click the A button to view source A, then make the following (approximate) parameter
changes to create an "ahhh” sound:

Cutoff 1 =800 Hz, Res 1=87%
Cutoff 2 =1200 Hz, Res 2 = 87%
Cutoff 3 =2800 Hz, Res 3 =87%
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10. Click the B button to view source B, then make the following (approximate) parameter
changes to create an “eeeh” sound:

« Cutoff 1 =230 Hz, Res1=87%
«  Cutoff 2 =2600 Hz, Res 2 =75%
« Cutoff 3 =3200 Hz, Res 3 =75%

11. Click the C button to view source C, then make the following (approximate) parameter
changes to create an "oooh” sound:

Cutoff 1 =200 Hz, Res 1=87%
Cutoff 2

880 Hz, Res 2 = 65%

Cutoff 3 =2400 Hz, Res 3 =50%

12. Click the D button to view source D, then make the following (approximate) parameter
changes to create an “ehh” sound:

Cutoff 1 =530 Hz, Res 1 =65%
Cutoff 2 =1850 Hz, Res 2 = 75%
Cutoff 3 = 2500 Hz, Res 3 =50%

Control parallel source filters with morphing
The previous task set up a number of vowel sounds with source filters. Follow these steps
to morph between these sounds with your keyboard modulation wheel.
1. In Alchemy in Logic Pro, click Morph to view morph parameters, then click the Morph
Lin button.
2. Set the X knob to 0%.
In the modulation rack, Morph All X is shown at the top.

3. Choose Perform > Control7 in the first modulation rack slot. Leave the modulation depth
value at 100%.

The modulation wheel is linked by default to performance control 7.

4. Play your keyboard, and move your modulation wheel to morph between the source
filtered sounds.

If the output level seems low, you can boost it by increasing the value of the Vol knob in
the Master section or the Volume knob on the Name bar.

Alchemy filter types in Logic Pro for Mac

Alchemy provides a total of 15 multi-mode filter modules. These can be used at the source
level or as main filters that process all routed signals. Filters used at the source or main
filter stages affect each voice independently. You can also insert filters in the Effects
section, but they are monophonic when used at this point in the signal path and affect

all voices (the overall signal) simultaneously.

Two main filters. See Main filter controls.
Four sets of three source filters. See Source filter controls.

The MMFilter module in the Effects section. See Filter effects.

There are dozens of filter types to choose from in the main filters and the MMFilter
effects module.
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Alchemy filter types: lowpass, bandpass, highpass

A lowpass (LP) filter passes the portion of a signal below a specified cutoff frequency and
rolls off the portion above that frequency. A bandpass (BP) filter passes the portion of a
signal occupying a band surrounding the cutoff frequency and rolls off the portions above
and below that band. A highpass (HP) filter passes the portion of a signal above a specified
cutoff frequency and rolls off the portion below that frequency.

There are multiple LP, BP, and HP filter designs in Alchemy, each with distinctive
characteristics that you may prefer for a given purpose. The available LP, BP, and
HP filter designs include:

- Clean: Bi-Quad filters. These filters have no Drive option.

- Edgy: Two- or four-pole analog-modeled filters. Four-pole variants provide a steeper
roll-off of frequencies beyond the cutoff.

- Gritty: Two-pole filters designed to saturate heavily at higher Resonance and
Drive settings.

- Rich: Two- or four-pole analog-modeled filters. Four-pole variants provide a steeper
roll-off of frequencies beyond the cutoff.

- Sharp: Two-pole analog-modeled filters.
- Smooth: Two- or multi-pole state-variable filters.

The three principal filter controls have standard functions for all filter types.

« Cutoff: Controls the filter cutoff frequency.

- Resonance: Controls the filter resonance or emphasis. Higher settings boost
frequencies in the immediate vicinity of the cutoff frequency.

- Drive: Allows the filter to be overdriven; the precise effect varies with each filter design.

Alchemy filter types: formant, notch, and peaking

A formant filter works like a bandpass filter with a potentially very narrow bandwidth. It is
designed to mimic a formant, or fixed resonance, such as those produced by the hollow
body of a guitar or by the shape of the vocal cavity (which is adjusted during speech to
produce different vowel sounds).

« Cutoff: Controls the resonant frequency of the formant.

« Amount: Controls the width of the band surrounding the resonant frequency. Low values
produce a narrow band, high values a wider one. Low resonance values may allow little
or no sound to pass through the filter.

A notch filter cuts a narrow band around a resonant frequency. The remainder of the signal
is affected minimally.

- Cutoff: Sets the frequency of the cut band.
- Amount: Controls the amount of attenuation.

A peaking filter boosts a narrow band around a resonant frequency. The remainder of the
signal is affected minimally.

- Cutoff: Sets the frequency of the boosted band.
« Gain: Controls the amount of boost. Higher values are generally the most effective.

- BW: Sets the bandwidth around the cutoff frequency.

103



Logic Pro Instruments for Mac

Alchemy filter types: comb filters

A comb filter mixes the original signal with one or more copies of the signal which are
delayed by a very short time interval. At some frequencies this mixture causes phase
cancelations, while at other frequencies it causes reinforcements. The result is a spiky
frequency spectrum with multiple resonant peaks. Graphically, these peaks resemble
the teeth of a comb, which gives this filter type its name.

Alchemy offers three comb filter designs, each with its own character. The best choice is
very much a question of your preference and the type of sound you are trying to create.
That said, there are some distinguishing characteristics that may help guide you.

Comb Pos uses positive feedback on the delay lines, while Comb Neg uses negative
feedback to produce less extreme effects, often with a hollow quality. These two are the
less powerful combs and offer a much more gradual increase in resonance. They can

be useful when you require either a less dramatic effect or you want to hear more of the
exciter signal character in your sound. The latter point is noteworthy as this trait can be
useful when you want a more naturalistic modeled sound.

Comb PM uses bipolar feedback on the delay lines. The resonance control is bipolar,
allowing you to freely shift from negative (hollow sound) on the left to positive (bright and
peaky) on the right. This comb is useful for classic bright Karplus-Strong style sounds,
where the exciter impulse is not easily heard and the comb is more prominent. Take care
with your resonance level because it is capable of quickly going to extremes, which can
lead to feedback. Start with a resonance level of zero and increase (or decrease) slowly
to find a suitable effect strength.

For instrument modeling, it is best to assign combs as source filters, rather than in the
master filter or effect sections. Although comb filters can be used in the master filter
section, it is better to use the main filters for additional processing. Comb filters are also
available in the Effects section but are not polyphonic, so you will achieve better results if
they are placed earlier in the signal path.

« Cutoff: Controls the delay time in the comb circuit. Lower cutoff values equate to a
longer delay.

«  F-Back: Controls the amount of feedback in the comb circuit.
- Damp: Softens the frequency peaks in the comb-filtered spectrum.

Note: Sending a percussive sound into a highly resonant comb filter causes it to ring at
a frequency determined by the delay time you have set with the Cutoff knob.
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Alchemy filter types: ring modulation

Ring modulation is a process in which a modulator and a carrier signal are multiplied. Each
frequency component of the modulator interacts with each frequency component of the
carrier to produce two sidebands: a sum and a difference (carrier — modulator). When a
filter is set to the RingMod type, the signal entering the filter acts as the modulator, while
the carrier is supplied internally by the filter.

«  Frequency: Controls the carrier frequency.
- Mix: Applies a constant offset to the carrier.

- At 0%, the carrier wave varies between -1 and +1, resulting in classic
ring modulation.

« At 100%, the carrier wave varies between 0 and 1, resulting in classic amplitude
modulation. In this case, the carrier signal itself is present alongside the sum and
difference sidebands.

- Weird: Controls the carrier waveform.

Set to 0% for a pure sine wave carrier. Use this setting to produce characteristic
bell-like timbres.

Set above 0% to progressively truncate the carrier waveform. Higher settings
produce additional sidebands, typically resulting in noisy timbres.

Alchemy filter types: distortion

Alchemy filters offer several distortion effects.

- Bitcrusher is a harsher-sounding digital effect.

- Downsample is a lo-fi digital effect (similar to Bitcrusher but is frequency dependent).
- Mech is a more metallic-sounding distortion.

« Tube is a classic tube distortion effect.

Note: Distortion effects created in the source and main filter sections are polyphonic, with
each voice distorted independently. This avoids unpleasant intermodulation effects when
you play chords. In contrast, the Distortion module in the Effects section at the end of the
signal path processes a mix of all voices.

The filter controls work as follows when the filter type is set to a distortion effect:

- Amount: Controls the intensity of the distortion effect.

- Mix: Controls the mix between clean and distorted signals. A value of 0% results in the
clean signal only. A 50% value results in an equal mix of clean and distorted signal. A
100% value results in the distorted signal only.

- PreGain/Freq: Boosts the input gain. Sets the frequency for the Downsample
distortion type.
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Alchemy filter types: compressor and FM

These tools provide creative options at the filter stage of the signal path. Unlike dedicated
FM synths, Alchemy does not have preconfigured algorithms or a mod matrix setup
specifically for FM. It does, however, offer the option to run a huge number of FM filters in
various series and parallel configurations. FM in Alchemy also has a different character to
classic FM synths. FM in Alchemy is more like working with FM on analog synths where you
are modulating oscillator frequency rather than phase. As a result, Alchemy’s FM is great
for adding different kinds of effects to your sound, as well as "organic” distorted textures.

The filter controls work as follows when the filter type is set to Compressor:

- Thresh: Set the threshold level—signals above this threshold value are reduced in level.

- Ratio: Set the compression ratio—the ratio of signal reduction when the threshold
is exceeded.

- Gain: Set the amount of gain applied to the compressed signal.

The filter controls work as follows when the filter type is set to FM:

«  Freq: Set the carrier oscillator frequency.

Tip: For classic FM sounds, double-click the Freqg knob to set it to the center
position, then Control-click the knob and choose Add Modulation > NoteProperty >
KeyFollow from the shortcut menu.

- Mod: Set the degree to which the modulator (source audio) can modulate the frequency
of the carrier.

- F-Back: Set the amount that the output of the carrier is fed back into itself.

Alchemy master voice section in Logic Pro for Mac

Master voice section controls are shown only in advanced view. Click the Advanced button
to switch to advanced view, then click the Global button.

An individual voice generated in the source section is passed through the main filters,
then into the master voice section where controls are provided for the amplitude, pan,
and coarse and fine-tuning of the voice. The voice is then mixed with other voices at
the input of the Effects section.

The master voice section also provides high-level control over various attributes of a
preset such as polyphony, tuning, and glide.

Always

Newest
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Master voice controls

Vol knob: Adjust the level of the voice. By default, AHDSR 1 modulates this parameter.

Note: When an AHDSR envelope is assigned to modulate master volume, the modulation
depth cannot be adjusted. This is because setting the depth below its default of 100%
would cause notes to remain above zero amplitude indefinitely, resulting in hung notes.
This rule applies to other modulators, such as an MSEG, where you also require a mod
depth setting of 100% unless you actually want notes to sustain indefinitely.

Pan knob: Adjust the stereo position of the voice. Acts as a pan control for mono sounds
and as a balance control for stereo sounds.

Coarse/Fine Tune knobs: Adjust the pitch of the voice in semitones (Coarse) and cents
(Fine=1/100 of a semitone).

All/A/B/C/D buttons: Select All to set global voice parameters, which override individual
source settings. Select A/B/C/D to set individual source voice parameters. All of the
following parameters can be set globally or per source.

Trigger Mode pop-up menu: Determine how trigger events affect audio signals and
glides (portamento). This parameter interacts with the Num and Glide controls and can
be used globally or per source.

Note: A trigger signal causes certain processes to execute from the beginning. These
include: the playback of samples and modulators, including LFO, AHDSR, MSEG, and
Sequencer. Individual modulators also have their own trigger options.

Always: If the Num value is 1, a trigger is generated at the start of each legato
group, and portamento occurs at the start of every note. For all other Num values,
a trigger is generated at the start of every note, and portamento occurs at the start
of every note.

- Retrigger: A trigger is generated at the start of every note, and portamento occurs at
the start of every note.

Legato: If the Num value is 1, a trigger is generated at the start of each legato group,
and portamento occurs at the start of each legato group. For all other Num values,
behavior is unchanged when you play single notes. When you play a chord, each
note of the chord is triggered individually.

Num (ber of voices) pop-up menu: Set the maximum polyphony of a preset (up to 32
voices) when used globally, or maximum polyphony per source. A value of 1 results in
a monophonic preset or source.

Tip: Aim for the lowest possible polyphony value for the preset because this helps to
reduce CPU load.

Voice Priority pop-up menu: Choose the Newest (last played), Oldest (first played),
Lowest or Highest (pitch) note to be prioritized when polyphony is exceeded. This
parameter can be used globally or per source.

Rate/Time buttons: The portamento (glide) mode can be set to Rate or Time. This
parameter can be used globally or per source.

« Rate: Alchemy glides from note to note at a fixed rate set with the Glide knob. Longer
glides require more time. Shown as a percentage of the overall envelope length.

- Time: Alchemy glides from note to note over a fixed amount of time (in msec) set
with the Glide knob. Longer glides occur at a faster rate.
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- Glide knob: Set the portamento rate or time. Glide causes slides from one note pitch to
the next. This parameter can be used globally or per source.

«  Pitch bend Up/Down pop-up menus: Set the maximum range for upward and downward
pitch bend modulation, typically performed with your keyboard pitch wheel. Can be set
globally or per source.

Note: Individual sources can be set to respond to pitch bend or to ignore it. This is
determined with the Keyscale parameter on each source subpage. Pitch bend is also
available as a modulator, allowing further control over the pitch bend response of each
source. See Source subpage controls.

Alchemy modulation section

Alchemy modulation overview in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

Alchemy features a modular modulation system that combines ease of use with extensive
functionality. The modulation rack is shown at the left. See Modulation rack controls. The
modulator control panel occupies the center portion of the display. This area updates
dynamically to display modulation sources for the selected parameter.

- Modulator panel type buttons: Click to view settings and adjust the controls of each
modulation source.

Note: Some modulation types, namely MIDI, Note property, and Perform control
modulators, don't have a control panel in the center of the modulation section.
These modulators are set with menu items in the modulation rack.

Click to view modulator
|Modulation rack ;control panels.

SEQUENCER  ENVFOLLOWER  MODMAP

MODULATION

Filter 1 Cutoff

On Control2

on Velocity

on

Almost every knob in the Alchemy interface is a modulation target, representing a
parameter that can be modulated by as many as ten modulators. This not only includes
voice parameters, but also effect, arpeggiator, and performance; even other modulation
parameters can be modulation targets. Each mod rack entry may have its depth (amount it
affects the target) modulated by up to five additional modulation sources. Each modulation
depth mod entry may be further modulated by an additional modulation source.

Note: The additional layers of modulation are useful when the amount of modulation, such
as vibrato, is controlled by an envelope, MSEG, or channel aftertouch, for example. The
third layer of modulation is particularly useful for assigning velocity or the modwheel to
add expressiveness to the preceding modulation layers.
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When a parameter is the target of one or more modulators, an orange modulation arc is
shown beside the blue value arc for the knob. This indicates that the knob is an active
modulation target and shows the modulation range. Parameters that are morphed and
have a modulation assignment show both an orange and a green arc around the control.

Note: The most recently clicked knob is highlighted in blue, making it easy to identify the
current target. If you switch between source subpage A to source subpage B, for example,
the highlight shifts to the corresponding knob on the new subpage. This behavior lets you
quickly assign modulations to a parameter such as Fine Tune for multiple sources.

Each modulation type is described in the linked sections. The MIDI control, Note Property,
and Perform control modulators do not have a graphical control panel.

+ LFO. See LFO controls.

- AHDSR. See AHDSR envelope controls.

- MSEG. See Multiple segment envelope controls.

+  Sequencer. See Sequencer.

- Envelope Follower. See Envelope follower parameters.
. ModMap. See ModMap parameters.

- MIDI control. See MIDI control modulators.

- Note Property. See Note property modulators.

- Perform. See Perform control modulators.

View or edit modulations assigned to a parameter

- In Alchemy in Logic Pro, click the parameter knob.
The parameter name is shown in the Target pop-up menu at the top left of the
modulation section. Directly below the Target pop-up menu is a modulation rack

with up to ten slots (one is shown by default). Click a different knob, and the mod
rack updates to reflect the new selection. See Modulation rack controls.

Use the modulation source shortcut menu
- In Alchemy in Logic Pro, Control-click a modulation target knob (filter Cutoff, for
example), then choose a command from the shortcut menu.

« Add modulation: Assign a new modulator by choosing it from a submenu. The new
modulation assignment is shown in the first empty slot of the modulation rack.

« Clear modulation: Removes all modulations from the knob, leaving the modulation
rack empty.

- Copy modulation: Copies information about all currently assigned modulators to
the Clipboard.

Paste modulation: Applies all modulator information from the Clipboard. Use of
the Copy and Paste commands lets you quickly assign the same modulations to
multiple targets.
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Assign a basic modulation with the modulation rack

As an alternative to the shortcut menu, you can assign modulation sources to targets in
the modulation rack. This example assigns the LFO 1 modulation source to the source A
Volume target. These steps apply equally to other modulation sources and targets. See
Modulation rack controls.

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Play a note to hear the default sawtooth wave.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. In the source section, click the Vol knob for source A. In the modulation section, the
Target pop-up menu changes to read Vol A.

3. Click in the top slot of the modulation rack, then choose LFO > LFO 1 from the pop-up
menu. Click the LFO button to display the LFO controls in the area to the right of the
modulation rack.

4. Hold a note to hear a tremolo effect, as the source A volume is modulated by LFO 1.
Change the LFO Rate setting to adjust the speed of the effect.

5. Try adding another modulator to the rack in the slot beneath LFO 1.

Note: Up to ten different modulators of any type can be assigned to each control in
a preset.

Modify the basic modulation

In the preceding example, a tremolo effect is achieved by modulating the source A Vol knob
with LFO 1. This example expands on the basic modulation by modulating the LFO 1 Rate
with KeyFollow, which makes the tremolo effect faster when you play higher notes. You can
adapt this example to work with other modulator parameters, such as AHDSR Attack time.

1. In Alchemy in Logic Pro, Control-click the LFO 1 Rate knob, then choose Add Modulation
> Note Property > KeyFollow from the shortcut menu.

LFO 1 Rate is shown in the Target pop-up menu, and KeyFollow is listed in the first slot
of the modulation rack.

2. Play a variety of higher and lower notes to hear the effect of KeyFollow on the LFO Rate.
If this effect is too extreme, you can reduce the value of the Depth knob shown to the
right of the first slot in the modulation rack. See Modulation rack controls.

Adjust the modulation intensity

Each modulator has its own Depth control, and each Depth control can itself be assigned
a modulator. A modulator can even be set to modulate its own depth. Up to five depth
modulators may be assigned to any modulation source. See Modulation rack controls.

1. In Alchemy in Logic Pro, Control-click a Depth control in the modulation rack, then
choose Show Modulation from the shortcut menu.

The modulation rack updates to display the Depth control name in the Target pop-up
menu. For example, LFO 1 Rate Depth 1 indicates the first modulator of the Depth target
(which is modulating the LFO Rate 1 target).

2. Add one or more modulators to the rack.
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Alchemy modulation rack controls in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

Normally, two things happen when you click a knob. First, the modulation rack associated
with the knob is displayed. Second, if a modulator has already been assigned to the first
slot in the newly displayed rack, the corresponding control panel is shown to the right.
Some modulators do not provide a control panel.

In two cases, however, Alchemy prevents these things from happening. If the knob you
click is on a modulator control panel (if you click LFO Rate or AHDSR Attack Time, for
example), Alchemy assumes you want to adjust the modulation of the current target
instead of switching to a new target. Similarly, if you click a modulation Depth knob in
the modulation rack, Alchemy assumes you want to adjust the depth, so the current rack
view is retained.

You can still view and edit modulation assignments in these cases. If a knob is located on
a modulator control panel or in the modulation rack, Control-click it to open a shortcut
menu with several commands. Choose Show Modulation to display the modulation rack
associated with the control.

Note: Some parameters cannot be modulated. Knobs in the Perform section are not
modulation targets because they are designed for use as modulation sources. If a
parameter is set with a menu command rather than a knob, you cannot modulate it,
such as with Loop mode or Filter type.

MODULATION
Filter 1 Cutoff

On AHDSR2

On KeyFollowFixed

On LFO2 (Ramp Down) ~

On Control2

Modulation rack parameters

«  Back button: Shows the previously selected modulation target that has had its
Depth value changed. The Back button is visible once you Control-click a modulation
Depth knob and select Show Modulation from the shortcut menu.

- Modulation target pop-up menu: Shows the selected modulation target and allows you
to select any active modulation target. Up to ten modulation slots are shown below the
Target pop-up menu. Each slot in the modulation rack has identical controls.

- On/off button: Turn the modulation source on or off. Off bypasses the modulation
assignment but doesn’t remove it from the slot.
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Modulation pop-up menu: Choose the modulation source. Choose None to remove
a source. Modulators are grouped by submenu. Choose New (modulator) to create
additional modulation sources of the chosen type. Many modulator types allow up
to 16 discrete modulation sources to be created. Each of these modulation sources
can have independent parameter settings and can modulate different targets.

When you assign a source, a new slot appears below the selected slot. Up to ten
modulation slots are available for each target.

Edit (E) button: Open the selected modulator control panel in the right half of the
modulation section.

Note: Not all modulator types have a control panel. Some are available only in the
Modulation pop-up menu.

ModMap pop-up menu: Assign, create, or delete a ModMap. A ModMap is used to
process the output of other modulators. See ModMap parameters.

Depth knob: Set the modulation intensity in a range from -100% to 100%. Double-click
to reset Depth to zero.

Smooth knob: Causes the target to respond more gradually to modulation at values
above zero. If you find that rapid filter or amplitude modulation causes unwanted sonic
artifacts, one solution is to add a small amount of smoothing. Larger values can also
produce interesting effects.

Note: The Smooth parameter is not available as a modulation target.

Scroll bar: Drag vertically to view modulation rack routings (slots) that are not currently
visible. The scroll bar is shown only when the number of assigned slots exceeds the
modulation rack display area.

Mod Targets button: Shows the currently viewed modulator targets. See Modulation
target pop-up menu entry above, and the Find targets for a modulator and Remove all
unused targets tasks below.

Select, create, or change a modulator in the modulation rack

In Alchemy in Logic Pro, click a slot in the modulation rack, then choose an item from
the pop-up menu.

Undo a modulation assignment in the modulation rack

In Alchemy in Logic Pro, choose None from the modulation rack pop-up menu.

The modulator has no effect on the currently selected target but remains available for
assignment to other parameters.

Note: Depending on the situation, you may prefer to use the On/Off button for a
modulation slot to bypass the routing temporarily. This retains all parameter settings
of the modulation source.

Delete a modulation assignment from the modulation rack

In Alchemy in Logic Pro, click a slot in the modulation rack, then choose Parameter
group > Del parameter name from the pop-up menu.

For example, you would delete LFO 2 by choosing LFO > Del LFO 2 from the
pop-up menu.

112



Logic Pro Instruments for Mac

Find targets for a modulator

The modulation rack shows all modulators (sources) assigned to a particular target. The
Mod Targets button at the top right of the modulation section quickly displays all targets
of a particular modulation source.

- In Alchemy in Logic Pro, click the Mod Targets button to open a pop-up menu that
shows all modulators and all assigned targets for these modulators.

If you initialize Alchemy by clicking the File button, and then choose Initialize Preset
from the pop-up menu, you can browse the Target menu to see that:

AHDSR 1 modulates Master Volume.
Velocity, a Note Property, modulates Master Volume.

No other modulations are assigned.

Remove all unused targets

- In Alchemy in Logic Pro, click the Mod Targets button, then choose the Remove Unused
Modulations entry from the pop-up menu.

All currently unused modulations are handled as follows:

- Any modulators assigned to a section which is turned off will be unassigned. For
example, if Aftertouch assigned to Additive FX Harmonic A : Odd/Even, it will be
unassigned when the additive module is turned off for A.

Any modulators (LFOs, AHDSRs, MSEGs, Sequencers, Modmaps) will be removed if
they are not assigned.

Any ‘Max' modulations will be removed if the same value can be achieved by
changing the static value and removing the Max modulation.

Alchemy LFO controls in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

The LFO module provides a standard Low Frequency Oscillator, such as you might find in
any conventional synthesizer or sampler. There are one or two unusual features, however.

Note: The LFO module has no depth control. The modulation depth is adjusted using the
Depth knob alongside the slot in the modulation rack.

MSEG SEQUENCER  ENV FOLLOWER MODMAP Show Target

Disrupted Cycle

Delay Attack Phase Rate

Sync
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LFO controls

Current LFO pop-up menu and field: Access each LFO control panel by selecting a
number from the pop-up menu or with the Previous and Next arrows. Alchemy provides
up to 16 LFOs—one by default, but more if you create them when assigning modulators.

File button: Open a pop-up menu with a number of LFO-related commands.

< Preset submenu: Choose a preset LFO shape. This can be used as is, or as a starting
point for your own shapes.

Save: Save the current LFO settings. A dialog opens in which you can name and save
the file (*Ifo). The new LFO name appears at the bottom of the Preset submenu.

Copy/Paste: Use these commands to copy parameter settings between LFOs.
Clear: Initialize the LFO.

Trigger pop-up menu: Choose On to retrigger the LFO (start from zero) with each
new played note. Off makes the LFO run freely (song start trigger). Voice On/FX Off
modulates voice parameters only, not effects. Also see the Delay, Attack, and Phase
knob descriptions.

Note: Settings from earlier application versions may not behave as expected, because
of the additional trigger option. Change to VoiceOn/FX Off to match the former version
behavior, then resave the setting.

Bipolar button: When on, the LFO outputs negative and positive values per cycle (-50%
to 50%). When off, only positive values are output (0% to 100%).

Shape pop-up menu and field: Choose an LFO waveform from several categories. You
can also step through the available waveforms with the Previous and Next buttons (the
arrows). The chosen LFO shape is shown in the waveform window.

« Basic: Common waveforms such as Ramp Up, Ramp Down, Sine, Square, and
Triangle, along with two random choices. Random Glide is a constantly fluctuating
random modulator that moves smoothly between random values at a speed set with
the Rate control. Random Hold is a stepped random modulator that jumps between
random values at a speed set with the Rate control, holding each value until the next
jump occurs.

Complex: A variety of complex cycles, sweeps, and patterns can be used to create
regular (and irregular) patterns for your LFO modulations.

« Random Patterns: A variety of complex patterns that can be used to create random
LFO modulations.

- Serial-Angular: A variety of stepped shapes.
- Serial-Smooth: Provides complex rising-and-falling patterns.

- Ultra High Frequency: The ultra-high frequency category waveform shapes contain
multiple copies of a pattern. The modulation speed is a multiple of the speed set
with the Rate control.

Delay knob: Introduce a delay between the note-on message and the first cycle
of the LFO when Trigger is on. When Trigger is off, Delay has no effect. The delay
time is adjustable over a range of 0.00 seconds to 20.00 seconds, or is set in
tempo-synchronized divisions when Sync is enabled.
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- Attack knob: Fade in the LFO output to increase modulation depth the longer a note
is held (when Trigger is on). When Trigger is off, Attack has no effect. The attack
time is adjustable over a range of 0.00 seconds to 20.00 seconds, or is set in
tempo-synchronized divisions when Sync is enabled.

- Phase knob: Adjust the start point of the LFO from zero to later in the cycle (when
Trigger is on). The available range is 0.00% to 100.00%.

- Rate knob: Set the LFO rate or frequency. When Sync is off, rate is adjustable from 0 Hz
to 220 Hz. With Sync on, rate is set in beats and sub-beats.

«Sync button: Turn on to synchronize the LFO Rate, Attack, and Decay controls with the
project tempo. Turn off to freely set the LFO speed, attack and decay times.

- Waveform window: Shows real-time changes to the LFO waveform.

Alchemy AHDSR envelopes in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

The AHDSR module provides an envelope generator with attack, hold, decay, sustain, and
release stages. The A, H, D, and R times can be set independently. You can set the level of
the S stage which is maintained until a MIDI note off message is received.

The AHDSR display shows a graph of envelope generator output. The ruler along the
top shows the time, calibrated in seconds or in beats when Sync is activated. The
envelope appears as series of points joined by lines or curves representing the
different envelope segments.

You can set AHDSR values with the controls outlined in this section or by dragging points
on the envelope graphic.

You can adjust the curvature of segments between points. Drag the line between points
upward to make a segment progressively more convex; drag it downward to make a
segment progressively more concave. Convex, linear, and concave envelope segments
produce characteristically different effects. Option-click the line to reset a segment to
a linear slope.

SEQUENCER  ENV FOLLOWER MODMAP Show Target

3 4 5 6 7
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Envelope controls

«  Current AHDSR pop-up menu and field: Access each AHDSR control panel by selecting
a number from the pop-up menu or with the Previous and Next arrows. Alchemy
provides up to 16 envelopes—one by default, but more if you create them when
assigning modulators.

- File button: Open a pop-up menu with a number of envelope handling commands.

Preset submenu: Choose a preset envelope shape. This can be used as is, or as a
starting point for your own envelope shapes.

Save: Save the current envelope. A dialog opens in which you can name and save
the envelope file (*.ahd). The new envelope name appears at the bottom of the
Preset submenu.

- Copy/Paste: Use these commands to copy settings between envelopes.
« Clear: Initialize the AHDSR.

« Randomize: Create a random envelope shape. This can be used as is, or as a starting
point for your own envelope shapes.

- Trigger pop-up menu: Choose On to retrigger the envelope (start from zero) with each
new played note. Off triggers the envelope for the first note only. Voice On/FX Off
modulates voice parameters only, not effects. The envelope retriggers only for notes
received after all other notes have been released.

Note: Settings from earlier application versions may not behave as expected because
of the additional trigger option. Change to VoiceOn/FX Off to match the former version
behavior, then resave the setting.

«Sync button: Turn on to synchronize the envelope with the project tempo. Adjustment
of AHDR knobs snaps the envelope to bars and beats. Turn off to set envelope stage
times freely.

- Envelope display: The AHDSR display shows an editable graph of envelope
generator output.

- Attack knob: Set the time required to reach the peak amplitude level after a note is
played. Adjustable from 0.00 seconds to 20.00 seconds.

- Hold knob: Determine the time that the peak amplitude level is held before the decay
stage of the envelope begins. Adjustable from 0.00 seconds to 20.00 seconds.

- Decay knob: Set the time required for the peak amplitude to fall to the sustain level.
Adjustable from 0.00 seconds to 20.00 seconds.

- Sustain knob: Set the envelope sustain level as a percentage of peak amplitude.
Adjustable from 0% to 100%.

+  Release knob: Set the time required for the signal amplitude to fall from the sustain
level to zero, after the key has been released. Adjustable from 0.00 seconds to
20.00 seconds.

Tip: Where possible, try to use the minimum required envelope release times in order
to reduce voice overlap, because this helps to reduce CPU load.
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Alchemy multiple segment envelopes in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

The Multiple Segment Envelope Generator (MSEG) allows complex modulation envelopes to
be created and edited.

The MSEG display shows a graph of envelope generator output. The ruler along the top
shows the time in seconds or in beats when Sync is activated. The envelope appears as
series of points joined by lines or curves representing the different envelope segments. A
Play icon scrolls across the display, tracking the progress of the envelope relative to the
most recently played note.

Any number of points can be added to an envelope. The envelope segments linking these
points can be linear or curved. A Sync function allows envelopes to be linked to a grid
derived from the Logic Pro tempo to create elaborate rhythmic patterns.

Envelopes are created and edited in two basic ways: by adding, moving, or removing
points, and by adjusting the curve of the envelope segments between points. See the Edit
Mode pop-up menu information.

Two pale gray vertical lines also appear in the MSEG display, each with a small triangular
handle shown in the ruler. These are the envelope loop markers. The marker with the left-
facing handle sets the loop end point. The marker with the right-facing handle sets the
loop start point.

The loop markers are moved by dragging the handles horizontally. The loop start marker
cannot be moved to the right of the loop end marker, and the loop end marker cannot be
moved to the left of the loop start marker. Loop markers always snap to the nearest point.
Also see the Loop Mode pop-up menu information.

SEQUENCER  ENV FOLLOWER MODMAP

Show Target
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MSEG controls

«  Current MSEG pop-up menu and field: Access each MSEG control panel by choosing
a number from the pop-up menu or with the Previous and Next arrows. Alchemy
provides up to 16 envelopes—one by default, but more if you create them when
assigning modulators.
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- File button: Open a pop-up menu with a number of MSEG-related commands.

«  Preset submenu: Choose a preset envelope shape. This can be used as is, or as a
starting point for your own envelope shapes.

- Save: Save the current envelope. A dialog opens in which you can name and save
the envelope file (*mse). The new envelope name appears at the bottom of the
Preset submenu.

Copy/Paste: Use these commands to copy settings between envelopes.
Clear: Initialize the MSEG.

Randomize: Create a random envelope shape. This can be used as is, or as a starting
point for your own envelope shapes.

- Trigger pop-up menu: Choose On to retrigger the MSEG (start from zero) with each new
played note. Off triggers the MSEG for the first note only. Voice On/FX Off modulates
voice parameters only, not effects. In Off mode, the MSEG retriggers only for notes
received after all other notes have been released.

Note: Settings from earlier application versions may not behave as expected because
of the additional trigger option. Change to VoiceOn/FX Off to match the former version
behavior, then resave the setting.

- Sync button: Turn on to synchronize the MSEG with the project tempo. When you adjust
or create envelope points, they snap to bars and beats. Turn off to set envelope point
positions freely.

« Snap Y pop-up menu and field: Quantize point levels (or y values), limiting them to
exact fractions of the available range. For example, a Snap Y setting of 1/3 snaps point
levels to the values 0, 1/3, 2/3, and 1 when a point is dragged. Off disables quantization
and lets you set point levels freely. You can also step through Snap Y values with the
Previous and Next buttons (the arrows).

Note: The Snap Y setting doesn’t move existing point levels into alignment with
quantized positions; it only affects the response of points when created or dragged.

- Loop Mode pop-up menu and field: Choose one of four MSEG loop modes.

None: Looping is disabled. The loop markers remain visible in the MSEG display but
have no effect in this mode.

« Continuous: The loop section plays continuously in a forward direction while a note
is held and continues after the note is released.

- Sustain: The loop section is played while a note is held. When the note is released,
the remainder (or release section) of the envelope plays.

- Forward/Back: The loop section plays alternately in a forward/backward direction
while a note is held and continues after the note is released.

- Edit Mode pop-up menu and field: Choose one of three modes that determine how the
MSEG responds to edits.

Normal: Only the selected point or points are moved. Non-selected points remain in
their current positions.

Slide: Dragging the selected point or points also moves all subsequent envelope
points, retaining the relative distance between points.

- Stretch: Dragging the selected point or points to the left compresses earlier
points and stretches later points. Dragging to the right stretches earlier points and
compresses later points. In either case, the total length of the envelope is preserved.
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MSEG display: Shows a graph of MSEG output, shown as points connected by lines.

Scroll bar and zoom controls: Drag the middle of the scroll bar to view envelope points
that aren't visible in the display area. Horizontally drag the zoom controls at either end
of the scroll bar to resize the contents of the visible display area.

Add or remove an MSEG point

In Alchemy in Logic Pro, to add a point, click on or near a line at the required position in
the MSEG display.

To remove a point, double-click it.

Note: Make sure the appropriate Snap Y option is active before creating points. Also be
mindful of the Sync button state.

Move one or more MSEG points

In Alchemy in Logic Pro, drag a point to the required position.

The x-axis value (time position) and y-axis value (level) are shown at the pointer
position as you drag.

Note: Hold down Command while dragging a point to restrict movement to the
horizontal or vertical axis, whichever movement is performed first.

To move several adjacent points together as a group, first drag to select multiple points,
then drag any point in the group to the required position.

Note: Make sure the appropriate Edit Mode option is active before moving points. Also
be mindful of the Sync button state.

Adjust MSEG envelope segment curvature

In Alchemy in Logic Pro, you can adjust the curvature of each segment between points.
Convey, linear, and concave envelope segments produce characteristically different
effects.

Drag the line between points upward to make the segment progressively more convex.

Drag the line between points downward to make the segment progressively
more concave.

Option-click the line to reset the segment to a linear slope.

Create an MSEG modulation routing for pitch control

Though this example is specific to pitch modulation, you can follow these steps to create a
modulation routing for other parameters such as Pan or filter Cutoff.

1.

3.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

In the master voice section, click the Coarse Tune knob, and assign MSEG 1 as its
modulator.

In the modulation rack, set the MSEG 1 Depth control to 24 semitones.
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4. If the MSEG control panel is not visible, click the MSEG button at the top of the
modulation section.

5. From the Snap Y pop-up menu, choose 1/24.

Now an MSEG envelope can be used to control pitch in semitone increments, over a
two-octave (a 24 semitone) range.

Alchemy sequencer in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

The sequencer module is a programmable step-based modulator that can play patterns
of up to 128 steps that are synchronized with the project tempo. The level of each step,
groove/swing, and envelope can be controlled globally for the pattern and per step.

SEQUENCER ENV FOLLOWER MODMAP Show Target

Alchemy sequencer controls

- Current sequencer pop-up menu and field: Access each Sequencer control panel
by choosing a number from the pop-up menu or with the Previous and Next arrows.
Alchemy provides up to 16 sequencers—one by default, but more if you create them
when assigning modulators.

- Trigger pop-up menu: Choose On to play the sequencer pattern from the beginning
with each MIDI note-on. Off makes the sequencer run continuously. Voice On/FX
Off modulates voice parameters only, not effects. The sequencer module is always
synchronized with the Logic Pro tempo, regardless of the Trigger setting.

Note: Settings from earlier application versions may not behave as expected because
of the additional trigger option. Change to VoiceOn/FX Off to match the former version
behavior, then resave the setting.

+  Rate pop-up menu and field: Set the duration of every step in the sequencer pattern,
expressed as a fraction of a beat. For example, assuming a quarter-note beat, a value
of 1/2 produces eighth note steps and a value of 1/4 produces sixteenth note steps. You
can also step through Rate values with the Previous and Next buttons (the arrows).

- Value Snap pop-up menu and field: Quantize sequencer step values, limiting them to
exact fractions of the available range. For example, a setting of 1/2 aligns bars to the
values 0%, 50%, and 100% when dragged vertically. Off disables quantization, which
lets you set step values freely. You can also step through available values with the
Previous and Next buttons (the arrows).

Note: Value Snap doesn't move existing step values into alignment with quantized
positions; it only affects the response of step values when you move or create them
in the step editor.
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Edit Mode pop-up menu: Choose one of three edit modes. Your choice affects the
appearance and behavior of the step editor to the right.

- Value: View and edit the value of each step in the pattern.

- Length: View and edit the length of each step in the pattern. Technically, you create

a pattern of longer and shorter envelope shapes so that the attack, sustain (gate),
and release stages fill a larger or smaller portion of the fixed step duration. These

lengths are combined with the overall sequencer Attack/Gate/Release settings to
determine the envelope shape of each step.

- Swing: Create variations in the timing of steps. Each swing value ranges from 0 to

2; the middle value of 1 represents standard timing, while smaller values play earlier

and larger values play later. These swing values are combined with the overall
sequencer timing pattern set with the Swing knob.

File button: Open a pop-up menu with sequencer-related commands.

Preset submenu: Choose a preset sequencer configuration. This can be used as is,

or as a starting point for your own sequences.

Save: Store the current sequencer configuration (step values, lengths, and swing
settings plus the sequencer control settings) in a new disk file (*.seq). The new
sequence name appears at the bottom of the Preset submenu.

- Copy/Paste: Store the current sequencer configuration in the Clipboard. Paste
applies the configuration currently found on the Clipboard.

- Clear: Reset the sequencer controls and pattern to default settings.

«  Randomize: Apply random offsets to the Swing, Attack, Gate, and Release
parameter values.

< Import: See the Import data from a MIDI file task in this section.

Swing knob: Adjust timing to create swing effects. Values over 0% increase the

duration of odd-numbered steps (1, 3, 5, and so on) while decreasing even-numbered

step lengths.

Attack knob: Set the time required for each step to reach its peak level.

Hold knob: Set the amount of time each step is held at its peak level.

Release knob: Set the time required for each step to fall from its peak level to zero.

Step editor: Shows steps numbered from left to right across the top of the display.
Steps are represented by vertical bars that you can edit directly. The appearance
and behavior of the step editor is determined by the active Edit Mode menu choice.

Scroll bar: Drag the middle of the scroll bar to view steps that are not visible in the
display area.
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Use the Alchemy sequencer step editor

In Alchemy in Logic Pro, the step editor shows steps numbered from left to right across the
top of the display. The appearance and behavior of the step editor is determined by the
active Edit Mode menu choice. In the default Value mode, for example, the value of each
step is represented by a vertical bar. A blank column is shown when the value is zero.

- Drag a bar vertically to adjust its value, or click directly at the required height.
- Set the values of multiple bars by dragging horizontally across them.
- Option-click a bar to set it to zero.

- Tie one step to the next by clicking below it. A small chain-link symbol appears
below each tied step. When two or more steps are tied together, they behave like
one longer step.

Import data from a MIDI file into the Alchemy sequencer

Alchemy can extract information from a short MIDI file and can apply this information to
patterns in the step editor.

You can extract velocity data and set step values to match. If the MIDI file consists of notes
of equal duration, such as a succession of eighth or sixteenth notes, every step in the
resulting pattern will have an associated non-zero value. If the MIDI file consists mainly of
notes of equal duration with occasional gaps, such as a succession of eighth notes with
occasional eighth rests, the gaps are represented by step values of zero. If the MIDI file
has irregular timing, or if it consists of chords rather than single notes, the results of this
process are less predictable and usually less useful.

You can extract groove data (timing inflections) and set step swing values to match. If the
MIDI file consists of nearly equal durations, such as eighth notes or sixteenth notes with
timing inflections, this process yields useful results.

You can also extract note pitch data and set step values to match. The MIDI file should
consist of equal durations with no gaps and should be limited to single pitches between

a low C and a C two octaves higher. For example, a MIDI file could consist of notes C1
through C3, with the low C corresponding to a step value of zero. Because the pitch range
is always two octaves, you should use the sequencer to modulate pitch with a depth of 24
semitones in order to reproduce the pattern of notes in the original MIDI file.

- In Alchemy in Logic Pro, choose one of the following Import commands from the
Sequencer File pop-up menu.

Import Velocity: Set step values based on extracted velocity data and swing values
based on extracted groove data.

- Import Note: Set step values based on extracted note data and swing values based
on extracted groove data.

- Import Groove: Set swing values based on extracted groove data.

122



Alchemy envelope follower in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

The Env Follower module provides an envelope follower with Attack, Release, and Scale
parameters. The Attack and Release times can be set independently. You can set the
overall Scale, or amplitude, of the Env Follower output.

Adjustments to Attack and Release times cause a slowdown in the reaction time of the
envelope follower to the input signal. The display shows changes in real time.

MSEG SEQUENCER  ENV FOLLOWER MODMAP

Show Target

File

MasterPostFX

- \ 1 A
A 4’“:’4"‘""“ &
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Env Follower parameters

«  Current Env Follower pop-up menu and field: Access each Env Follower control panel
by selecting a number from the pop-up menu or with the Previous and Next arrows.
Alchemy provides up to 16 envelope followers—one by default, but more if you create
them when assigning modulators.

- File button: Open a pop-up menu with a number of envelope follower
handling commands.

«  Preset submenu: Choose a preset envelope follower setting. This can be used as is,
or as a starting point for your own envelope follower settings.

- Save: Save the current envelope follower settings. A dialog opens in which you can
name and save the envelope file (*.ef). The new envelope name will appear in the
Preset submenu.

Copy/Paste: Use these commands to copy settings between envelope followers.
Clear: Initialize the envelope follower.

- Source pop-up menu: Choose a source for the envelope follower from the Audio or
Modulators submenu.

Audio: The output of any individual Alchemy source, master filters 1 or 2, master
output pre- or post-effects, or the side chain input.

Modulators: Choose any active modulation source, Note Property, MIDI source, or
Perform control.

Note: The Source pop-up menu selection is saved with an envelope follower preset,
but is only restored to the same modulator if the corresponding modulation source is
active at the time of loading.

« Attack knob: Set the time required to reach the peak amplitude level of the audio or
modulation source. Longer attack times cause the rise time to be lazy.
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+  Release knob: Set the time required to fall from the peak amplitude level reached during
the attack phase to the current level of the audio or modulation source.

Tip: Set the Attack time and Release time values to zero to closely follow the input
source. When the envelope follower Source pop-up menu choice is audio, or a very fast
modulation, this closely approximates the source envelope shape.

Tip: Assign an LFO as the source and modulate the Attack, Release and Scale
parameters with other modulation sources to create new and interesting LFO shapes
not available from the LFO menu.

« Scale knob: Set the amplitude of the output signal, after the envelope follower has
processed the incoming signal.

Tip: Because an Env Follower modulation source may be assigned to multiple
targets, the Scale parameter can be used to adjust the modulation depth of multiple
target parameters simultaneously.

«  Env Follower display: Shows the input source (dimmed), and the resulting signal after
processing (bright). The display does not update if the Env Follower panel is inactive.

Alchemy ModMap in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

A ModMap is not a modulator. Instead, its purpose is to process the output of a modulator,
mapping the original values to new ones before they are applied to a modulation target.
ModMaps let you create curved velocity responses, scale the volume of each source across
the keyboard, quantize the pitch response to a random-LFO modulation so it aligns with
the steps of a scale, and much more.

Mapping is defined by the graphical shape of the ModMap, which represents a transfer
function. The x (horizontal) axis represents the range of original modulation values, from
0.00 to 1.00. The y (vertical) axis represents the range of mapped modulation values, also
ranging from 0.00 to 1.00. To see how a modulation value is affected by the ModMap, look
at the original value along the x-axis; the corresponding y value determines the output of
the mapping.

- A convex ModMap maps the middle range of inputs to values that are higher than the
default output.

+ A concave ModMap maps the same range of inputs to values that are lower than the
default output.

« A horizontally flat ModMap maps a range of inputs to a single output.

- A stepped ModMap quantizes the input, mapping each input value to a corresponding
output value defined by one of the steps.

SEQUENCER  ENV FOLLOWER MODMAP Show Target
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ModMap parameters

Current ModMap pop-up menu and field: Access each ModMap control panel by
choosing a number from the pop-up menu or with the Previous and Next arrows.

ModMaps are created or deleted with the ModMap pop-up menu commands in the
modulation rack. The default ModMap does nothing because the output is identical
to the input.

File button: Open a pop-up menu with a number of ModMap-related commands.

Preset submenu: Choose a preset ModMap. This can be used as is, or as a starting
point for your own ModMaps.

Save: Save the current ModMap. A dialog opens in which you can name and save
the ModMap file (*mma). The new ModMap name appears at the bottom of the
Preset submenu.

. Copy/Paste: Use these commands to copy settings between ModMaps.
« Clear: Initialize the current ModMap.

Snap X pop-up menu and field: Quantize the original point values, limiting them to exact
fractions of the available range. For example, a Snap X setting of 1/3 snaps point values
to 0, 1/3, 2/3, and 1 when a point is dragged. Off disables quantization and lets you set
point levels freely. You can also step through Snap X values with the Previous and Next
buttons (the arrows).

Choose Key mode to change the ModMap display to a familiar keyboard layout. Key
mode works for any modulation source but is particularly useful for Key Follow sources,
where a specific modulation amount can be assigned to individual notes.

Snap Y pop-up menu and field: Quantize point levels (or y values), limiting them to
exact fractions of the available range. For example, a Snap Y setting of 1/3 snaps point
levels to the values 0, 1/3, 2/3, and 1 when a point is dragged. Off disables quantization
and lets you set point levels freely. You can also step through Snap Y values with the
Previous and Next buttons (the arrows).

Note: The Snap X and Snap Y settings do not move existing point levels into alignment
with quantized positions. These parameters only affect the response of points when
created or dragged.

ModMap display: Shows a graphical representation of the ModMap, which represents a
transfer function.

Add or remove a ModMap point

.

In Alchemy in Logic Pro, to add a point, click on or near a line at the required position in
the ModMap display.

To remove a point, double-click it.

Note: Make sure the appropriate Snap X/Y option is active before creating points.

Change the velocity curve with a ModMap

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.
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Click the Master Vol knob to show the modulation rack in the modulation section.
Note the two modulators loaded in the modulation rack: AHDSR 1 in the first slot,
Velocity in the second.

Choose ModMap 1 from the pop-up menu to the right of the Velocity slot in the
modulation rack.

This applies the default ModMap to Velocity modulation of Master Vol.

Play a few notes on your MIDI keyboard to confirm that the velocity response is
unchanged by the default ModMap.

Drag the middle of the ModMap line upward to create a convex curve.

Play a few more notes on your MIDI keyboard, and listen to the effect of the convex
velocity curve: notes you strike with medium force play louder than they did with the
default curve.

Drag the middle of the ModMap line downward until the segment curves in the opposite
direction, becoming concave.

Play a few more notes on your MIDI keyboard, and listen to the effect of the concave
velocity curve: notes you strike with medium force play softer than they did with the
default curve.

Use a ModMap to scale a single source level in a multi-source preset

This example covers a preset where two sources play at full level from the bottom of the
keyboard up through approximately C4. Above this point, source A remains at full strength
while source B gets softer as you play further up the keyboard.

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Click the Global button to view all sources, then load one sample (or multi-sample) into

source A, and load a contrasting sample (or multi-sample) into source B.

By default, there is a 50% crossfade between these sources, so you should hear a
balanced mix of the two samples across the entire keyboard range.

Click the source B Vol knob to show the modulation rack in the modulation section.
In the first slot of the modulation rack, choose Note Property > KeyFollow.

The amplitude of source B is modulated according to MIDI note number, but this
modulation does not yet have the required shape. Currently, the lowest notes are
softest, notes in the middle of the keyboard are medium-loud, and notes at the top
are loudest.

You will now use a ModMap to reshape the response of source B Vol to modulation by
KeyFollow.

Choose ModMap 1 from the pop-up menu to the right of the source B slot in the
modulation rack.

This applies the default ModMap to KeyFollow modulation of source B Vol.

Play a few notes on your MIDI keyboard to confirm that the KeyFollow response is
unchanged by the default ModMap.
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7.

8.

Edit the ModMap points as follows:
- Drag the leftmost point up to a level of 1.00.

- Click at a position along the line slightly to the right of the halfway mark to create a
new point. Leave the level of this new point at 1.00.

- Drag the rightmost point down to a level of 0.00.

Play across the keyboard range to hear the source B Vol response. If the response is not
to your taste, make further adjustments to the point values or positions in the ModMap.

Use a ModMap to quantize pitch modulation to a pentatonic scale

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Click the master voice section Coarse Tune knob to show the modulation rack in the
modulation section.

3. In the first slot of the modulation rack, choose LFO > LFO 1, and reduce the modulation
Depth to 12.0 semis.

4. Adjust LFO 1 settings as follows:
«  Shape = RandHold
- Rate =1/2 beats
- Bipolar = off

5. Play and hold a note to confirm that the pitch changes freely within the 12 semitone
range, twice per beat.

6. Set SnapX = 1/6 and SnapY = 1/12. These functions make it easier to create the required
ModMap shape.

7. Click along the line to create ten new points between the first and last points.

8. Edit the ModMap points as follows:

X Positions Y Positions

1/6 0/12

1/6 2/12

2/6 2/12

2/6 4/12

3/6 4/12

3/6 7112

46 7112

46 9/12

5/6 9/12

5/6 12/12
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Alchemy MIDI control modulators in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

You can choose one of six different modulation sources from the MIDI submenu in the
modulation rack. These are ideal for adding breath and foot controller modulations,
for example.

Set MIDI continuous controllers as modulators in the modulation rack

1. In Alchemy in Logic Pro, click a slot in the modulation rack, then choose MIDI from the
pop-up menu.

2. Choose one of the following MIDI control options from the submenu:
- Pitchbend: The pitch bend wheel.
« ModWheel: The modulation wheel.
« Ctrl A (CC2 Breath): MIDI continuous controller 2 (Breath).
« Ctrl B (CC4 Foot): MIDI continuous controller 4 (Footpedal).
« Ctrl C (CC74): MIDI continuous controller 74 (General purpose).

« Ctrl D (CC75): MIDI continuous controller 75 (General purpose).

Alchemy note property modulators in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

Several properties of incoming MIDI note data, as well as values generated per-note by
Alchemy, are available as modulation sources.

Note: There is no Note Property control panel display.

Set note properties as modulators

1. In Alchemy in Logic Pro, click a slot in the modulation rack, then choose Note Property
from the pop-up menu.

2. Choose one of the following options from the submenu:
- Velocity: Modulation based on the velocity values of incoming MIDI note data.

«  KeyFollow: Modulation based on incoming MIDI note numbers. The modulation value
glides to the value of higher-pitched notes. The Glide value is determined by the
Glide parameter in the master voice section. See Alchemy master voice section.

KeyFollowFixed: As per KeyFollow, but the modulation value increases as you
play higher pitches on your MIDI keyboard. This is a bipolar source, with C3
corresponding to zero.

Aftertouch: Modulation based on channel or polyphonic aftertouch data.

Speed: Modulation based on the elapsed time between notes. A progressively slower
sequence of notes results in progressively greater modulation values.

« Held: A modulation signal that rises to full-scale immediately at note-on and falls to
zero immediately at note-off.
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«  FlipFlop: A modulation signal that is alternately full-scale and zero on
successive notes.

- FlipFlop2: Like FlipFlop, but the value reverses every two notes: zero, zero, full, full,
in a repeating pattern.

Note: The FlipFlop modulators can be used together to create a round robin involving
all four sources. To do this, set Morph mode to Morph XY or XFade XY, set the
Morph X and Y knobs to 0%, then modulate X with FlipFlop and Y with FlipFlop2 or
vice versa. See Morph controls.

- SteppedA2/3/4: SteppedA4 behaves like Stepped4, except it resynchronizes to zero
when the Arp is at the start of a pattern. SteppedA2 behaves like FlipFlop, except it
resynchronizes to zero when the Arp is at the start of a pattern. SteppedA3 is similar
to Stepped4, except with three steps.

Stepped4/8/16: Similar to FlipFlop, but cycles between the number of values (4, 8, or
16) at each subsequent note-on. Steps are spaced at equal increments, starting from
a value of zero. If you need further control, you can use a ModMap to define values
for each step. See ModMap parameters.

« Random17-4: Modulation based on a fixed random value per note. This is a unipolar
source with values ranging from zero through full-scale. The four random sources
are independent of each other.

«  PitchBend: Modulation based on MIDI pitch-bend messages. This is a bipolar source
with values ranging from negative full-scale through positive full-scale.

Max: Modulation based on a constant full-scale value.

Polyphony: A modulation signal that is larger when there are more notes playing

and smaller when there are fewer notes playing. Technically, the current number of
played notes is divided by the total polyphony. This parameter may be useful for
reducing volume when lots of notes are played. Polyphony is determined by the Num
parameter in the master voice section. See Alchemy master voice section.

« ArpMod A/B/C/D 1-2: Assign parameters for arpeggiator control.

The assigned parameters are controlled by the arpeggiator. The Poly Mod 1 and

Poly Mod 2 pop-up menu assignments in the arpeggiator correspond to these
parameters. When the arpeggiator is in All mode (denoted by the A), one arpeggiator
is used for all sources. When you use multiple arpeggiators to control individual
sources, Poly Mod options A/B/C/D are shown in the Note Properties pop-up menu.
See Arpeggiator sequencer controls.

Alchemy perform control modulators in Logic Pro for Mac

Modulation components are shown only in advanced view. Click the Advanced button to
switch to advanced view.

You can choose one of sixteen different modulation sources from the Perform submenu
in the modulation rack. These correspond to the eight assignable knobs, two X/Y control
squares, and four envelope knobs shown in the Perform section.
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Set performance controls as modulators in the modulation rack

1. In Alchemy in Logic Pro, click a slot in the modulation rack, then choose Perform from
the pop-up menu.

2. Choose one of the following Perform section control options from the submenu:
« Control 1-8: Assignable knobs, numbered 1-8.
« XYPadi1X: The X (horizontal) axis of the left XY control square.
« XYPad1Y: The Y (vertical) axis of the left XY control square.
«  XYPad2X: The X (horizontal) axis of the right XY control square.
« XYPad2Y: The Y (vertical) axis of the right XY control square.
- MAttack: The Attack knob.
« MDecay: The Decay knob.
«  MSustain: The Sustain knob.
+ MRelease: The Release knob.
« ModWheel: The modulation wheel.

Your choice is immediately mapped to the chosen Perform section control.

Alchemy Perform section

Alchemy performance controls in Logic Pro for Mac

When simple view is active, or if the Perform button is on in the Perform/Arp/Effects
section in other views, the performance controls subpage is displayed.

PERFORM

X1: Morph X X2: Trip Mix

Triplet Slow & Dirty Full Gallop (’ Q ’ O Q Q
Doy Cuof  ApOciave ApMode Atack  Decay
Hollow Triplts » @ @

Tube  Resonance AmSelect A Shufle Y Ye:Trp Colour SUS8N  Release

=n

The performance controls subpage provides eight knobs, two XY pads, and a set of

ADSR envelope knobs for a total of sixteen controls. These can be assigned to modulate
parameters in the same way as other modulation sources. In addition to these assignable
controls, the Perform section has its own gain stage with a dedicated Snapshot Vol
control. Also available is the Transform pad that lets you capture morphable snapshots of
performance control settings. All performance controls are available as automation targets.

Each performance control type is discussed in the linked sections.

«  Transform pad. See Transform pad.
- Performance control knobs. See Performance control knobs.
. XY pads. See XY pad controls.

- Performance envelope controls. See Performance control envelopes.
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Use performance controls effectively

Performance controls are a custom set of controls that modify the values of key sound
parameters. You can use the Auto Assign feature, which seeks to find the most relevant
parameters of the current preset to map to performance controls. Auto Assign can often
provide a good starting point for assignments, but it is much better if you take the time to
make manual assignments.

As you explore the included sound library, you may notice that many presets have a similar
performance control layout. Some presets may require special performance controls, but
the following guidelines work well for most presets.

- Control knobs: Provide quick access to a sound’s main characteristics. You can assign
knobs to other parameters in advanced view.

Knobs 1 and 5: Often used for Delay (1) and Reverb (5) level. If other effects are
used, other effect parameters can be substituted here. Control of effects mix levels
should take priority over other parameters, assigned to Knob 1.

« Knobs 2 and 6: Often used for filter cutoff and resonance. If your preset doesn’t use
a filter, you might consider adding one in a fully open state in the Effects section.

«  Knobs 3 and 7: Often used to control rhythm or movement in a preset with LFO or
arpeggiator parameter assignments.

Knobs 4 and 8: Often used for timbre, pitch, or other source parameters.

- XY pad 1: Generally used for morphing among sources. If more than one source is used,
this XY control is the place to assign control of morphing or crossfading.

- XY pad 2: Can be used for control over additional morphing or effects parameters or for
features unique to a particular preset.

- Envelope knobs: Normally control the corresponding parameters in AHDSR 1. You can
reassign to other parameters in advanced view.

- Mod wheel: Typically linked with the most playable performance control and should
always be functional for the first snapshot. Take care with modwheel assignments to
make sure settings of 50% or lower don't cause undesirable results, such as a dropout
of the sound (from a very low minimum lowpass cutoff setting, for example). This is
particularly important if your MIDI controller has a spring-loaded joystick.

- Octave: Turn off if you want to play your sound across the entire keyboard range.

- Aftertouch: Should always be assigned to something useful for the preset.
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Alchemy Transform pad in Logic Pro for Mac

When simple view is active, or if the Perform button is on in the Perform/Arp/Effects
section in other views, the performance controls subpage is displayed.

Alchemy presets contain eight snapshots of performance control settings, numbered 1
to 8. By default, snapshot 1is selected. This is indicated by the framing box.

Filter Sequence Soft Distortion Bright Repeater Wide Open

Simple

Tight Sequence Sequence Bend Sequence Mod Sequence

KN KNS

Control2 |+ -381d8B |2
Wheel

Snap Vol

Octave

Transform pad controls

In addition to the parameters outlined, you can Control-click directly on snapshots in the
Transform pad to open a shortcut menu with a number of snapshot and other commands.
See the tasks in this section for details about use of these commands.

- Transform pad: Drag the framing box to different positions to morph between
performance snapshots in real time. The performance control knobs update,
modulating the associated parameters.

- Action menu button: Open a pop-up menu with a number of snapshot-related
commands.

< Copy Snapshot: Store all performance control settings of the selected snapshot
in a buffer.

Paste Snapshot: Paste all performance control settings from the buffer to the
selected snapshot.

Copy 1 To All: Copy all performance control settings of snapshot 1 into snapshots
2 to 8.

Clear: Capture the current performance control values and apply them directly to
target parameters, preserving the current sound. Following use of the command,
all performance control and Transform pad assignments are cleared, all controls

are reset to zero, and the knob and pad name fields are wiped.

« Randomize Snapshots: Create random performance control values for all snapshots
except the currently active snapshot.

Auto Assign All: Automatically assign all performance controls to appropriate
parameters in the current preset. This command also generates a random set

of snapshots that are derived from the settings in snapshot 1. This is the quickest
way to start with the performance controls.

Auto Assign Empty: Automatically assign all unused performance controls to
appropriate parameters in the current preset. Existing performance control
assignments are not affected, and no snapshot settings are created.
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- Snapshot Update: Enable to immediately write changes of performance control
values to the nearest Transform pad snapshot. This prevents the performance knob
from reverting to its previous position when you move a performance knob and then
move the Transform pad framing box slightly.

Tip: This parameter is on by default, but you can enable or disable it as
preferred and then save the default preset in the plug-in header to recall this
behavior in new presets.

Octave pop-up menu: Define an octave range used to switch between Transform pad
positions when you play notes within the specified range.

Rate field: Drag vertically or use the arrows to set the speed of movement
(interpolation) between snapshots when switching from a MIDI keyboard.

ModWheel pop-up menu: Assign your keyboard modulation wheel to a performance
control. This can be any knob, the x- or y-axis of pads, or the envelope controls. Set
to None to disable modwheel control of performance controls. A setting of None is
remembered between presets. See Performance control knobs, XY pad controls, and
Performance control envelopes.

Each modwheel target offers an inverted option. This is useful when using a spring-
loaded modulation wheel as it stops the target performance control from closing when
the modulation wheel is released.

Snap Vol field: Set the intensity of change from one snapshot to the next. In essence,
this sets an initial level between snapshots.

All snapshots should be approximately the same volume, with a peak level around -5dB.
You should also be mindful of relative volume levels between snapshots. For example,

a soft pad and a distorted lead could both peak at -5dB, but the lead may seem louder.

In this scenario, lower the volume of the lead, rather than increase the pad level, so that
relative volume levels seem similar between the pad and lead sounds.

Create and store a Transform pad snapshot

Unique variations should be created for each snapshot. Though the degree of variation

is up to you, the changes should be significant, rather than simple filter or effect level
changes. If your snapshots all sound like basic variations of the same sound, look at
changing your performance control assignments to make them more flexible and complex.
This will allow you to create more interesting and dynamic snapshots.

1.

In Alchemy in Logic Pro, click the Transform pad snapshot you want to use.

2. Set each of the performance controls as required.

3. Control-click anywhere on the Transform pad, then choose Store Current Snapshot from

the shortcut menu.

Note: Store Current Snapshot only applies if; Update Snapshot is disabled in the
Transform pad File pop-up menu, if the framing box is not directly aligned with
a Transform pad slot, or if you want to save the current settings to a different
Transform pad slot.
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Name or rename the selected Transform pad snapshot

Aim for a unique and descriptive name for each snapshot. Keep things simple and clear; if
snapshot 1is a bass, snapshot 2 is a pad, and snapshot 3 is arpeggiated, this should be
represented in the name. If your variations are less straightforward to differentiate, use a
name that describes the effect on the sound.

Note: Snapshot names are indexed and appear as text search results in the Browser.
Snapshot names are also passed to Smart Controls.

1. In Alchemy in Logic Pro, click the Transform pad snapshot you want to name or rename.

2. Control-click anywhere on the Transform pad, then choose Rename Current from the
shortcut menu.

3. Enter text in the highlighted text input field, then press Enter.

Replicate the selected Transform pad snapshot

1. In Alchemy in Logic Pro, click the Transform pad snapshot you want to replicate.

2. Control-click anywhere on the Transform pad, then choose Store Current Snapshot from
the shortcut menu.

3. Control-click anywhere on the Transform pad, then choose Store Snapshot > (target
snapshot) 1-8, or All from the shortcut menu.

The stored snapshot is replicated in the target snapshot. If All is chosen, all eight
snapshots are identical.

Swap a Transform pad snapshot

1. In Alchemy in Logic Pro, click the Transform pad snapshot you want to swap.

2. Control-click anywhere on the Transform pad, then choose Swap Current Snapshot from
the shortcut menu.

3. Choose the target snapshot 1-8 from the submenu.

The positions of the two snapshots are swapped.

Switch between Transform pad snapshots with your MIDI keyboard

1. In Alchemy in Logic Pro, select a MIDI note name, such as C4 from the Octave pop-up
menu below the Transform pad.

The first eight notes of the chosen octave are assigned to snapshots 1-8.
2. Press one of the assigned keys on your controller to select the corresponding snapshot.

Note: MIDI notes assigned to snapshots do not trigger Alchemy voices. Choose Off from
the Octave menu to make notes play across the entire range of MIDI note numbers.

3. Drag vertically in the Rate field to set the speed of movement between snapshots. You
may also want to adjust the Snap Vol field value to set initial levels between snapshots.
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Alchemy performance control knobs in Logic Pro for Mac

When simple view is active, or if the Perform button is on in the Perform/Arp/Effects
section in other views, the performance controls subpage is displayed.

The eight knobs can each be named by clicking in the field below a knob and typing a
name. When a custom name is assigned, auto-assign does not update the name. Delete
the performance control text to reenable auto-assigned names.

Control-click any perform knob to open a shortcut menu with a number of useful
commands. Most of these commands are also available for the Perform section
envelope controls. See Performance control envelopes.
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Performance control knob shortcut menu items

Delete Modulation: Shows a list of all targets receiving modulation from the knob.
Select an item in this list to delete the corresponding modulation assignment.

Swap With: Exchange all modulation assignments between the selected knob and any
other performance control selected from a list.

Copy Setting to all Snapshots: Updates all eight snapshots with the current value of the
selected knob, which replaces the stored value of that knob in each snapshot.

For example, if you want to set the master Sustain knob to a value of 100% in every
snapshot, turn the knob to the 100% position, Control-click it, then choose this
command to apply the new setting to all eight snapshots.

Auto Assign: Set a modulation target for the selected control and update the label.

Lock Control: Enable to prevent the Transform pad from affecting the assigned control.
This is useful when you want to automate the assigned parameter independently of the
Transform pad.

Invert Knob: Swap the minimum and maximum values of the selected performance
control and associated modulation targets. Technically, this parameter modifies the
parameter range.
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Alchemy XY pads in Logic Pro for Mac

When simple view is active, or if the Perform button is on in the Perform/Arp/Effects
section in other views, the performance XY pads controls subpage is displayed.

XY pads: Drag the handles to modulate two parameters simultaneously. The x- and y-axes
of each XY pad can be named independently by clicking the fields above or below and
typing a name. When a custom name is assigned, auto-assign does not update the name.
Delete the performance control text to reenable auto-assigned names.

Control-click an XY pad to open a shortcut menu containing similar commands for both the
X- and y-axis.

X1: Morph X X2: Seq Release

¥Y1: BP Seq ¥Y2: Seq Sustain

X/Y pad shortcut menu items

- Delete Modulation X/Y: Shows a list of all targets receiving modulation from the x- or
y-axis. Select an item in this list to delete the corresponding modulation assignment.

- Swap X/Y With: Exchange modulation assignments between the x- or y-axis and any
other performance control selected from a list.

« Copy X/Y to All Snapshots: Updates all eight snapshots with the current value of the
selected x- or y-axis, which replaces the stored value of that axis in each snapshot.

- Auto Assign: Set a modulation target for the selected x- or y-axis and update the label.

« Lock Control: Enable to prevent the Transform pad from affecting the assigned control.
This is useful when you want to automate the assigned parameter independently of the
Transform pad.
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Alchemy performance control envelopes in Logic Pro
for Mac

When simple view is active, or if the Perform button is on in the Perform/Arp/Effects
section in other views, the performance controls subpage is displayed.

There are four envelope control knobs. By default, these are linked to the corresponding
parameters in the main Alchemy level envelope (AHDSR 1), but you may reassign these
knobs to other parameters. Control-click any knob to open a shortcut menu with a number
of useful commands. See Performance control knob shortcut menu items.
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Envelope controls

Attack knob: Set the attack time for AHDSR1, or adjust the value of assigned parameter
or parameters.

Decay knob: Set the decay time for AHDSR1, or adjust the value of assigned parameter
or parameters.

Sustain knob: Set the sustain level for AHDSR1, or adjust the value of assigned
parameter or parameters.

Release knob: Set the release time for AHDSR1, or adjust the value of assigned
parameter or parameters.

Alchemy arpeggiator

Alchemy arpeggiator overview in Logic Pro for Mac

Alchemy offers a flexible and powerful arpeggiator. The arpeggiator is shown only in
browse or advanced view. Click the Browse or Advanced button to switch to either view,
then click the Arp button in the Perform/Arp/Effects section.
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The arpeggiator subpage consists of three main sets of controls.

- Basic arpeggiator controls: These buttons and knobs determine the basic behavior of
the arpeggiator. See Basic arpeggiator controls.

- Arpeggiator sequencer controls: These buttons, pop-up menus, and knobs let you
edit one or more arpeggiator sequencers. These sequencers are internal to the
arpeggiator and are separate from the main Alchemy sequencers. See Arpeggiator
sequencer controls.

- Arpeggiator menu commands: These provide a number of useful functions for managing
arpeggiator patterns. See Arpeggiator menu commands.

If you're ready to begin some hands-on experimenting, see Use the arpeggiator.

Alchemy basic arpeggiator controls in Logic Pro for Mac

The arpeggiator is shown only in browse or advanced view. Click the Browse
or Advanced button to switch to either view, then click the Arp button in the
Perform/Arp/Effects section.

The basic arpeggiator controls consist of several buttons and nine knobs.
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Basic arpeggiator controls

« All/A/B/C/D buttons: Choose the target source that is used to play the arpeggiator
pattern. See the tasks in Use the arpeggiator.

- When set to All, the arpeggiator pattern is played by all active sources.

« You can restrict the arpeggiator pattern to a single target source by setting values
for one of the A, B, C, or D arpeggiators. The other three sources, if active, respond
to incoming MIDI data with no arpeggiation.

You can also activate and create different arpeggio patterns for any combination
of the A, B, C, or D arpeggiators. When you play the keyboard, each active source
is triggered by the corresponding active arpeggiator, resulting in up to four
simultaneous (but different) arpeggiated sources.

Note: Alchemy uses separate voices to play arpeggiated and non-arpeggiated output.
Therefore, this feature requires the Num(ber) of voices to be set to at least 2 in the
master voice section. See Alchemy master voice section.

- Sync button: Turn on to synchronize the arpeggiator with the project tempo. See
Rate knob.
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Key Trigger pop-up menu: Choose an option to align the arpeggiator and host
application grid values. Incoming and playing notes snap to this value when the
host is in play mode.

Choose a value other than Off to restart the arpeggiator pattern when the first note
is struck after a pause. This allows you to create pattern variations by playing chords
on different beats in the bar and may feel more responsive. Playing legato does not
retrigger the arpeggiator.

- Choose Snap to Rate when you want to use a host application rate that differs from
available menu options.

- Choose Cycle Reset to enable or disable. This option starts the arpeggiation from
the first note each time the pattern is repeated and when the host application is
started (at step 1). Cycle Reset is enabled by default, and turned off for all existing
presets for backwards compatibility.

Mode knob: Turn the arpeggiator on and off, and determine the order in which incoming
notes are organized into a pattern. In addition to Off, you have the following choices:

Up: Plays the current notes from lowest to highest.

Down: Plays the current notes from highest to lowest.

Up/Down: Plays the current notes from lowest to highest and back again.
Down/Up: Plays the current notes from highest to lowest and back again.
As Played: Plays the current notes in the order they were originally played.
Random: Plays the current notes in a random, non-repeating order.

Chord: Plays all held notes simultaneously as a chord. The chords are retriggered
and pulse in time with the arpeggiator rate and rhythm, as determined by the
arpeggiator sequencer settings. See Arpeggiator sequencer controls.

Note: Mode is a modulation target. This lets you set a Perform knob to modulate
Mode, enabling you to turn the arpeggiator on and off during a performance.

Rate knob: Set the duration of each arpeggiator step. When Sync is on the arpeggiator
is synchronized with the project tempo, and Rate is set in bars/beats. When Sync is
off, the Rate knob sets a constant length for each step which is unaffected by project
tempo changes.

Octave knob: Determine if the arpeggiator pattern is played only at its original pitch or
across higher octaves when the pattern is repeated.

Length knob: Set the length of each arpeggiated note. At the maximum setting of 100%
the length of each note is a full step. Set the length to lower values to generate shorter
notes for a more staccato effect (if triggering a sound with a fast release time).

Pattern knob: Choose the active pattern in the step sequencer section to the right.
Sixteen different step sequencer patterns can be created and edited for each
arpeggiator. By default, all patterns are identical, so this parameter has no effect until
your patterns are edited.

Swing knob: Change the timing of the arpeggiator, moving even-numbered steps to
later positions without changing the timing of odd-numbered steps. This can add a
more relaxed feel or groove to the part. Swing generally works best when combined
with a Rate knob setting of 1/4 of a beat (16th note swing feel) or a Rate knob setting
of 1/2 a beat (8th note swing).
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« Note Vel knob: Determine how the arpeggiator handles note velocity values. Arp
sequencer 1 modulates arpeggiator Amp values by default. When Note Vel is set to a
value of 0%, the step values of Arp sequencer 1 determine the velocities of notes in the
arpeggiator pattern. When Note Vel is set to a value of 100%, arpeggiator pattern note
velocities are determined by incoming MIDI velocities. Intermediate Note Vel values
blend the Arp sequencer step values with incoming MIDI velocities.

- Split knob: Set the highest MIDI note number to be included in the arpeggiator
pattern. Notes above this value are not arpeggiated. Set to the maximum value (G8)
to arpeggiate all MIDI input.

- Latch knob: Hold the arpeggiator pattern when you lift your hands from the keyboard in
Hold or Add mode. Set to Off to stop the arpeggiator pattern when you lift your hands.

Hold: Newly played notes are organized into a new pattern, which replaces the
existing pattern.

Add: Newly played notes are added to the existing pattern.

Tip: Try combining As Played mode with the Add latch setting to create an
interactive step sequencer with up to 128 steps.

Alchemy arpeggiator sequencer in Logic Pro for Mac

The arpeggiator is shown only in browse or advanced view. Click the Browse
or Advanced button to switch to either view, then click the Arp button in the
Perform/Arp/Effects section.

The arpeggiator sequencer section is similar in functionality to the step sequencer in the
main modulation section, but with an important difference: the arpeggiator sequencer
provides multiple sequences running in parallel, each hardwired to a different arpeggiator
parameter. In addition, each arpeggiator provides a pair of Poly Mod sequencers, which
can be used to modulate synthesizer parameters via the modulation matrixes. See

Note property modulators.

You can reduce the number of steps by dragging the gray end marker to the left, or you
can increase the number of steps by dragging the marker to the right, up to a maximum
of 128 steps. If the sequence is too long to fit in the display, you can scroll through all
steps by dragging the gray scroll bar below.

Steps can be tied by clicking the link symbol below the step, which joins that step note to
the next to make one longer note.

There are two different ways to view and edit sequencer data: Step and Multi edit mode.
Click either button to choose the mode.

Step | Multi Velocity [v Off |v
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Step edit mode: In Step edit mode, you can view and edit the sequence one parameter
at a time, with step values displayed as vertical bars. Drag vertically to edit step levels.
Option-click to reset a step to zero.

' Step | Multi

In Multi edit mode, you can edit common step parameters for multiple steps.

Alchemy Arpeggiator Step edit mode parameters

Edit Mode buttons: Use the Step or Multi button above the to choose the sequencer
view and edit mode.

Target pop-up menu: Choose the parameter to view and edit.

Velocity: These values set the velocities of notes generated by the arpeggiator,
assuming the Note Vel knob is not set to 100%. Set a step value to zero to create
a rest. No note is played on that step.

Tune: These values determine tuning offsets for each step in semitones.

Pan: These values set the pan position of individual notes: drag up to pan the note
left, or down to pan right.

Swing: These values determine timing offsets that make individual steps play
early or late. The Swing sequence and the Swing knob can be used at the same
time, allowing you to add a basic shuffle feel with the Swing knob, then fine-tune
individual notes with the Swing sequence.

Length: These values set the note length for each step. Steps with zero length do
not play. The Length knob globally scales the durations of all steps, but you can
refine these lengths with the Length sequence. Try setting even-numbered steps
shorter than odd-numbered steps, for a funky, groovy feel.

Arp Mod 1-2: Use these general purpose sequences to modulate any of the main
synthesizer parameters: ArpMod 1-2 is available as a modulation source. See Note
property modulators.

Value Snap pop-up menu: Set a value that automatically snaps edits you make to
sequence steps. For example, set to 1/3 to limit edits to 100%, 66%, 33%, or zero
values. Off disables quantization, which lets you set step values freely.

Note: Value Snap doesn’t move existing step values into alignment with quantized
positions; it only affects the response of step values when you move or create them
in the step editor.

Scroll bar: Drag the middle of the scroll bar to view steps that are not visible in the
display area.
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Alchemy Arpeggiator Multi edit mode parameters

- Gate On buttons: Turn individual steps on or off. These buttons actually display the
Velocity sequence values, with any step value greater than zero displayed as on.
Switching to Multi edit mode from Step edit mode does not change existing Velocity
seguence values. However, if you turn off a step in Multi edit mode, then turn it back
on, that step is set to 100% rather than its previous value.

- Tie buttons: Perform the same function as the tie buttons under each step in step mode:
the step is tied to the next to make one longer note.

Note: Any Velocity sequence value greater than zero is ignored for the subsequent tied
step, as is the Pan sequence value. Pitch offsets work for the tied steps, however, so
you can create pitch glides over tied steps by adjusting the Glide value in the master
voice section, setting the Num(ber) of voices to 1, and setting the voice mode to
Legato. See Alchemy master voice section.

- Tune fields: Drag vertically to set tuning offsets for each step in semitones. Double-
click to reset the offset to zero.

- Pan knobs: Set panning offsets for each step. Double-click to reset the offset to zero.

- Scroll bar: Drag the middle of the scroll bar to view steps that are not visible in the
display area.

Alchemy arpeggiator menu commands in Logic Pro for Mac

The arpeggiator is shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Arp button in the Perform/Arp/
Effects section.

File button: Opens a pop-up menu with a number of useful arpeggiator pattern
management commands.

Alchemy Arpeggiator file menu items

- Preset: Choose from a submenu of preset sequencer patterns.

«  Save: Save the current sequencer pattern as a new preset.

- Copy: Copy the current sequencer pattern to the Clipboard.

- Paste: Paste a pattern from the Clipboard to the selected sequencer pattern.
- Clear: Reset the selected sequencer pattern to default values.

+ Randomize: Fill the currently visible pattern with random values.

« Import MIDI: Import note, velocity, and timing information from a monophonic pattern,
and set the Pitch, Velocity, and Swing sequence values accordingly.

Use the Alchemy arpeggiator in Logic Pro for Mac

The arpeggiator is shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Arp button in the Perform/Arp/
Effects section.

Follow the steps outlined in the tasks to use the Alchemy arpeggiator.
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Turn the selected arpeggiator on or off in Alchemy

In Alchemy in Logic Pro, click the All/A/B/C/D button to select an arpeggiator in the
Arpeggiator section, then do one of the following:

- Set the Mode knob to any value other than off to enable the arpeggiator. Set the
Mode knob to Off to stop the arpeggiator.

- Set the Latch knob to any value other than off to enable the arpeggiator. Set the
Latch knob to Off to stop the arpeggiator.

- Stop the Logic Pro transport.

Create classic arpeggiator patterns in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Click the Arp button to show the arpeggiator section. All is selected by default.

Turn the Mode knob to select Up, Down, Up/Down, or Down/Up mode.

Play a chord and hold it: the individual notes of the chord are arpeggiated with regular
8th notes.

. Try one or more of the following:

Set the Rate knob to 1/16 to create 16th note arpeggios instead of 8th notes.

Set the Octave knob to 2 or 3, so the pattern is transposed up by octaves before
repeating at the original pitch.

« Adjust the Swing knob to add a swing feel. Note that this knob is capable of
extreme settings, so use lower values for a normal swing feel. Values around
25% result in a strong swing feel. Values of 10% or lower result in a subtle,
relaxed feel to the groove.

Set the Latch knob to Hold to make the arpeggio continue cycling after you release
the keys.

Experiment with Trigger mode. With Trigger turned on, the arpeggiator feels more
responsive and allows you to deliberately restart the pattern with your playing. It
also allows you to play out of time with the rest of the project.

Create an octave bouncing bassline in Alchemy

1.

o r 0N

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Click the Arp button to show the arpeggiator section. All is selected by default.
Turn the Mode knob to select Up, Down, Up/Down, or Down/Up mode.
Set the Octave knob to 2.

Play single notes in the lower registers: each note bounces up and down one octave,
with an 8th note timing.

Rotate the Length knob to change note lengths. Higher settings result in a more legato
feel, while lower settings create shorter staccato notes.
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Arpeggiate multiple sources with different settings for each in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Click the Arp button to show the arpeggiator section. All is selected by default.
Click the A button at the top left of the arpeggiator.

This switches the display to show settings for the source A arpeggiator. You can have a
separate arpeggiator for each source instead of the single global arpeggiator available
in All mode.

Turn the Mode knob to enable the source A arpeggiator, then play a chord, and adjust
the Rate and Octave knobs to suit.

Turn on source B. Switch to advanced view if required.
Click the B button at the top left of the arpeggiator.

This switches the display to show settings for the source B arpeggiator. The settings
you made for the source A arpeggiator are not changed.

Turn the Mode knob to enable the source B arpeggiator, then play a chord, and adjust
the Rate and Octave knobs to suit.

Choosing a different mode results in source A and B alternately playing in unison or
playing intervals from within the chord you play. Try setting one of the arpeggiators

to Random mode to add a level of unpredictability. Choose different Rate settings to
change the playback timing of sources. Try combining a straight timing for one source
with a triplet or dotted timing for another to create complex polyrhythms.

Repeat steps 5-7 for sources C and D if you require additional arpeggiated sources.

Note: You need at least four note polyphony to hear all four arpeggiated sources at
once. See Alchemy master voice section.

Create a more complex arpeggiator pattern using the sequencer section
in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Click the Arp button to show the arpeggiator section. All is selected by default.

Turn the Mode knob to select Up, Down, Up/Down, or Down/Up mode.
Click the Step button to switch to Step edit mode, then choose Velocity from the
pop-up menu.

Adjust step levels for the Velocity sequence to introduce volume changes. Try turning
down all even numbered steps for a groovier feel, or Option-click specific steps to
disable them, thus creating a rest for that step.
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6.

Choose Length from the pop-up menu to display the length sequence. Experiment with
shorter or longer notes for different steps: try lengthening odd numbered steps and
shortening even numbered steps to enhance the groove.

Try tying a step to the next step by clicking the link symbol at the bottom. Experiment
with tying different steps to generate different rhythms and with tying multiple
subsequent steps to create a long note that spans several steps.

Create a step sequencer style pattern with pitch glides in Alchemy

1.

10

1.
12.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Click the Arp button to show the arpeggiator section. All is selected by default.

Turn the Mode knob to select Up, Down, Up/Down, or Down/Up mode.

Set the Rate knob to 1/4. You can also choose to use a small Swing knob value to create
a looser feel.

Click the Multi button to switch to Multi edit mode.

Turn off several steps in the top Gate row to create a different rhythmic pattern.
As an option, you can also adjust the Pan knobs to position steps left or right in
the stereo field.

Click buttons in the Tie row to tie two or more steps.

Drag vertically in a Tune field for one of your tied steps. This results in a pitch change
partway through the note. Values of +/- 12 semitones can work well to produce octave
shifts up or down, but other values can also produce useful results: try +7 semitones
for example, or -2.

Switch to advanced view if required, then click the Global button, and set the Num(ber)
of voices to 1 to create a monophonic preset. See Alchemy master voice section.

.Set the voice mode to Legato.

Click the Time button to set the Glide mode.

Set a small Glide knob value, such as 50ms or lower, to introduce pitch glides for tied
and detuned steps. This results in smooth, rather than jarring, pitch transitions.

Create synchronized rhythmic pulsing chord patterns in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Click the Arp button to show the arpeggiator section. All is selected by default.

Turn the Mode knob to Chord.

Set the Rate knob to 1/4. You can also choose to use a small Swing knob value to create
a looser feel.

. Click the Multi button to switch to Multi edit mode.
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6. Turn off a significant number of steps to make the pattern simpler. For example, enable
only steps 1, 4, 7, 10, 13, and 15 to create a triplet polyrhythm.

7. Choose Off in the Trigger pop-up menu to prevent the arpeggiator from retriggering
when you play a chord.

8. You can choose to perform similar operations on further patterns, chosen with the
Pattern knob. Use different values for each pattern to create complex polyrhythms.

9. As a further option, Control-click the Pattern knob, then choose Add Modulation from
the shortcut menu, and link it to one of the performance controls. This lets you use the
assigned performance control to switch between patterns while playing.

Alchemy effects section

Alchemy effects overview in Logic Pro for Mac

Effect modules are shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Effect button in the Perform/
Arp/Effects section.

The Alchemy Effects section houses a powerful multi-effects processor that provides five
independent effects racks: Main, A, B, C, and D. Each rack allows you to insert chains of
effects. The signal flows through inserted effects from the top to the bottom of each rack.
You can achieve different sonic outcomes by changing the order of effects in each rack.

- Individual sources (post source filters, if used) can be routed to the A/B/C/D racks. See
Source master controls and Source filter controls.

- The main filters can be independently routed to the Main/A/B/C/D racks. See
Main filter controls.

Output from the Effects section is mixed with the dry output signal from the main or source
filter modules before being sent to the Alchemy main outputs.
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For each effect loaded in each effects rack, there is a corresponding control panel shown
in the area to the right. The top-to-bottom order of the selected rack is shown from left-to-
right in the control panel area. Drag the gray scroll bar to view effects units or parameters
that are not visible in the control panel area.

Effect control panels display a variable combination of buttons, knobs, displays, menus,
and fields that are specific to the effect. Many effect control panels also include a File
button that opens a pop-up menu with Load, Save, Copy, Paste, and Clear commands.
These menu commands apply to the settings of the individual effect.

Note: The Clear command available in plug-in control panel menus restores default settings
for the effect. It does not bypass the effect or remove it from the effects rack.
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See the linked sections for information on individual effect parameters.

- Dynamic and utility effects
- Filter effects
- Modulation effects

- Reverb effects

Alchemy Effects rack parameters

- Main/A/B/C/D rack buttons: Use Main to view and set global effects settings for the
overall instrument sound. Use A/B/C/D to set independent effect chains routed from
each source or the main filters. It is possible to route both the main filter outputs and
individual source outputs into the same effects rack.

- Effect on/off buttons: Bypass or enable each effect slot in the selected effects rack.

- Effect slots: Load an effect type from the pop-up menu. None removes an effect. Drag
an effect name to move it to another slot.

A further effects slot is automatically created when an effect is inserted.

When you an insert an effect in a slot that already contains an effect, the existing
effect is replaced.

« Choose None from the pop-up menu to remove an effect. The slot is bypassed and is
not removed.

- When you drag the name of an inserted effect to a different slot to move it;
preceding or following effects are moved up or down the list surrounding the target
slot to preserve the order of the effects chain.

«  File pop-up menu: Open a pop-up menu with several commands you can use for
the selected effects rack (Main, A, B, C, or D). Commands do not apply to all racks
simultaneously.

The Load, Save, Copy, and Paste commands apply to the entire contents of the
selected effects rack and to the settings of each loaded effect.

- The Clear command removes all loaded effects in the selected effects rack.

- The Randomize command randomizes the settings of all currently loaded effects in
the selected effects rack.

- Scroll bar: Drag vertically to view effects rack slots that are not currently visible. The
scroll bar is shown only when the number of assigned slots exceeds the effects rack
display area.

Alchemy dynamic and utility effects in Logic Pro for Mac

Effect modules are shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Effect button in the Perform/
Arp/Effects section.

Effects in this group are used to control the level or stereo position of the signal.
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Alchemy Amp effect parameters

Allows for a variety of auto-gate effects when modulated by an LFO or sequencer.

«  Gain knob: Use a setting of 100% to preserve the input signal level. Lower values reduce
this level, all the way to silence at 0%.

Alchemy Panner effect parameters

Allows for a variety of auto-pan effects when modulated by an LFO or sequencer.

- Pan: Low values boost the left and cut the right channel; high values boost the right and
cut the left. At 50% the balance between left and right input channels is preserved.

Alchemy Phat Compressor effect parameters

Dynamics processor based on a soft-limiting compression algorithm.

- Amount knob: Set the amount of compression. Make-up gain is built in, so more
compression results in greater apparent loudness.

- Release knob: Determine how quickly the compression effect subsides once the input
signal falls below the threshold.

- Phat button:Add a saturation effect, for a different compression color. Turn off for more
neutral/transparent compression.

Alchemy Vintage Compressor effect parameters

Dynamics processor based on analog compression hardware.

- File button: Open a pop-up menu with several useful commands and to access presets.
«  Presets: Choose a preset from the submenu.

- Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

«  Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

Clear: Reset all parameter settings to default values.

- Attack knob: Set the time it takes for the compressor to react when the signal exceeds
the threshold level.

- Release knob: Determine how quickly the compression effect subsides once the input
signal falls below the threshold value.

- Threshold knob: Set the threshold level. Signals above this threshold value are reduced
in level.

- Input Gain knob: Set the level of gain applied to the signal at the compressor input.
- Ratio knob: Set the ratio of compression when the signal exceeds the threshold value.

- Makeup Gain knob: Set the amount of gain applied to the compression signal at the
compressor output.
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Alchemy filter effects in Logic Pro for Mac

Effect modules are shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Effect button in the Perform/
Arp/Effects section.

Effects in this group change the frequency content of the signal.

Alchemy Bandpass Filter effect parameters

An adjustable width bandpass filter. The rejected portion of the signal can be recovered at
a later point in the signal path by using the Band Reject effect.

« Low Cut/High Cut knobs: Set the lower and upper boundaries of the passband.

+ Low Res/High Res knobs: Add resonant emphasis to the passband boundaries.

Alchemy Band Reject Filter effect parameters

Available only when the Bandpass Filter1/2 is inserted earlier in the signal path. Lets
you mix in the portion of the signal that was rejected by the bandpass filter. A classic
application of this feature is for multi-band distortion.

+  Mix knob: Set the amount of band-rejected signal mixed back into the signal path,
bypassing effects between the BP Filter and the Band Reject mix point.

Alchemy Bass Enhancer effect parameters

Bass-boosting EQ, recommended for use with bass and low frequency percussion sounds.
- Amount knob: Set the intensity of the bass enhancement.

- Tune knob: Determine the frequency band to which the boost is applied.

- Phat button: Add a saturation effect, for a different color to the bass enhancement. For
more neutral/transparent results, leave phat mode off.

Alchemy Distortion effect parameters

Distortion effect with multiple algorithms that can be used simultaneously.

- Bitcrush knob: Use for a lo-fi digital distortion.

- Mech knob: Use to produce a nastier, more intense distortion.

- Tube knob: Use to simulate the warm distortion effect of an overdriven tube amp.
- XCite knob: Use to create distortions with an enhanced high-frequency range.

- Pre Gain knob: Set the amount of input gain applied before the distortion effect. This
enables you to produce heavily saturated distortions with some distortion types,
especially Tube.

«  Post Gain knob: Set the output level to compensate for significant signal boosts caused
by distortions such as Tube and Mech.
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Alchemy MultiMode Filter effect parameters

Provides multiple filter types that process all voices routed through the Effects section.

Type pop-up menu: Choose from dozens of different filter types. Each has a unique
characteristic. See Filter types.

Note: The knobs described are common to most filter types but not all.

Cutoff knob: Set the filter cutoff frequency.

Resonance knob: Set the filter resonance or emphasis. Higher settings boost
frequencies in the immediate vicinity of the cutoff frequency.

Drive knob: Overdrive the filter. The precise effect varies with each filter design.

Mix knob: Determine the wet/dry balance (0% = dry only; 50% = equal mix; 100% = wet
only). Typically this is left at 100%.

Alchemy Three Band EQ parameters

Offers three bands of parametric EQ. Each band, shown as F1/F2/F3 (where F denotes
frequency), has identical controls.

Gain knobs: Set the amount of boost or cut to the three frequency bands.
Freq knobs: Set the center frequency for the three frequency bands.

Note: The three frequency bands can each be set to values from 16 Hz through
to 20 kHz, so it isn't necessary (although it may be useful) to tune F2 above F1,
or F3 above F2.

Q knobs: Set the bandwidth of the three frequency bands.

Alchemy Waveshaper parameters

An EQ unit that applies a predefined filter shape. Two sets of identical controls can be used
to modify the pre-shaped and post-shaped signal.

Mix knob: Set the balance between the dry input signal and the wet effect signal.
Gain knobs: Set the amount of boost or cut to the pre- or post-filtered signal.

Shape knobs: Set the pre- or post-filter shape toward a lowpass or highpass type. The
center position has a balance of low and high filtering.

Freq knobs: Set the center frequency for the pre- or post-filtered bands.

Display: View and edit the predefined filter curve. Drag the white handles to set the
shape start, mid, and end points. Drag the line between points to create convex or
concave curves. Option-click the line to reset it to a linear shape.

Bipolar button: Turn on to use a bipolar filter curve. Turn off to use a unipolar
filter curve.

File button: Open a pop-up menu with several useful commands.
Presets: Choose a preset from the submenu.

Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

Clear: Reset all parameter settings to default values.
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Alchemy modulation effects in Logic Pro for Mac

Effect modules are shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Effect button in the Perform/
Arp/Effects section.

This group includes delay, chorus, flanger, and phaser effects.

Alchemy Delay effect parameters

Stereo delay with dual-filtered feedback.

L/R Rate knobs: Set the delay time in msec when the Sync button is off, or in beats
when the Sync button is on. See Sync button parameter below.

L/R Offset knobs: Add a small additional amount of delay, enabling you to adjust the feel
of tempo-synced delays.

L/R Feedback knobs: Determine the amount of delayed signal fed back to the input of
the delay.

Filter A/B buttons: Turn on to filter the delayed signal without affecting the dry signal.
You can use one or both filters. Select a type for each filter via the selection fields. Each
filter has Cutoff and Resonance controls.

Filter type pop-up menu: Choose a type for each filter. See Filter types.
Cutoff knobs: Set the filter cutoff frequency for filter A or B.

Resonance knobs: Set the filter resonance or emphasis for filter A or B. Higher settings
boost frequencies in the immediate vicinity of the cutoff frequency.

Sync button: Turn on to synchronize delay rates with the project tempo. See L/R Rate.

Mono button: Turn on to mix the left and right input channels down to mono. The result
is fed to both the left and the right channels of the delay. The dry portion of the signal
remains in stereo.

Crossover knob: Determine stereo placement of the feedback signal. At 0%, left feeds
left and right feeds right; at 50%, each channel is fed to both inputs; at 100%, left feeds
right and right feeds left.

Initial Pan knob: Determine stereo placement of the initial delayed signal (prior to
Feedback). Typically, you would set Initial Pan to 0% or 100% when Crossover = 100%,
and leave Initial Pan centered at 50% in most other cases.

Mix knob: Determine the Wet/Dry balance (0% = dry only; 50% = equal mix;
100% = wet only).

File button: Open a pop-up menu with several useful commands.
«  Presets: Choose a preset from the submenu.

- Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

« Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

« Clear: Reset all parameter settings to default values.
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Alchemy Modulation FX parameters

A short delay with built-in LFO modulation, useful for chorus, flanging, and related effects.

File button: Open a pop-up menu with several useful commands and to access presets.
«  Presets: Choose a preset from the submenu.

- Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

Clear: Reset all parameter settings to default values.

Delay knob: Set the base delay time. Short values are useful for flanging, values in the
range of 10 to 40 msec are useful for chorus, and longer delay times can produce a
variety of metallic and buzzing effects.

Rate knob: Set the modulation speed. Faster rates and smaller depths are characteristic
of chorus effects, while slower rates and greater depths are typical for flanging.

Mix knob: Determine the wet/dry balance (0% = dry only; 50% = equal mix;
100% = wet only).

Depth knob: Set the modulation intensity.

Feedback knob: Set the level of the delayed signal that is fed back into the input.
Medium to medium-high settings are common for flanging effects, while chorus tends
to use little or no feedback.

Stereo knob: Spread the delayed signal across the stereo field.

Alchemy Phaser effect parameters

A simple phasing effect with built-in LFO modulation.

File button: Open a pop-up menu with several useful commands and to access presets.
Presets: Choose a preset from the submenu.

Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

- Clear: Reset all parameter settings to default values.

Rate knob: Set the modulation speed. Can be synchronized with the project tempo when
Sync is enabled. See Sync button.

Depth knob: Set the modulation intensity.
Spread knob: Spread the delayed signal across the stereo field.
Frequency knob: Set the filter cutoff frequency.

Poles knob: Set the intensity of the phasing effect. Higher values result in a more
cutting and harsh phasing sound.

Tip: Where possible, try to use the minimum number of poles required because this
helps to reduce CPU load.

Feedback knob: Set the level of the delayed signal that is fed back into the input.
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Mix knob: Determine the wet/dry balance (0% = dry only; 50% = equal mix;
100% = wet only).

Sync button: Turn on to synchronize delay rates with the project tempo. See Rate knob.

Alchemy reverb effects in Logic Pro for Mac

Effect modules are shown only in browse or advanced view. Click the Browse or
Advanced button to switch to either view, then click the Effect button in the Perform/
Arp/Effects section.

Effects in this group are used to add ambience to the signal.

Alchemy Acoustic Reverb effect parameters

High quality, full-featured reverb effect.

Time knob: Set the length of the reverb tail. Values up to 20 sec are possible.
Pre Delay knob: Set the amount of initial delay before diffuse reflections begin.
Size knob: Determine the dimensions of the simulated space.

Width knob: Determine how much reflections are spread across the stereo field.
Diffusion knob: Determine the density of the early reflections.

Gate knob: Set a threshold below which the reverb tail is gated. Attack shapes the
beginning of the gated tail, while Decay shapes its end.

Attack knob: Attack shapes the beginning of the gated reverb tail.
Decay knob: Decay shapes the end of the gated reverb tail.

EQ knobs: Modify the frequency content of the wet signal. LoFreq sets the frequency of
a low shelf that you can boost or cut with LoGain. HiFreq sets the frequency of a high
shelf that you can boost or cut with HiGain.

Damping knobs: Determine the amount of frequency-specific losses (damping).
DampLoF sets the frequency of a low shelf that you can damp by increasing
DampLoAmt. DampHiF sets the frequency of a high shelf that you can damp by
increasingDampHiAmt.

Variation knob: Determine the reverb color.

Quality knob: Determine the processing precision. Use low values to conserve
CPU resources.

Mix knob: Set the wet/dry balance (0% = dry only; 50% = equal mix; 100% = wet only).
File button: Open a pop-up menu with several useful commands and to access presets.
«  Presets: Choose a preset from the submenu.

- Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

« Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

« Clear: Reset all parameter settings to default values.
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Alchemy Classic Reverb effect parameters

CPU-efficient reverb.

File button: Open a pop-up menu with several useful commands and to access presets.
«  Presets: Choose a preset from the submenu.

- Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

Clear: Reset all parameter settings to default values.
Pre Delay knob: Set the amount of initial delay before diffuse reflections begin.
Damping knob: Determine the amount of high frequency loss in the reflections.
Hi/Lo Cut knobs: Set high and low frequencies. The wet signal above and below is cut.

Size knob: Determine the dimensions of the simulated space. Larger values equal longer
reverb times.

Mix knob: Determine the wet/dry balance (0% = dry only; 50% = equal mix;
100% = wet only).

Alchemy Convolution Reverb effect parameters

A high-quality reverb effect that uses recordings of actual acoustic spaces, such as caves,
tunnels, halls, and so on. These recordings are known as impulse responses. You can apply
an impulse response to your Alchemy preset which makes it sound like it is being played in
the chosen acoustic space.

Logic Pro Instruments for Mac

Dry knob: Set the level of the dry signal sent to the main outputs.
Wet knob: Set the level of the effect signal sent to the main outputs.
PreDelay knob: Set the amount of initial delay before diffuse reflections begin.

Size knob: Determine the dimensions of the simulated space. Larger values equal
longer reverb times.

Stereo knob: Set the output width of the convolution. When set to 100%, the output
width is dictated by the impulse response sample. When set to 0%, it is equivalent to
convolving with a mono version of the stereo impulse.

Start knob: Determine the start point of the loaded impulse response.
End knob: Determine the end point of the loaded impulse response.

Tip: Where possible, try to use the shortest possible impulse response length
required because this helps to reduce CPU load. If you change the IR length, you will
need to adjust the envelope shown in the Impulse response display.

Impulse response display: View the loaded impulse response waveform. An editable
level envelope is superimposed over the waveform.

Drag the envelope points to set levels over the duration of the impulse response.
Click on or near the envelope line to create new points.

Double-click a point to delete it.
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- IR pop-up menu and field: Load an impulse response (IR). Use the arrows to step
forward and backward through impulse responses.

+ File button: Open a pop-up menu with several useful commands and to access presets.
« Presets: Choose a preset from the submenu.

- Save: Open a dialog where you can name and save the current settings to a new
preset. The saved preset name is shown at the bottom of the Presets submenu list.

Copy/Paste: Copy the current settings to the Clipboard and paste the
Clipboard contents.

Clear: Reset all parameter settings to default values.

Note: The impulse response file is not loaded, saved, or copied and pasted. File
menu commands affect only the parameter settings.

- Reverse button: Reverse playback of the loaded impulse response.

- On/off buttons: Enable or disable either integrated filter module.

- Filter type pop-up menus and fields: Choose the filter type. See Filter types.
- Cutoff knobs: Set the cutoff frequency for each filter.

- Resonance knobs: Set the resonance or emphasis for each filter. Higher settings boost
frequencies in the immediate vicinity of the cutoff frequency.

Alchemy extended parameters in Logic Pro for Mac

Alchemy provides additional parameters that are accessed by clicking the disclosure arrow
at the lower left of the interface.

Extended parameters

« MIDI Mono Mode pop-up menu: Choose Off, On (with common base channel 1), or On
(with common base channel 16).

In either mode, each voice receives on a different MIDI channel. Per voice channels
support pitchbend, aftertouch, modwheel, and Performance control assignment
messages. See Performance controls overview. Controllers and MIDI messages sent on
the base channel affect all voices.

+ Mono Mode Pitch Range slider: Set a value from 0 to 96.

The chosen pitch bend range affects individual note pitchbend messages received on
all but the common base channel. The default is 48 semitones, which is compatible
with the GarageBand for iOS keyboard in pitch mode. When using a MIDI guitar, 24
semitones is the preferable setting because most guitar to MIDI converters use this
range by default.
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Alchemy tutorials

Alchemy tutorial introduction for Logic Pro for Mac

The following sections contain information to assist you as you start to explore sound
creation in Alchemy.

Given the flexibility and variety of Alchemy synthesis engines, you can take a number of
different approaches to sound design.

- If you prefer to tweak existing settings, it may be more suitable to use features that
affect the entire instrument. At the simplest level this is achieved with performance
controls such as the Transform pad. See Basic synthesis tweaks and Performance
controls overview.

- If you prefer to build sounds from scratch—parameter by parameter—you can. See
Alchemy source overview and Create sounds from scratch.

- Alchemy also features advanced morphing capabilities that facilitate cross-synthesis to
create new sounds. See Elemental morphs overview.

Whatever approach you favor, you can achieve new and interesting results. Experiment and
familiarize yourself with each approach. Each has its strengths and weaknesses, and often
a combination of methods may strike the best balance for your needs.

When programming a sound from scratch in Alchemy, the best approach is to work on each
component of the sound in isolation.

To start, you need a plain vanilla setting. You can revert to this setting by choosing File >
Initialize Preset in the Name bar. The default setting is sonically uninteresting but provides
a useful starting point for several examples.

Important: Use of Initialize Preset automatically turns on wide unison mode. See Alchemy
wide unison mode.

mowe | sunz | sowce | OB I - @

Alchemy basic synthesis tweaks in Logic Pro for Mac

Alchemy provides thousands of ready-made presets for you to explore. These are not
only a great resource for musical inspiration but can also provide numerous insights into
how sound designers have created them. Even if you're not inclined to program your own
sounds from scratch, some small tweaks to existing presets can provide that “perfect”
sound for your projects or performances.

Note: Images shown in tutorials are not specific to presets used in tasks. They are included
as a guide to help you find areas and parameters in the Alchemy interface.
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Use performance and effect controls to tweak a sound in Alchemy

This task introduces you to basic operations in the performance and effect controls. This
method of interaction works in the same way across presets. These controls can have a
subtle or dramatic impact and can be used to very quickly create patch variations. If you
happen across something that sounds great while making your tweaks, don't forget to
click the Save As button at the top.

1. In Alchemy in Logic Pro, click the Preset name field in the Name bar and choose the
Analog Bass Sequence preset. Make sure the Advanced view button is active.
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2. Click the Perform button to view the performance controls, then drag the framing
bracket in the Transform pad while playing your keyboard.

The sound morphs between different sound variations. If you happen across
something you like, you can use the Save As button in the Name bar to name
and save a new preset.
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3. Drag the framing bracket to the top left (“Snappy”), then set the Decay knob to
zero and the Sustain knob to around 75%. Drag the Arp Mode knob to the leftmost
Off position.

When you hold a note on the keyboard you will hear a sustained sound with no
sequenced pattern. Adjust the Cutoff, Resonance and Tube knobs to hear how they
affect the sound.
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9.

Click the Effects button to view the Effects section, then click the Blue On buttons of all
four effects to bypass them.

Play a few notes to hear the impact this has, then click the gray On button to re-enable
the Multimode Filter plug-in.
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Choose the Formant option in the Multimode Filter Type menu.
Click the On button for the Delay plug-in and play a few notes to hear the effect.

Choose any preset from the File menu in the Delay effect interface. Drag the gray scroll
bar at the bottom of the Effects section if the Delay effect isn't visible.

. Return to the performance controls, and adjust the Resonance and Cutoff knobs while

playing both staccato and held notes.

Drag the blue control points in both XY Pads while striking a note to hear their impact.

10. Double-click both the Resonance and Cutoff knobs to set them to the zero position.

Swap the source to tweak a sound in Alchemy

1.

In Alchemy in Logic Pro, click the Global button toward the upper left to view sources
A to D.

You can see that the Analog Bass Sequence preset uses four sources: A, B, C and D.

. Click the source select field for both source A and source B, then choose Load VA >

Simple > Triangle in each.

Play your keyboard to hear a more mellow synth type sound. Feel free to repeat this
step with sources B and C, using different waveforms, or perhaps import a sample.

Square

Tune

Additive
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Mute a source to use a partial preset in Alchemy

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset, then choose the Analog Bass Sequence preset from the Preset name field. Make
sure the Global button is active in advanced view.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Click both the source A and source B buttons to mute these sources. A blue A, B, C, or
D button indicates the source is active.

Play the keyboard to hear a very different sequenced sound which emphasizes the
interaction between Additive source C and the Saw used for source D. You can click the
C and D source buttons, in turn, to hear them in isolation. It may surprise you to hear
what they sound like individually.

Tip: Muting sources in this way is also a good working practice when editing or
adjusting source settings because it allows you to focus on the sonic characteristics
you are trying to achieve for the source. You can unmute the source and adjust
the Volume settings of each to set the balance between them once you’ve made
your changes.

Tune

Additive

Tune Pan

3. Click the Perform button to view the performance controls, then drag the framing
bracket in the Transform pad while playing your keyboard.

You will hear the sound morphing between different sound variations. If you happen
across something you like, you can use the Save As button in the Name bar to name
and save a new preset. Return the framing bracket to the "Snappy” position when done.

Filter Sequence Soft Distortion Bright Repeater Wide Open

Simple

Tight Sequence Sequence Bend Sequence Mod Sequence
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Octave

Rate Whea!
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Adjust the tuning and envelope of a source in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset, then choose the Analog Bass Sequence preset from the Preset name field.
Make sure the Global button is active in advanced view.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Drag the source B Tune knob to -24 semis.
Click the source B Vol knob.

The AHDSR envelope updates in the central modulation section.

AHDSR SEQUENCER  ENV FOLLOWER MODMAP Show Target

Double-click the source B Pan knob to center it.

In the central modulation section, make sure the Attack, Hold, and Decay knobs are set
to zero, set Sustain to around 80%, and Release to around 0.032. You may also want to
experiment with adjustments of the Decay and other knobs in the performance controls
section to hear their impact.

QQ

Attack  Decay
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Sustain  Release
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Adjust filters to tweak a sound in Alchemy

1. In Alchemy in Logic Pro, change the filter 2 Cutoff and Resonance settings in the main
filter section to the right of the sources while playing.
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2. Click the Filter type menu to experiment with different filters.
3. Enable filter 1, and try different settings.

4. Adjust the Par/Ser knob to hear how this affects the sound when the filters are used in
series or in parallel.

Drag the framing bracket in the performance controls to hear variations of your
tweaked sound.

Recycle sources and sound settings from other presets in Alchemy

This is less of a tweak and more of a shortcut for sound creation. Alchemy provides
thousands of presets that can be partially used for new sounds, sequences, modulation
settings, arpeggios, effects settings, and more.

1. In any loaded Alchemy preset, click the source name field and choose Save Source from
the pop-up menu.

2. Give the source a name in the file dialog, and click Save.
This source is automatically saved in the Alchemy > Source subfolder.

3. In a new instance of Alchemy, click the Source select field and choose Load Source
from the pop-up menu, then choose the saved source.

The source (or sources) from up to four presets can be recycled in this way.

4. Steps 1-3 can be repeated for any Alchemy element that provides a File pop-up menu,
such as modulation settings, arpeggiator settings, effects settings, and so on.

Make use of existing presets as sources of raw material for your own sounds.

Create Alchemy sounds from scratch in Logic Pro for Mac

Alchemy provides a number of different synthesizer engines that can be used to
resynthesize, or reconstruct, imported sampled sounds. It does this by analyzing sonic
characteristics of the source, such as level, frequency, phase, and other components. This
analysis is then mapped to values that are reconstructed by one or more of the synthesis
engines. Details on importing and analysis of source material are covered in Import browser
and in individual source sections. See Source elements overview.
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Alchemy also allows you to use several of the built-in synthesizer engines to create sounds
without sample importing and analysis. This section explores these pure synthesis options
and other approaches to creating the basic building blocks of your sounds.

Once you have added the raw material to your sources, Alchemy'’s filters, modulation, and
Effects sections are available to further refine your sound. See the information and tasks

outlined in these sections: Main filter controls, Alchemy modulation overview, and Alchemy
effects overview. Also look at the Performance controls overview and Alchemy arpeggiator
overview sections.

Note: Images shown in tutorials are not specific to presets used in tasks. They are included
as a guide to help you find areas and parameters in the Alchemy interface.

Explore pure additive synthesis in Alchemy

Pure additive synthesis allows you to create sounds by combining sine wave harmonics

and overtones (or partials) of different levels, phase, pitch, and pan position. If you're
unfamiliar with this method of synthesis, see Additive edit window overview and
Additive synthesis.

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See

Alchemy wide unison mode.

Click the A button (below Global) to view source A parameters.

This defaults to the VA (Virtual Analog) synthesis engine. Play a few notes to hear

the sound.

Click the Additive button, just below the File button in the Name bar, then click the

Additive On button to enable the additive engine.

Double-click the Additive Vol knob to reset the level, then play a few notes to hear

the sound.
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4. Click the Edit button to the left of the realtime spectrogram (waveform) display.
The main edit window opens.

Inspector, global, group,

Iand zone controls
T 1

- Keymap editor

LLLALRLLNLALUALRLENALLRLR LRI AERLIOLLY

Loop XFade

1
E

lZone waveform editor

5. Click the Additive button to view the additive edit window, where the Vol button should
be active and a single column is shown at the left of the Partial bar display.

This is the first (and only) harmonic of your sound.

6. Drag vertically and horizontally across the Partial bar display to create a series of new
harmonics of different levels. Create a pseudo waveform shape.

Play your keyboard to hear how this sounds. Depending on what you've drawn, you
should hear a harsh and edgy digital sound.

7. Click the Mode pop-up menu, and choose Fifth (harmonics).
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8.

10.

11.

12.

13.

Drag the first harmonic vertically to see how the fifth harmonics only are changed,
noting that the change is relative to the first harmonic.

This is how you adjust grouped harmonics. Adjusting groups of, rather than individual,
harmonics is the best approach to take when creating additive sounds. Creating and
adjusting individual harmonics is possible (using One in the Mode pop-up menu), but it
is tedious and not an efficient approach. In general terms, even harmonics sound more
musical and odd harmonics sound noisy or dissonant.

Click the Tune button, choose One (single harmonics) from the Mode pop-up menu,
then draw horizontally and vertically (creating another pseudo waveform shape) in
the Partial bar display.

Play the keyboard to hear a deranged metallic sort of sound.

Choose Fifth from the Mode pop-up menu, then drag some points vertically and
horizontally in the Partial envelope display.

Play the keyboard to hear the fifth harmonics bend in pitch, controlled by the envelope
associated with this group of harmonics.

Harmonic envelopes control the level, pitch, pan, and phase of harmonics over time.
This level of control over each harmonic (if required) enables you to recreate almost
any type of sound, but as mentioned, it is far more efficient to work with groups

of harmonics. Individual editing of harmonics or their associated envelopes is only
recommended for fixes to unwanted partials or for more impactful edits to the lower
harmonics, such as the fundamental, second, fourth, and so on. Edits of upper
harmonics are unlikely to be audible in many cases.

Close the edit window, and experiment with the Fundamental, Octaves, Odd/Even, and
Fifths knobs in the additive effects section. Also adjust the PVar and Sym knobs to hear
their impact.

On Harmonic v On Beating \ On Spread

Y ’ |
’

Fundamental Octaves Amount Partial

1 A\

Odd/Even Fifths

Choose Stretch from the second additive effects pop-up menu, and experiment with the
Stretch and String knobs.

As further steps, you may also want to Control-click different Additive controls to assign
modulation routings. Try assigning a modulation sequencer to the String parameter in
the additive effects section to create a stepped sample-and-hold type of sound. You
can use a File menu preset for the sequencer or create your own sequence.

If you want to take the modulation sequence concept further, you could create a
sequence of individual harmonic pitches, resulting in a melody. Similarly, you could
sweep a comb filter across the harmonic series, again resulting in a melody.
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Explore VA synthesis in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Click the A button (below Global) to view source A parameters.

This defaults to the VA (Virtual Analog) synthesis engine. Play a few notes to hear
the sound.

ADDITIVE GRANULAR SAMPLER

Low Cut High Cut

Choose several waveforms from each category in the source select field, and play the
keyboard each time to hear the sound.

Alchemy has dozens of waveforms to choose from, providing a wealth of raw source
material. Once you've explored the options, choose Complex > Soft Edge. This
resembles a cheap electronic keyboard piano sound.

Turn on filter 1 in the source parameters at the left, and double-click the Cutoff knob.

Play to hear a much mellower, more electric piano-like sound. Feel free to try different
filters, but LP 12dB Smooth is a good option.

Click the Global button at the top left, then click the Master Vol knob.

Adjust the Release knob to a value around 1.00 in the central AHDSR envelope section.

Always

Glide
Rate Time

165



6. Click the Effects button at the lower left to view the Effects section.
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7. Choose Mod FX in the top effects slot, then click the Mod FX File button and choose
Preset > Big Chorus.

You may want to adjust the Rate to around 2.8 Hz.

8. Choose Phaser in the second effects slot, then click the Phaser File button and choose
Preset > Subtle Vibrato.

Turn on the Sync button, then play to hear a simple, effected electric piano sound
that is created from a single source. It goes without saying that this sound could be
improved in many ways, but this primer should give you a feel for how quickly a basic
preset can be created in Alchemy’s VA engine. Keep the sound you've created for the
next task.

Combine synthesis methods to create sounds in Alchemy

Alchemy provides up to four sources in a preset. Each source has a full set of synthesis
parameters associated with the chosen synthesis engine. This allows you to combine
multiple synthesis types, such as virtual analog, additive, resynthesis, granular, or straight
sample playback in a single preset. Because each synthesis method has different strengths
and weaknesses, it is both easier and will deliver better results if you choose the most
appropriate engine for the task.

Though there are areas of crossover between synthesis engines, the VA engine is strong
for synthesizer type sounds, the additive engine is strong for digital and bell-like sounds,
and the sampler/granular engines are best suited for sample manipulation, with the latter
being particularly useful for loop mangling.

Alchemy also offers resynthesis which uses the additive or spectral synthesis engines, or
a combination of the two, along with optional formant control. Resynthesis, put simply,
analyzes a source audio file and reconstructs a facsimile of this sound using sine waves
and noise signals. You can then manipulate these reconstructed elements to create

new presets. The additive engine is well suited for single notes with a strong harmonic
character. The spectral engine is suitable for chordal material and other complex signals.
In many cases, you will achieve the best results by combining the two synthesis engines.
This lets you manipulate the resynthesized source more precisely, playing to the strengths
of each synthesis method.
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In Alchemy in Logic Pro, choose advanced view and click the source B select field, then

choose Import Audio from the pop-up menu to open the Import browser window.

Analysis Mode

Additive  Spectral | AddeSpec Granular  Sampler

Formant

. Click the Preview button to enable or disable automatic preview of selected files.

. Click the Sampler button to choose the import analysis mode.

If the audio data is imported to the additive, spectral, add+spectral, or granular
elements, analysis may take a moment or two. No analysis occurs when the Sampler
analysis mode button is active.

. Choose Alchemy Samples > Strings > Single Samples > Strings Mid, then click the

Import button.

The Import browser closes when the import is complete, and the previous window
is displayed.

. Click the Global button (if not active), then adjust the Vol knobs of source A and B

to hear an electric piano/string layer.

. Repeat for sources C and D, using different analysis modes and the same or

different samples.

An import progress dialog is shown when import methods other than Sample are used.

The Import browser automatically closes when the import is complete.

Click the source select buttons at the left for sources B, C, and D, then click the
Additive, Spectral, Pitch, Formant, Granular, and Sampler buttons at the upper
right to view the parameters of each synthesis engine.

SPECTRAL PITCH FORMANT VA
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8. Listen to each source in isolation, and experiment with these synthesizer engine
parameters to get a feel for what each engine provides for imported material.

The use of different synthesis engines enables different kinds of manipulation options
for each source, providing different sonic characteristics. Beyond the comparatively
simple combining of sources and synthesis engines in this way, you can perform a
sophisticated form of cross-synthesis with Alchemy morphing features. See Elemental
morphs overview.

Alchemy elemental morphs overview in Logic Pro for Mac

Most people are familiar with the concept of morphing images and 3D graphics. We've

all seen the videos of a human face morphing from one face to another, or transforming
from a young to an older version of the same face. The idea of morphing between sounds
commonly involves transitioning between the filter values, envelope shape, or amount of
reverb for each sound. The Performance controls in Alchemy, particularly the Transform
pad, allow this type of parameter morphing, often moving between multiple synth and
effect settings simultaneously to produce dramatic changes to the sound.

Alchemy can also perform a deeper and more powerful form of morphing referred to as
elemental morphing. Elemental morphing is an advanced form of morphing that operates at
the sound generation level, making it possible to combine core characteristics of different
sounds, technically referred to as cross-synthesis. It allows new sounds to be created by
mixing and matching elements from multiple source sounds. Elemental morphing expands
the possibilities for creative sound design well beyond what is possible with the parameter
morphing described in the paragraph above.

The Alchemy additive, spectral, granular, and formant synthesis engines are key facilitators
for this type of morphing. Each synthesis method has inherent strengths and weaknesses,
making them more suitable for certain sound types than other synthesis engines. Having all
of them available in Alchemy makes it a unique and powerful morphing tool. Another critical
component for elemental morphing is Alchemy's ability to reconstruct audio using these
synthesis engines; a process called resynthesis. Resynthesis makes it possible to perform
elemental morphing on any audio because it creates a synthesized facsimile of the original
sound that affords more manipulation options than a static sample. Without resynthesis,
elemental morphing would be limited to sounds built from scratch within Alchemy.

Successful morphing depends on developing an understanding of which engine is best
suited for the type of audio material you are working with. Your choice also affects the
type and number of sound shaping options available. Morphing is a complex process with
many variables that can impact on the results. As with any form of synthesis, the more
you work with it and the more familiar you become with its strengths and weaknesses,
the easier and faster it is to create sounds you have in mind.

See Morph use and tips, Morph drum beats, and Morph melodic sounds.

Note: Images shown in tutorials are not specific to presets used in tasks. They are included
as a guide to help you find areas and parameters in the Alchemy interface.
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Alchemy morph use and tips for Logic Pro for Mac

Source components are shown only in advanced view. Click the Advanced button to switch
to advanced view, then click the Morph button to view and use the morph controls. See
Morph controls.

It is important to choose the same analysis mode for all morphed sources. See
Import browser.

Though you can morph with any synthesis type, the best morphing results are achieved
with the spectral or additive engines. Spectral is the most suitable import method to use
for the majority of audio material. Use Additive or Add + Spec import mode if dealing with
pitched, monophonic sounds. Make sure the Formant button is turned on when importing
sounds because this generally results in a higher quality morph.

If you are not creating a pitched instrument that requires the root note to remain at the
default pitch, irrespective of the morph position, turn off the Fixed Pitch button, because
this will result in a higher quality morph.

The time alignment of sounds is crucial to achieving a good morph. Selecting sounds with
similar timing and loop characteristics tends to deliver the best results. Aim to have a
similar loop duration and loop location within the selected samples. If the sounds you

are morphing are comprised of more than single note samples or the timing of your
sources doesn't align as you would like, adjust the warp marker positions. See the
Manually time-aligning morphed sounds task in this section.

Morphs that move from 100% of all elements in a sound to 100% of another sound can

often be suitable for sound effects but may be more difficult to shape into new playable
instruments. You may find it better to mix the levels of individual elements for this type

of use.

Note: Images shown in tutorials are not specific to presets used in tasks. They are included
as a guide to help you find areas and parameters in the Alchemy interface.

Manually time-aligning morphed sounds in Alchemy

This task covers manual alignment of sources. Alchemy features an auto align function (see
Morph controls) that can make this an automatic process, but in some cases you may need
to manually intervene to achieve the best results.

When morphing is turned on for a source, warp markers are displayed in the zone waveform
editor. See Zone waveform editor.
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When you morph from a sound with a fast attack to one with a slow attack, Alchemy
smoothly adjusts the attack time according to the morph all position, or the envelope
position if in elements mode. Warp markers define the attack phase boundaries of each
sound. More generally, warp markers define the boundaries of a series of time-aligned
segments when two or more sounds are morphed together.

1. In Alchemy in Logic Pro, click the source select field for the active source, then choose
Import Audio from the pop-up menu.

2. In the Import browser, click the Additive, Spectral, or Granular import mode button.

Parent Folder

Analysis Mode
Additive  Spectral | AddeSpec. Granular  Sampler

Formant

3. Select the files you want to use, then click the Import button.

When you import additive, spectral, or granular data, Alchemy automatically sets warp
markers at the following positions:

The absolute start point of the sound.
The end of the attack portion.

The loop start point. If a sample does not have loop points, loop points are
automatically chosen.

The loop end point. If a sample does not have loop points, loop points are
automatically chosen.

The absolute end point of the sound.
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4. If you need to edit warp markers, shown as light gray lines, click the source Edit
button to open the main edit window. Depending on the source material and active
morph mode, light blue lines may appear on the background between the start and
end markers. These can help with manual alignment of warp markers. The Time ruler
indicates.

Do any of the following in the zone waveform editor:

To move a warp marker, including the loop start and end, drag the marker handle left
or right.

Note: The loop start and loop end markers also double as warp markers. You cannot
position the loop start later than the loop end. However, it is possible to drag both
the loop start and loop end markers to the same position, creating a sustain point
rather than an extended loop region.

To insert a new warp marker, double-click a position in the waveform editor.

The number associated with each existing warp marker, inclusive of the loop
markers, is updated accordingly.

To delete an existing warp marker, double-click its handle.

If your sounds are single notes, the placement of the five default warp markers usually
delivers good results when morphing. You may want to change the position of marker 2,
placing it at the point where it sounds like the end of the attack for each sound. This can
produce a more convincing morph between sounds with contrasting attack qualities.

If your sounds consist of multiple events such as musical phrases, drum loops, or a spoken
sentence, you may find it useful to create additional warp markers. If you are morphing
between two voices speaking the same sentence, placing a warp marker at the start of
each word helps to preserve the integrity of each word during the morph. You must make
sure the same numbered warp marker is at the start of the same word in each sentence.

If you are morphing between musical phrases or drum loops with different grooves or
timing nuances, placing a warp marker on every beat, half beat, or quarter beat helps
you to achieve a smoother morph.

Explore source morphing options and controls in Alchemy

This tutorial makes use of the Morph Example preset, which you should load from the
Name bar. The preset contains acoustic guitar, kalimba, a sustained solo vocal, and synth
brass samples. Additive + formant was used as the import method because the content
contains more pitched info than noise, and this also allows access to the additive harmonic
controls. This basic material provides enough scope to go in a number of directions.
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Play the keyboard while changing parameters to get a feel for what each does.

1.

In Alchemy in Logic Pro, click the Advanced button to view all parameters. Click the
A/B/C/D buttons, in turn, to look at parameter settings for all four sources.

Note that PVar is set to zero for all sources. This isn’t always useful, but for this
particular preset, no pitch variations are required.

Solo each source, in turn, and play a few notes, then unsolo before moving to the next
source. This will give you a better understanding of the way the sound is constructed.

Click the Morph button at the left, and note the active Morph XY and Elements buttons.
Experiment with the X and Y parameters, using either the points in the display or the X
and Y knobs for the Additive, Pitch, Formant, and Envelope parameters.

XFade XY XFadeLlin MorphXY  Marph Lin

Al Elements

Granular Pitch Formant Envelope

Fixed Pitch

Click the XFade XY, XFade Lin, and Morph Lin buttons to hear the impact each type of
crossfade or morph has on the sound. Experiment with the All, Elements, X and Y, A-B,
C-D, and A-B-C-D parameters available in each morph or crossfade mode.

In the Perform section, drag the Transform pad framing box to the "Bold Pluck,”
"Glassy,” and other snapshots, repeating step 3 and playing as you audition each
variation. You'll see movements in the Transform pad update the other Perform
section controls.

Filter Sequence Soft Distortion Bright Repeater Wide Open

Simple

Tight Sequence Sequence Bend Sequence Mod Sequence

Rate Whea!

Octave Snap Vol

N
Click the Mod Targets button at the right of the modulation section and hover the
pointer over the Perform menu item. Take a look at the number of, and the choice
of, parameters assigned to each performance control.

As you can see, the preset is far more complex than it appears on the surface. The
morphing controls are not simply used to crossfade between sources, but between
modulators, filter and effect parameters, mix settings, harmonic levels, and much more.
Morphing can be viewed and used to blend the sounds of each element as well as
aspects of each synthesis type into a hybrid of synthesis methods.
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Crossfade all four sources using an X/Y pad performance control in Alchemy

Follow these steps to use the left X/Y pad in the performance controls section instead of
the X/Y pad in the morph section. This allows you to control crossfades between sources in
simple view and also allows you to include these modulations in Transform pad snapshots.

X1: Morph X X2: Seq Release

Y1: BP Seq ¥Y2: Seq Sustain

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Switch to advanced view, and set up each of the four sources with a different, but
complementary sound.

Feel free to use any of the synthesis engines for each source or to blend multiple
engines within one source.

3. Click the Morph button at the left to view morphing parameters, then click the
XFade XY button.

4. Make sure the X knob is set to zero, then Control-click the X knob and choose
Add Modulation > Perform > XYPad1X from the shortcut menu.

5. Make sure the Y knob is set to zero, then Control-click the Y knob and choose
Add Modulation > Perform > XYPad1Y from the shortcut menu.

Morph four spectral sources using an X/Y pad performance control in Alchemy

Follow these steps to use the left X/Y pad in the performance controls section instead of
the X/Y pad in the morph section. This allows you to control crossfades between sources in
simple view and also allows you to include these modulations in Transform pad snapshots.

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Switch to advanced view, then click the Morph button at the left to show
morphing parameters.

3. Click the source A select field, and choose Import Audio.

4. Select Spectral mode in the Import browser, choose a suitable sample, and import it.
Turn on Formant mode before importing.
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Repeat steps 3 and 4 for each of the other three sources. Make sure Spectral mode is
chosen and the Formant button is on when importing to sources B, C, and D.

Click the Morph button at the left to view morphing parameters, then click the
Morph XY button.

You can now morph between the four sources using the X and Y knobs. Follow steps 7
and 8 to assign the X and Y knobs to the left X/Y pad in the Perform section.

Double-click the X knob to set it to zero, then Control-click the X knob and choose
Add Modulation > Perform > XYPad1X from the shortcut menu.

Double-click the Y knob to set it to zero, then Control-click the Y knob and choose
Add Modulation > Perform > XYPad1Y from the shortcut menu.

Create a linear morph between two speech samples in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Switch to advanced view, then click the Morph button to show morphing parameters.

Click the source A select field, and choose Import Audio.

Locate the first of your speech samples and import it, using Additive, Spectral, or
Add+Spec mode. Turn on Formant mode before importing.

Repeat steps 3 and 4 for source B and your second speech sample. Use the same
import mode as for the first sample, and make sure Formant mode is active.

Click the Morph button at the left to view morphing parameters, then click the Morph
Lin button to view linear morphing parameters.

XFadeXY XFadelin MorphXY  Moerph Lin

Al Elements

Granular Pitch Formant Envelope

Fixed Pitch

Click the A-B button to change the linear morphing mode.

You can now use the X knob to morph between the two speech samples. Each
resynthesis method creates different sounding results even before morphing,
and the results halfway through the morph are dramatically different. Experiment
with each sample import method to determine which delivers the best outcome.

Control-click the X knob, then choose Add Modulation > Perform > Control 1 from the
shortcut menu.
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9.

Click the Perform button to view performance controls, then click the Wheel pop-up
menu under the Transform pad, and choose Control 1.

You can now use the mod wheel to move performance control 1.

Soft Distortion Bright Repeater Wide Open

Filter Sequence

Tight Sequence sing.l\ie Bend Sequence Mod Sequence

Snap Vol

Rate Whea!

Octave

10. As optional steps, click the source A button, then click the Edit button to view the main

edit window for this source.

- If necessary, drag the S and E handles (start and end point markers) in the waveform
display to trim the file.

- Double-click above the waveform display to place additional warp markers at
important syllables in your speech samples.

Click the B button in the main edit window to view source B parameters.

Double-click to create additional warp markers. Existing warp markers already
correspond with those created for source A. The syllable tagged with warp marker n
in source B is time-aligned with the syllable tagged with warp marker n in source A
at the halfway point of the morph.

Morph four additive sources using a pair of MSEG envelopes in Alchemy

1.

Logic Pro Instruments for Mac

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

. Switch to advanced view, then click the Morph button to show morphing parameters.

Click the source A select field, and choose Import Audio.

Select Additive mode in the Import browser, choose a suitable sample, and import it.
Turn on Formant mode.

Repeat steps 3 and 4 for each of the other three sources. Make sure Spectral mode is
chosen and the Formant button is on when importing to sources B, C, and D.

Click the Morph button at the left to view morphing parameters, then click the
Morph XY button.

You can now morph between the four sources using the X and Y knobs. Follow the
steps below to assign the X and Y knobs to MSEG 1 and MSEG 2, respectively.
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7. Double-click the X knob to set it to zero, then Control-click the X knob and choose
Add Modulation > MSEG > MSEG1 from the shortcut menu.

You can now define morphing on the X axis with the MSEG1 envelope in the
modulation section.

SEQUENCER  ENV FOLLOWER MODMAP Show Target

3 4 5 6

Continuous

Normal

8. Double-click the Y knob to set it to zero, then Control-click the Y knob and choose
Add Modulation > MSEG > MSEG2 from the shortcut menu.

You can now define morphing on the Y axis with the MSEG2 envelope in the
modulation section.

Morph drum beats in Alchemy in Logic Pro for Mac

This tutorial guides you through the process of importing two drum beats and then
morphing between them. You will initially morph all elements collectively, then
each individually.

Note: Images shown in tutorials are not specific to presets used in tasks. They are included

as a guide to help you find areas and parameters in the Alchemy interface.

Import and morph multiple drum loops in Alchemy

The loops used for this example are from the Electro House and Tech House loop libraries.

If you cannot find the loops, you'll need to download these additional content packages.
To do so, choose Download Additional Content from the Logic menu in the menu bar.

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Click the source select field for source A and choose Import Audio.
The Import window opens.

3. Open the Apple Loops browser, and type “Lockstep” in the search field. Drag the
Lockstep Beat 02 loop to the Dropzone area of the Import window.

4. Click the Spectral and Formant analysis mode buttons at the lower left, then click the
Import button.

This determines the synthesis engine used for resynthesis of the audio sample.
Spectral + Formant is a good general purpose option that works well for drum loops.
It's also the default setting in a new instance of Alchemy. When analysis is complete,
you can trigger the loop at its native pitch by playing C3 on your keyboard.
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5. Drag the Insider Groove Beat loop to the controls area of source B.

This alternative import method triggers the Import process automatically, using the
previously selected analysis mode.

6. Play C3 to trigger both loops at once. The loops are 8 beats long and have a native
tempo of 120, so playback is nicely synchronized. Although there are techniques for
tempo matching imported loops, it is simpler to use matched samples and improves
the potential for getting good results with minimal effort. If the loops have a very
different groove, click the Edit button to open the main edit window, where you can
do any of the following:

- In the waveform display, create warp markers to divide the loop into equal length
segments. The number of markers required depends on the length and complexity
of the loop. Aim to have a segment for each significant beat in the loop.

Slide each warp marker forward or back as necessary to align it with the nearest
drum hit transient. Hold a warp marker in the waveform display to zoom horizontally
for more accurate adjustments.

Switch to the other drum loop source with the A/B/C/D buttons at the top left of the
main edit window.

- Slide each warp marker forward or back as before to align each with the nearest
drum transient.

7. Click the A button (under Global), then choose Continuous from the source A Loop
Mode pop-up menu. Repeat this step for the source B loop.

This sets both beats to loop continuously while you hold down a note.
8. Turn off the Velocity On button in the modulation rack.

When triggering loops, it can be helpful to disable velocity control of the playback level
so the loops trigger with the same loudness regardless of how hard you play. If the
modulation area doesn’t show this parameter, click the Global button, then click the
center of the Master Volume knob shown at the upper right.

Click to view modulator

|Modulation rack ‘control panels.
I 1T 1

MODULATION SEQUENGER  ENVFOLLOWER  MODMAP

Filter 1 Cutoff

On Control2

on Velocity

on

9. Click the Morph button at the left to show the morphing section at the upper right, then
drag the handle in the middle of the morph control area from left to right to hear the
level of each source crossfade.

The default view shows XY set to crossfade, not morph, between the sources.
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10. Select one of the two morph buttons in the morphing section to access the elemental

11.

morphing controls. Because there are only two sources, click the Morph Linear button,
then click the A-B button to limit morphing to these two sources.

XFade XY XFadeLlin MorphXY  Marph Lin

Al Elements

Granular Pitch Formant Envelope

Fixed Pitch

Drag the handle between the two sources while holding a note to create a fundamentally
different effect than the crossfade between them.

What you can hear is a true morphing between discrete components of each sound. The
transition is not simply between the overall level of each sound, but between the levels
of multiple narrow frequency bands and the formant characteristics of each sound.

Drag the handle to the far left, then listen as you move slowly to the right to hear a
phantom shaker-like rhythm that doesn’t exist in either loop. Once you have finished
exploring, move the handle back to the far left before looking at the next task.

Morph elements independently in Alchemy

1.

In Alchemy in Logic Pro, click the Elements button in the morph section to access
controls that allow independent morphing between different sound elements, as
opposed to morphing all sonic aspects simultaneously.

Play C3 on your keyboard, then move the Spectral control handle (orange dot) from left
to right. You can also rotate the Spectral knob.

You can hear the spectral components of the first loop transition to those of the
second loop. The change is similar to that heard in step 10 of the previous task, but
the phantom shaker rhythm is clearer, and the kick sound from the Lockstep Beat
remains intact longer. In fact, this combination causes the kick to change tone and
become more pronounced at bar 1 of each bar. When the Spectral control is full right,
the original kicks are replaced by a pronounced “thump” at the head of each bar.
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Morph pitch and formants in Alchemy

1.

In Alchemy in Logic Pro, move the Pitch handle (green dot) from left to right. You can
also rotate the Pitch knob.

Drum beats don't generally contain much pitched information, so use of the Pitch
control may have little impact when working with loops. In this case, however, setting
Pitch to the far right position results in the prominent high tom of the Insider Groove
Beat becoming louder near beat 2. Only the tail of the pitch pushes through however,
creating an eighth note rhythm that starts near beat 3.
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Set Formant (purple dot) to 75%-100% to make the onset of the tom pitch more clearly
audible. You can also rotate the Formant knob to set this value.

Set the Spectral knob to zero.

You can hear the arc of the tom hit, but without tonal characteristics because there's
little spectral material at this point in the Lockstep loop. This demonstrates the
important role that resonances play in human perception of pitch information.

Assign performance controls to morphed drum loop elements in Alchemy

1.

In Alchemy in Logic Pro, Control-click the Position knob for source A, then choose
Add Modulation > LFO > LFO1 from the shortcut menu.

In the modulation section, click the Shape pop-up menu for LFO1 and choose
Basic > RampUp.

MSEG SEQUENCER  ENV FOLLOWER MODMAP Show Target
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Switch off Bipolar mode for the LFO, and set Rate to the same number of beats as the
loop. For example, set the Rate knob to 4 beats for a one-bar loop, or to 8 beats for a
two-bar loop, and so on.

Control-click the Position knob for source A, and choose Copy Modulation from the
shortcut menu.

Click the source B button to view source B parameters.
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6. Control-click the Position knob for source B, and choose Paste Modulation from the
shortcut menu.

The playback position of both loops is now controlled by LFO1, and they play back in
sync with the project tempo.

7. Click the Morph button to view morphing parameters, then click the Morph Lin button.

8. Click the A-B button to use the X knob to morph between the two time-aligned
drum loops.

9. As an optional step, you can click the Elements button to use or assign
element controls.

XFadeXY XFadelin MorphXY  Moerph Lin
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- Control-click the Spect/Gran knob (orange dot), and choose Add Modulation >
Perform > XYPad1X from the shortcut menu.

Control-click the Pitch knob (green dot), and choose Add Modulation > Perform >
XYPad1Y from the shortcut menu.

You can now use the left X/Y pad in the Perform section to morph the spectral
data by moving the pointer horizontally. You can morph pitch data by moving the
pointer vertically.

Control-click the Formant knob (purple dot), and choose Add Modulation >
Perform > XYPad2X from the shortcut menu.

- Control-click the Envelope knob (yellow dot), and choose Add Modulation >
Perform > XYPad2Y from the shortcut menu.

You can now use the right X/Y pad in the Perform section to morph the formant
filters by moving the pointer horizontally. You can morph the envelope shape by
moving the pointer vertically.

Morph melodic sounds in Logic Pro for Mac Alchemy

Sounds that contain melodic or harmonic material, such as those that are not purely drums
or percussion, present more challenges when morphing. In these cases, it's especially
important to understand some of the limitations and to know which synthesis options will
deliver the best results. This group of tutorial tasks covers morphing between sounds that
contain melodic material produced by monophonic instruments such as a solo voice,

a synth lead, or an orchestral instrument like a flute or oboe. The example files have

the same basic length, which makes results more predictable than if file lengths are

quite different.

Note: Images shown in tutorials are not specific to presets used in tasks. They are included
as a guide to help you find areas and parameters in the Alchemy interface.
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Play a source melody with another source in Alchemy

1.

In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

Click the source select field for source A, and choose Import Audio from the
pop-up menu.

The Import window opens.

Type "Amanda Aa Ee Ay Oh C3" in the search field, and drag the file to the Dropzone
area of the Import window.

Click the Additive and Formant analysis mode buttons at the lower left, then click the
Import button.

This determines the synthesis engine used for resynthesis of the audio sample. This
combination is generally best when you are working with melodic, monophonic audio
files. When analysis is complete, you can trigger the audio at its native pitch by playing
C3 on your keyboard. It's important to understand that you are hearing a resynthesized
version of the original sound that is being generated by the additive synthesis engine
and further shaped by the formant engine.

Tip: It's best to select the same analysis mode for all audio you plan to morph
between. If you don't do this, the primary synthesis element morphing control will be
non functional when morphing between sources analyzed with different engines. For
example, you can't perform additive morphing between a source generated by the
additive engine and another source generated by the spectral engine.

Click the source B select field, and choose Import Audio from the pop-up menu.

Type "Velvet Rope Synth Lead” in the search field, and click to select the file or drag it
to the Dropzone area of the Import window, then click the Import button.

Note: The previously selected import mode is retained, so there's no need to
change anything.

To set both files to loop continuously while you hold down the note, click the A button
(under Global), then choose Continuous from the Loop Mode pop-up menu. Repeat this
step for source B.

Click the Morph button at the left to show the morphing section at the upper right, then
click the Morph Lin button and the A-B button. The All button should be active.

Drag the handle between the two sources while holding a note to hear the sound morph
from the vocal (source A on the left) to the synth lead (source B on the right).

181



10. Click the Elements button to show the elemental morphing controls, then move the
Pitch handle (green dot) to the far right while holding down C3 on your keyboard.
You can also rotate the Pitch knob.

XFade XY XFadeLlin MorphXY  Marph Lin
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When the note cycle restarts, you will hear the vocal sample “singing” the melody
provided by the synth lead phrase in source B. The pitch morph is particularly effective
because the source A material contains no chordal content and does not change pitch,
and the Source B material has a very clear melodic phrase that the pitch analysis can
easily track. In general, files that work well for Flex Pitch in Logic work well for pitch
morphing applications in Alchemy. Keep this example loaded for the next task.

Explore additive morphs in Alchemy

Elemental morphing can sometimes lead to sudden and dramatic level changes. Before
adjusting the Additive control, click the Global button, then double-click the Volume knobs
for sources A and B. This sets them both to -18dB.

1. In Alchemy in Logic Pro, click the Morph button at the left to show the morphing section
at the upper right, then click the Morph Lin button, the A-B button, and the Elements
button (if required).

2. Drag the Additive handle (blue dot) to the right while holding C3 on your keyboard. You
can also rotate the Additive knob to set this value.

As you move the control, the harmonic partials of the vocal sample transition to the
partials of the synth lead. This doesn’t always produce pleasing results because partials
in one sound may emphasize noise or artifacts in the other sound. The workflow is often
one of sonic exploration in search of happy accidents rather than a predictable process.
Play notes and chords above and below C3 as you experiment.

3. Set the Additive control to approximately 30%, Pitch to 100%, and Formant and
Envelope to zero percent.

4. Click the A button at the left to view source A parameters, click the Additive button at
the top right, then rotate the Fundamental knob toward the left.

This attenuates the fundamental partial which brightens the sound by making the higher
frequency partials more pronounced.

Turn down the Odd/Even knob to create a more hollowed out sound, emphasizing the
partials of the synth lead. Experiment with other controls to get a feel for their effect
on the sound. Play octaves and fifths as you experiment.
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Create envelope morphs in Alchemy

The Envelope control in the morph section primarily morphs between the timing of sources.
This has little effect when files are close in length, but this behavior changes when the
playback length of files is altered.

1. In Alchemy in Logic Pro, click the Morph button at the left to show the morphing section
at the upper right, then move the Envelope handle (yellow dot) to the far left. You can
also use the Envelope knob to move the Envelope handle.

XFadeXY XFadelin MorphXY  Moerph Lin
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2. Click the A button at the left to view source A parameters, and click the Edit button at
the right of the source filename.

The source A edit window opens.

3. In the waveform editor at the bottom of the main edit window, drag the E handle to the
very end of the audible part of the waveform.

This effectively removes the silence at the end of the vocal phrase by reducing the
playback length of the overall file.

Preview button Loop markers

End marker

Start marker

4. Play C3 on your keyboard, and note that the phrase plays faster because the timing for
the sound is currently based on the timing of the vocal sample.

Also note that you can hear the entire synth lead phrase, which no longer fades away at
the end. If you move the end marker further left, you can hear the entire phrase of the
synth part played faster.

5. Click the X at the upper right to close the source A edit window.

6. Return to the morph controls, and adjust the Envelope knob to hear how it affects the
behavior of samples with different lengths.
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Use linked morph parameters in Alchemy

A green arc around a parameter indicates that it is morphed when you move dedicated
morph controls. Setting general (non-morph area) parameters to different values for each
source provides another technique that can influence morphing results.

1. In Alchemy in Logic Pro, click the source A button at the left, then click the Formant
button at the upper right to view the Formant controls. Rotate the Smooth knob to the
left until the Amanda vocal starts to break up and sound “fluttery.”
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2. Click the source B button at the left, then click the Formant button at the upper right.
Rotate the Smooth knob to the far left.

3. Click the Morph button at the left to show the morphing section at the upper right, then
move the Formant handle (purple dot) horizontally while playing. You can also use the
Formant knob to set this value.

You can hear the “fluttery” effect as you move the Formant control to the left, but this
disappears as you move it to the right.

Manipulate loops in Alchemy in Logic Pro for Mac

Logic Pro provides great options for working with loops and Apple Loops on tracks. If you
want to trigger loops live, or shape them with synthesis tools, you can do so using Sampler,
Ultrabeat, and Alchemy. Alchemy supports playback of Apple Loops as well as .aif, .caf, and
.wav audio files, and you can use it to manipulate tempo and pitch in real time. Alchemy's
sophisticated synthesis engines can transform loops with multiple forms of resynthesis

and extensive filter, modulation, and effects options.

Note: Images shown are not specific to the presets used in tasks. They are included as a
guide to help you find areas and parameters in the Alchemy interface.

Time stretch and pitch shift samples in real time in Alchemy

If you cannot find the loop used for this example, you'll need to download additional
content packages. To do so, choose Download Additional Content from the Logic menu
in the menu bar.

1. In Alchemy in Logic Pro, click the File button in the Name bar and choose Initialize
Preset from the pop-up menu to reset all Alchemy parameters to default settings.

Important: Use of Initialize Preset automatically turns on wide unison mode. See
Alchemy wide unison mode.

2. Set the project tempo to 110 BPM.
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3. Click the source select field for source A, and choose Import Audio from the

pop-up menu.

The Import window opens.

upport > Logic > Alchem

Parent Folder

Analysis Mode
Additive  Spectral | AddeSpec. Granular  Sampler

Formant

. Open the Apple Loops browser, and type “Basic Vintage Break” in the search field. Drag

the Vintage Funk Loop 03 file from the Apple Loops browser to the Dropzone area of the
Import window.

Note that the original tempo of this file is 100 BPM and that it is 8 beats (2 bars) long.

. Click the Spectral and Formant analysis mode buttons at the lower left, then click the

Import button.

This determines the synthesis engine used for resynthesis of the audio sample. Spectral
+ Formant is a good general purpose option that works well for drum loops. It's also the
default setting in a new instance of Alchemy. When analysis is complete, you can trigger
the loop at its native pitch and speed by playing C3 on your keyboard. Playing other
pitches transposes the loop, but retains the tempo.

. Set the Speed knob in the source main controls section to zero percent (full left).

This stops the loop from playing forward in time and repeats the first few samples at the
current position.
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Hold a note and rotate the Position knob to hear how playback is affected.

The Position knob moves playback forward and backward through the loop. Set the
value to zero percent (full left).
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Modulate position with an LFO in Alchemy

1.

In Alchemy in Logic Pro, Control-click the Position knob and choose Add Modulation >
LFO > LFO1 from the shortcut menu.

This assigns LFO 1 to control the Position knob, and the central modulation section
automatically updates to display the controls for LFO 1.

Switch the LFO shape from Sine to Ramp Up, and set the Rate to 2 (measures) to match
the length of the Apple Loop.

Tip: Changing the LFO shape to Ramp Down plays the loop backward by starting the
Position at 100% and moving back to 0%.

MSEG SEQUENCER  ENV FOLLOWER MODMAP Show Target
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Click the Bipolar button to turn it off.

When Bipolar is active, the LFO outputs both negative and positive values in each
cycle (from -50% to 50%). When off, only positive values are output (from 0% to
100%). If you play and hold a note on your keyboard, a small dot around the Position
knob indicates its values changing from 0% to 100%. Bipolar is useful for controlling
parameters like pan where 0 is in the midpoint of the knob’s rotation and you want the
value to oscillate around the center.

. Play C3 to hear the loop at its native pitch but at a tempo that matches the project

(110 BPM).

Explore further loop manipulation options in Alchemy

In Alchemy in Logic Pro, explore these additional options with the same loop to get a feel
for Alchemy's loop manipulation capabilities.

Turn off Trigger mode to hear the loop position continue to move through the file
only when you play a note. This allows you to create gating and stuttering effects
by rhythmically triggering notes. Try playing a series of very short 8th notes over
this loop to change its feel.
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You can play notes of different pitches or can use pitch bend to add a chopped

and screwed effect to your loops. The default pitch bend range is 2 semitones,

but Alchemy supports bi-directional pitch bends of up to 36 semitones. To set this,
click the Global view button and set the up and down pitch bend values independently
in the master section.

Always
Glide

Rate Time

Modulate position with an MSEG in Alchemy

The MSEG envelope can duplicate the same kind of looping Ramp Up pattern used in the
LFO task but is capable of longer, more complex patterns than a simple repeating ramp.
MSEG envelopes are useful when you have specific ideas about how you want parameters
to change over time. MSEG modulators are capable of creating a range of patterns from
simple short ramps to very long, complex sequences.

1.

In Alchemy in Logic Pro, click the Position knob, then click the button next to the
modulation area to disable the LFO.

Play a few notes and you will hear that the loop no longer plays forward.

. Control-click the Position knob, and choose Add Modulation > MSEG Env > MSEG1 from

the shortcut menu.

This assighs MSEG 1 to control the Position knob. The central modulation section
automatically updates to display the controls for MSEG 1.

SEQUENCER  ENV FOLLOWER MODMAP Show Target
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Click the File button in the MSEG editor, and load the Ramp Up preset.

This creates an 8 beat (2 bar) ramp from 0% to 100%. When you play a note, the result
is identical to that of the LFO modulation used in the previous task.

Click along the graph line in the MSEG editor to add three points near bars 5, 7, and 9.
Double-click a point to remove it.

Note: The exact position of each point in the MSEG is important for keeping a
consistent tempo.

187



Logic Pro Instruments for Mac

5. Drag points horizontally to move them, noting that they snap to the tempo grid. Drag
vertically to set the following values for each point.

- Bar 1: Point value 0%

- Bar 5: Point value 50%
- Bar 7: Point value 25%
- Bar 9: Point value 50%

6. Hold a note to hear the loop play forward, backward, and then forward again at the

project tempo.

More complex MSEG settings can cause the position to jump to specific points in the
loop, thus creating variations of the original loop.
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Drum Kit Designer in Logic Pro for Mac

Drum Kit Designer lets you build custom drum kits from a wide selection of drum and
percussion sounds. It also provides controls that change sound characteristics and the
level of each piece in your kit.

Further settings allow you to use different microphones and rooms to enhance multi-
channel kits. Multi-channel kits are identified in the Library by a “+" at the end of the
patch name. See "Work with Session Players” in Logic Pro Help for information on multi-
channel kits.

If you're new to using plug-ins in Logic Pro, see Add, remove, move, and copy plug-ins.

Exchange panel Edit panel

Dampen

Drum kit

The Drum Kit Designer interface is divided into the following main areas.

- Drum kit: Click a drum kit piece to preview its sound and to open the Edit pane and the
Exchange pane (if exchange pieces are available for that drum type).

«  Exchange pane: Shows all drums that are available for exchange (you may need
to scroll).

- Edit pane: Shows settings that change sound characteristics.
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The Edit pane is used to change sound characteristics and the level of each piece in
your Kkit.

Tune

Dampen

Edit pane parameters
Tune knob and field: Adjust the pitch of the selected kit piece.
Dampen knob and field: Adjust the sustain of the selected kit piece.
Gain knob and field: Adjust the volume of the selected kit piece.

Leak switch (multi-channel kits only): Include the sound in the mic of the other
kit pieces.

Overheads switch (multi-channel kits only): Include the drum kit overhead mic in
the sound.

Room switch (multi-channel kits only): Choose between rooms A and B or to turn off the
room emulation.

Use Drum Kit Designer in Logic Pro for Mac

Drum Kit Designer shows a 3D representation of the drum kit for the currently
loaded patch.

For all kits, you can preview the drums, edit the pitch, sustain, and volume of each drum
kit piece, and exchange the kick and snare drums. When working with multi-channel kits,
you can additionally exchange toms, cymbals, and hi-hat. Multi-channel kits let you turn
different microphones, such as overheads or room mics, on or off.

Note: Multi-channel kits and some drums are only available after you download
additional content.
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Drum Kit Designer also has additional parameters for adjusting the gain of other instrument
pieces, such as shaker, cowbell, and so on. See Drum Kit Designer extended parameters.

Preview a drum or percussion piece

- In Logic Pro, click a drum or percussion piece.

The first time you click any drum or percussion piece after opening the plug-in, one or two
panes open. You can exchange individual sounds in the Exchange pane to the left and can
edit individual drum or percussion piece settings in the Edit pane to the right.

Adjust kit piece settings (all kits)

1. In Logic Pro, click a drum or percussion piece.

The Edit pane opens to the right.

Tune

Dampen

- Toms: Click the tab for the tom you want to edit, or click the All tab to adjust the
tone of all toms.

Cymbals: Click the tab for the crash cymbal you want to edit, or click the All tab to
adjust the tone of both crash cymbals. The ride cymbal can be edited directly.

Kicks and snares: There are no tabs, so make your adjustments with the controls.
2. To adjust settings, do any of the following:

To adjust the pitch: Drag the Tune control vertically, or double-click the field and
enter a new value.

To adjust the sustain: Drag the Dampen control vertically, or double-click the field
and enter a new value.

- To adjust the volume: Drag the Gain control vertically, or double-click the field and
enter a new value.

3. To close open panes, click anywhere in the plug-in window background.
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Exchange a kit piece

For all kits, you can exchange kick and snare. When working with multi-channel kits, you
can additionally exchange toms, cymbals, and hi-hat.

Note: Multi-channel kits and some drums are only available after you download
additional content.

1. In Logic Pro, click a drum or percussion piece.

The Exchange pane opens to the left if exchange pieces are available for that kit piece.

2. Click the Info button of a selected piece to view its description.

3. Click the kit piece that you want to exchange in the Exchange pane. You may need to
scroll to find the piece you want to use.

The piece is exchanged and the respective drum sound is loaded.
Note: The toms and the crash cymbals can only be exchanged as a group.

4. To close the panes, click anywhere in the plug-in window background.

Adjust mic settings (multi-channel kits only)

In the Edit pane, do any of the following:

- Toinclude the sound in the mic of the other kit pieces: Turn on the Leak switch.
Leak
[ oN

This turns microphone bleed on or off, where the sound of a kit piece is picked up by
the different mics from other kit pieces.
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To include the kit piece overhead mic in the sound: Turn on the Overheads switch.

Overheads

[ ON @

This turns the overhead mic for the selected kit piece on or off.

To choose a room emulation to use with the sound: Choose between rooms A and B.
You can also turn off the room microphones.

Rooms A and B determine which room mic setup is used with the kit piece.

Drum Kit Designer extended parameters in
Logic Pro for Mac

Drum Kit Designer provides additional parameters that are accessed by clicking the
disclosure arrow at the lower left.

The Input Mapping pop-up menu lets you choose different mappings that provide
enhanced control of HiHats. The maps also change the way Drum Kit Designer sounds
are assigned across the MIDI note range. See Drum Kit Designer mappings.

Extended parameters
Input Mapping pop-up menu: Choose a keyboard mapping mode.
GM: Drums are mapped to the GM standard.

GM + ModWheel controls HiHat opening level: The keyboard Mod Wheel is mapped
for hi-hat control. Additional sounds are also mapped to keyboard zones above and
below the standard GM note mapping range.

V-Drum: Drums are mapped to work with V-Drum hi-hat, cymbal, and drum triggers.

Gain sliders: Drag the slider or in the field to adjust the level of the corresponding
sound (if available in the kit).

Shaker Gain
Tambourine Gain
Claps Gain
Cowbell Gain

Sticks Gain
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Drum Kit Designer is compatible with the GM standard. You can also choose GM +
ModWheel, which lets you use your keyboard modulation wheel to adjust the amount
the hi-hat opens and closes during a drum performance.

Drum Kit Designer is also compatible with the V-Drum standard.

The images show how drum sounds are remapped when different modes are chosen with
the Input Mapping pop-up menu in the extended parameters, and when using kits that
contain brush snares. Kits featuring brush snares provide a number of special features
discussed below the images.

GM Standard GM + ModWheel Brush Snare

Ride Inner

Cc3

Crash Right

Cowbell

Tambourine
Ride Bell
Ride Edge
Ride Outer
High Tom Edge
Crash Left
c2 High Tom

Mid Tom Edge

Hi-Hat Open

Hi-Hat Edge
Mid Tom

Hi-Hat Foot Close

Hi-Hat Shank

Low Tom Edge

Hi-Hat Closed Hi-Hat Tip

Low Tom

Snare Rimshot
Hand Claps
Snare Center
Snare Sidestick
c1 Kick

Kick
Snare Edge

Hi-Hat Foot Close
Snare Rimshot Edge
Hi-Hat Foot Splash

Snare Center Mute 1

Crash Right Stop

Crash Left Stop

—
=

Snare Center Mute 2
Snare Sweeps 8th Note

co

Snare Sweeps 16th Note
Snare 1/2 Note Circles
Snare 1/4 Note Circles

Snare Sweep Accents
Snare Sweep Accents Hit

Sweep Stroke
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Brush snare special features

Kits that contain brush snares have preset behaviors that can enhance your performances
and compositions.

Note: The following features apply only to keys that trigger a brush snare drum sound.

Left and right hand playing is chosen automatically when using MIDI channel 1. This
behavior is based on default settings such as the left hand being used for brush circles
(if this hand isn't already in use), and playing situation. For example, snare taps will
change from a default preference for the right hand to alternating hands if snare hits
are played in rapid succession.

Note: Hand usage can be forced by using MIDI channel 2 for the right hand and MIDI
channel 3 for the left hand.

Brush circles are played continuously while a note is held and loop randomly every bar,
synchronized to the project downbeat, tempo, and meter. If a tap on the same hand as a
held circle is played, the circle restarts immediately.

There are two mute states that take brush force into account. These mute states can
be active (caused by a brush hit) or passive (caused by the other brush resting on
the snare), or can be a combination of both. The current mute state is automatically
tracked, which results in a small sound variation each time a snare is played. For
example, if a circle is playing, a snare tap will sound slightly different than when
played from silence.

The Snare Center Mute articulations (on keys C#0 and D#0) keep the brush on the
snare head after the hit. These keys interrupt a playing circle on the same hand while
held. The circle resumes when you release either key.

Choose mapping mode for Drum Kit Designer

1.

In Logic Pro, click the disclosure arrow at the bottom-left corner of the plug-in window
to show additional settings.

Choose one of the following from the Input Mapping pop-up menu:

J

g:| v oM
GM + ModWheel controls HiHat opening level

V-Drum %

-2dB

-2dB

-2dB

-2dB

GM
GM + ModWheel controls HiHat opening level
V-Drum
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Drum Machine Designer

Drum Machine Designer overview in Logic Pro
for Mac

Drum Machine Designer is the ideal way to create, organize and interact with kits and
kit pieces. It is used for software instrument tracks but can also be played with a MIDI
keyboard or pad controller on instrument channel strips.

When combined with Step Sequencer, it provides an incredibly flexible and inspiring
platform for groove production.

Drum Machine Designer structure

Drum Machine Designer is not a plug-in, although it can be inserted into instrument
channel strips. It is a track-based meta-instrument using a track stack, which combines a
main track and a number of subtracks. Each track has a corresponding channel strip. For
information on adding a Drum Machine Designer track to a project, see the Step Sequencer
chapter of the Logic Pro User Guide.

Main track Kit name and icon

Analog Circuits
M S| R _?} \

Kick 1...ircuits
M S R

Analog Circuits

~

Kick 2...ircuits
M S|R
., Snare...ircuits
M S R
~,  Snare..ircuits
M S R

‘ Subtracks I Pads

- The main track channel strip is represented by the kit name and icon, shown in the kit
controls bar at the top of the Drum Machine Designer window.

- Each subtrack channel strip is represented by a corresponding kit piece pad, shown in
the grid.

Settings for the main track (kit) and all subtracks (kit pieces) are stored as a kit patch,
which can hold multiple channel strips, each with its own instrument, effect plug-ins, and
Smart Control settings. Plug-in settings, by comparison, can only hold the plug-in settings
of a single plug-in.
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A single subtrack with its instrument, effect plug-ins, and Smart Control settings is stored
as a kit piece patch.

The icon shown on tracks and channel strips always matches the pad icon, and updates
when a kit piece is exchanged or replaced. Double-click the track icon to open the Drum
Machine Designer window. Click the arrow beside the main track icon to view or hide
subtracks.

How Drum Machine Designer handles notes

MIDI notes received on the main track are distributed to subtracks, according to the input
and output notes assigned to the pads. This is true for notes played by regions on the
main track, and for notes played in real time when the main track is the focused track. For
example, if the pad assigned to the first subtrack is set to input note C1 and to output note
G2, a C1 played on the main track is converted to a G2. This note value is passed to the
first subtrack and plays a G2 on the instrument inserted in the subtrack channel strip.

In contrast, notes played on a subtrack are not altered, and are passed directly to the
instrument inserted in the channel strip, enabling you to play a subtrack instrument
chromatically and polyphonically.

You can separate the notes in the main track MIDI region by doing one of the following:

- Select the main track MIDI region, then choose the Edit > Separate MIDI Events > By
Note Pitch command.

- Control-click the main track MIDI region, then choose the Convert > Separate by Note
Pitch command from the shortcut menu.

Individual regions, containing note events, are created on each subtrack and can be
handled and edited in the same way as any other MIDI region.

Drum Machine Designer sounds

You can access Drum Machine Designer kit patches and kit piece patches in the Library.
When the Library is open:

- Click the kit name to view and select kit patches in the Library.

- Click a kit piece pad icon or pad background to view and select kit piece patches in
the Library.

Drum Machine Designer features an extensive collection of premapped kit patches and
also a huge number of individual sound (kit piece) patches that you can add or use as
replacement elements for pads, to create custom Kits.

You can assign sounds to pads with patches from the Library, or drop audio material
directly into Drum Machine Designer from the Browser, Loop Browser, or Audio Browser.
You can also drop MIDI or audio regions onto Drum Machine Designer pads or to main track
or subtrack headers.

Note: You can assign any type of instrument or sound to a pad. Should you choose to
assign a Vintage B3 Organ patch to a pad, for example, the Smart Controls pane shows
drawbars and other B3 parameters.

Note: You may need to download additional content to use all Library patches.
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Drum Machine Designer interface in Logic Pro
for Mac

The Drum Machine Designer interface is divided into the following main areas
and elements.

Kit name and icon

Analog Circuits — Kit controls bar
e

~Grid

Pad controls bar

Page switcher
1 controls

~Smart Controls/
Plug-in pane

Kit controls bar: A collection of kit pieces is known as a kit. Click the kit name or
the Kit Controls button on the kit controls bar above the grid to interact with global
effects and control settings for the entire kit in the Smart Controls pane, if visible.
See Drum Machine Designer grid kit controls.

Grid: Each pad offers its own kit piece or sound. Drum and percussion kit pieces
assigned to pads can be either synthetically generated or sample-based. In fact, you
can assign and use any instrument or plug-in you have at your disposal to a pad. Click
the speaker icon on a pad to play the assigned sound. Click the icon or background of a
pad to interact with its controls in the Smart Controls pane. You can mute, solo, reorder,
replace, and change the sound of each kit piece you have assigned to each pad. You
can also assign each pad to different input and output MIDI note numbers and to
different groups. See Drum Machine Designer grid kit controls and Use Drum Machine
Designer pad controls.

Pad controls bar: The Drum Machine Designer interface shows kit pieces laid out as
pads in a grid that spans multiple pages. Click the page switcher controls (circles

or arrows) on the pad controls bar below the grid to switch between pages. The pad
controls bar also contains buttons that change the view shown in the Smart Controls
pane. See Drum Machine Designer grid pad controls bar.

Smart Controls/Plug-in pane: Smart Controls parameters update when you select a kit
or kit piece, mirroring the Logic Pro Smart Controls pane. See Kit Tone and Effect Smart
Controls and Kit Piece Tone and Effect Smart Controls.

Note: If a Drum Machine Designer subtrack or pad uses a Quick Sampler or Drum Synth
plug-in, you will see additional Q-Sampler Main, Q-Sampler Details, or Drum Synth view
buttons alongside the Pad Controls button in the Drum Machine Designer Pad controls
bar below the grid. Use these to access the respective instrument plug-in interface and
parameters. See Drum Synth overview and Quick Sampler overview.
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Drum Machine Designer kit controls in Logic Pro
for Mac

Drum Machine Designer shows a grid representation of the kit for the currently loaded
patch. Each pad represents a kit piece. You can edit a number of settings for the entire
kit, discussed in this section. To learn about interacting with kit pieces, see Drum Machine
Designer Pad controls bar and Drum Machine Designer pad controls.

The kit controls bar above the grid shows the active kit name and provides access to kit
parameters. Click the kit name or the Kit Controls button to interact with global effects
and control settings for the entire kit in the Smart Controls pane. If the Smart Controls
pane is not visible, click the disclosure arrow at the lower left of the grid.

DMD Track 1

Kit controls bar parameters

To view kit Mute, Solo, and Action pop-up menu parameters, move the pointer over the kit
controls bar.

- Kit name and icon: Click the kit name to view kit parameters in the Smart Controls pane.
Double-click the kit name to rename it (and the main track). Click the kit icon to stop all
playing sounds. The Kit Controls button is highlighted when kit parameters are shown in
the Smart Controls pane.

Note: The kit icon displays a muted speaker icon when you move the pointer over it
during playback. This can be used to immediately stop playback of all kit pieces. This
is useful when you want to silence a long One Shot sample that you are previewing in a
Quick Sampler-based kit piece, for example.

- Kit Controls button: View kit parameters in the Smart Controls pane. The button
is highlighted when working with kit parameters in the Smart Controls pane. See
Kit Tone and Effect Smart Controls.

Note: The Kit Controls button is visible only if the Smart Controls pane is shown.
- Mute button: Select to silence the kit (mute the main track channel strip).

- Solo button: Select to hear the kit in isolation. All other tracks and channel strips are
muted, indicated by a flashing Mute button.
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« Action pop-up menu: Choose a command that globally affects the appearance and
behavior of the Kkit.

Select Pad by Key: Choose to turn on or turn off the automatic selection of pads
with a MIDI keyboard. When on, the pad with an input note that corresponds to the
incoming played MIDI note is selected.

Note: MIDI notes played by Logic MIDI regions do not select pads, regardless of the
setting of this menu item.

Select Channel strip by Pad: Choose to turn on or turn off the selection of channel
strips when you click a pad in the grid.

Note: This option not only selects the corresponding subtrack and channel strip

of the selected pad, but also sets focus to the main track. This ensures that notes
played on the main track continue to be distributed to all subtracks. You can turn on
both Select Pad by Key and Select Channel Strip by Pad to select pads, subtracks,
and channel strips by playing a key on your MIDI keyboard.

Open/Close Library: Open or close the Library pane. Click a kit patch name in the
Library to exchange the entire kit.

Use Empty Kit as Default: Turn on this option to use an empty kit when you insert
Drum Machine Designer on an instrument channel strip.

Hide/Show General MIDI Drum Names: Hide or show General MIDI (GM) drum names
on each active pad. This is useful as a reference when mapping new sounds in a

kit that you want to conform with the GM Drum standard. For example, when using
Drum Machine Designer with Drummer.

Hide/Show Kit Piece Icons: Hide or show the icons on each active pad.

Note: When you move the pointer over a pad, a small speaker icon is shown. Click
this icon to play the sound.

Reorder Pads: Choose the Change Sounds or Visual Only option to alter how pad
layout changes affect assigned pad sounds. The pad layout can be changed by
reordering pads. For example, when you insert a pad between other pads or drop
one pad onto another to exchange them.

«  Change Sounds: Changing the pad layout moves the sounds of the pads, but
pad input and output note settings are not changed: The sounds will appear in a
different order when played via a MIDI keyboard or by a recorded region.

Visual Only: Changing the pad layout moves the pads and sounds together, so
reordering will only have a visual effect: The pads will appear in a different order,
but assigned sounds are still played by the same MIDI notes.

Sort Pads by GM Drum Standard: Choose to automatically remap the order of pads
to the General MIDI (GM) Drum standard, which is used by Drummer. This changes
the visual order of pads, but does not remap sounds.

Note: Regardless of the "Reorder Pads” setting, both “Sort Pads” options will sort
the pads visually, in accordance with input note values.
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